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1. Основные настройки рабочей области.  
Для того, чтобы запустить редактор печатных плат Allegro PCB editor, необходимо найти на 

диске файл “allegro.exe”. Он находится в папке, куда была произведена установка продуктов 

Cadence. Либо можно обнаружить ярлык для запуска PCB editor в меню “Пуск”, если 

используется ОС Windows. После запуска программы пользователю предоставляется 

возможность выбрать лицензию, которая будет определять доступные для работы 

инструменты.  

 

Рис.  1.1 Пример списка лицензий, доступных при запуске Allegro PCB editor. 

Для каждой лицензии можно дополнительно подключать опциональные расширения. 

Разные расширения отвечают за различные дополнительные возможности. На данном этапе 

описание всех расширений будет опущено. 

Для того, чтобы запустить редактор печатных плат с базовым набором инструментов, 

необходимо выбрать лицензию “Allegro PCB Designer”, поставить галочку напротив фразы 

“Use as default” и нажать на кнопку ОК. После этих действий выбранная при первом запуске 

лицензия будет автоматически использоваться и при последующих запусках. Используемую 

лицензию можно всегда изменить в самом редакторе печатных плат после его запуска. Для 

этого необходимо выбрать пункт меню File - Change Editor, см. Рис.  1.2. 



 

 

Рис.  1.2 Возможность изменения используемой лицензии. 

После первого запуска перед пользователем появляется рабочая область редактора 

печатных плат и некоторые инструментальные панели. 

 

Рис.  1.3 Примерный вид редактора печатных плат при первом запуске. 

 



 

Первым действием, которое должен совершить пользователь после запуска редактора 

печатных плат, является проверка того, что используемый им софт самый свежий на текущий 

момент. Проверка осуществляется путем выбора меню Help в верхней части экрана. Далее в 

выпадающем подменю необходимо выбрать пункт About. После этого перед пользователем 

появится небольшое окошко с отчётом о версии программы. 

 

Рис.  1.4 Пример окна отчёта об используемой версии ПО. 

Если дата вашего последнего обновления сильно отстаёт от текущей даты, то необходимо 

обновить все модули ПО, поскольку каждый квартал Cadence проводит плановые обновления, 

в которых исправляет замеченные пользователями ошибки в работе и добавляет новый 

функционал. 

Надо обратить внимание, что с версии 17.2 ядро редактора печатных плат стало 64-х 

разрядным. Это повлекло за собой более расширенные возможности по работе с большими 

файлами проектов. Однако совместимость версий проектов сверху вниз отсутствует. 

Совместимость проектов снизу-вверх поддерживается. Можно легко открыть проект печатной 

платы из версии 16.6 в версии 17.2. Проект будет преобразован в более новую версию и 

сохранён на диске компьютера. 

После проверки версии используемого ПО пользователю необходимо подготовить 

программу к работе и настроить редактор печатных плат под себя. 

Прежде всего необходимо установить пути к библиотекам посадочных мест, площадок, 

STEP моделей и т.д. Для этого нужно выбрать пункт меню “Setup” и затем “User preferences”.  



 

 

Рис.  1.5 Меню запуска диалогового окна настроек проекта. 

После этого пользователь увидит диалоговое окно, которое позволяет вносить изменения в 

настройки проекта (Рис.  1.6). Все параметры, которые могут быть изменены, разделены по 

категориям. Если неизвестно, в какой категории находится необходимый параметр, то его 

можно найти, введя часть названия параметра в поле поиска. Замещающий символ * можно 

не использовать. Будут найдены любые совпадения с введенным значением. 

Рассмотрим наиболее важные параметры.  

Пути к папкам библиотек компонентов и площадок 

Как уже упоминалось ранее, необходимо показать программе: где расположены библиотеки 

пользователя, необходимые для работы. Для этого нужно раскрыть раздел “Paths”, а затем 

подраздел “Library”. Перед пользователем предстанет диалоговое окно, изображенное на Рис.  

1.7. 



 

 

Рис.  1.6 Окно настройки различных параметров проекта. 

 

 

Рис.  1.7 Окно настроек путей доступа к библиотекам. 

Пользователь может видеть, что в выделенном разделе содержится несколько параметров, 

отвечающих за пути к различным типам файлов. Если не использовать STEP модели, то 

необходимо настроить три параметра. 

 devpath 

 padpath 

 psmpath 



 

 

Devpath – параметр, отвечающий за месторасположение “device” файлов. Это файлы, 

создаваемые программой при работе с Netlist сторонних разработчиков, таких как Mentor EE, 

PADS, PCAD200x, Altium. 

Padpath – параметр, отвечающий за месторасположение контактных площадок, 

используемых в посадочных местах компонента. 

Psmpath - параметр, отвечающий за месторасположение файла посадочного места, 

используемого самой программой. Он не нужен для человека, но необходим для программы. 

Именно он используется при импорте Netlist для импорта посадочного места компонента в 

редактор ПП. 

Хотя пользователь может хранить все три типа файлов в различных папках, рекомендуется 

так не делать, поскольку при большом количестве компонентов могут возникнуть сложности с 

обновлением файлов PSM или PAD. Если использовать только одну папку для хранения всей 

библиотеки посадочных мест, то для всех трёх параметров необходимо прописать один и тот 

же путь.  

Пути к папке с библиотекой могут быть как абсолютными, так и относительными. 

Относительные пути отсчитываются от места расположения файла проекта. Это удобно, если 

для всех проектов поддерживается одинаковая структура папок. Тогда, перенеся файл 

печатной платы из одного проекта в другой, пользователь не утратит доступа к библиотекам. 

 

Рис.  1.8 Диалоговое окно настройки папок расположения device файлов. 

После того, как пользователь нажмёт на кнопку троеточия напротив параметра devpath, 

перед ним откроется окно настройки пути. См. Рис.  1.8. 

Необходимо поставить галочку напротив надписи Expand, чтобы увидеть все пути, 

содержащиеся в настройках. После этого пользователь сможет видеть все записи, которые 

содержит параметр devpath. 



 

 

Рис.  1.9 Пример записей, содержащихся в параметре devpath. 

На Рис.  1.9 представлено два способа записи путей одновременно. Это как относительный 

путь, так и абсолютный. 

../lib/package – относительный путь. 

C:/Cadence/SPB_16.6/tools/fsp/samples/dra – абсолютный путь. 

Первая строка, в которой содержится только одна точка, разрешает поиск библиотечных 

компонентов в папке с самим проектом печатной платы. Этот вариант дает возможность 

иметь для каждого файла проекта индивидуальную библиотеку, никак не пересекающуюся с 

библиотеками других проектов. 

Вторая строка, в которой содержится только две точки, разрешает переход из папки 

проекта на один уровень выше. То есть в папке более верхнего уровня может храниться, 

например, единая библиотека для всех ваших проектов, а в подпапках – сами проекты. 

Надпись “../lib/package” предлагает подняться на один уровень вложенности выше 

относительно папки с проектом и далее опуститься в подпапку “lib” и далее в “package”. В этом 

случае вы можете иметь единую библиотеку, например, для какого-то отдела компании, или 

для какого-то заказчика компании. При этом в другой папке может храниться библиотека 

другого отдела, и настройками этих путей можно очень гибко регулировать вашу организацию 

рабочих библиотек. 



 

 

Рис.  1.10 Пример структуры папок. 

 

Рис.  1.11 Папка, содержащая библиотеку посадочных мест. 

 

Для добавления и удаления записей в правом верхнем углу диалогового окна расположен 

простой набор инструментов. Порядок следования записей определяет порядок загрузки 

информации. Если у пользователя в различных папках хранится файл посадочного места с 

одинаковым названием, то будет взято именно то, которое записано в верхней строке. Все 

остальные посадочные места в более нижних строках будут проигнорированы. 

 

Рис.  1.12 Добавление новой записи. 



 

После того, как пользователь добавит новую запись, указывающую необходимую папку, это 

действие нужно будет совершить ещё два раза: для параметров padpath и psmpath. 

Более расширенная информация о том, из каких частей состоят посадочные места 

компонентов в Cadence Allegro PCB designer, будет дана позднее. 

После того, как пользователь ознакомился с механизмом доступа к настройкам проекта, 

необходимо выполнить настройки внешнего вида панелей инструментов, настройку “горячих” 

клавиш и зафиксировать панели Options, Find, Visibility. 

Панели Options, Find, Visibility. 

Данные панели отмечены синим цветом на Рис.  1.3. При первом запуске они свёрнуты. Но 

удобнее их развернуть. См. Рис.  1.13. В состоянии, показанном на этом рисунке, вся 

информация на этих панелях видна одновременно. Чтобы развернуть панель, необходимо 

навести указатель мышки на название панели в правом верхнем углу и нажать правую 

клавишу мышки.  

 

Рис.  1.13 Три вкладки, расположенных друг над другом. 

Возможно, вкладки не расположатся в точности так, как показано на Рис.  1.13, но каким-то 

образом раскроются и предстанут перед пользователем. Чтобы изменить их положение на 

экране, нужно аккуратно навести указатель мыши на серую полоску и, зажав левую клавишу 

мыши, потянуть окно в нужное место. Серая полоска выделена красным прямоугольником на 

Рис.  1.13. Данная область имеет более темный цвет, чем остальное окно. Чтобы правильно 



 

расположить указанные вкладки одну над одной, необходимо осторожно перемещать окно до 

тех пор, пока в правой части экрана на нужном пользователю месте не образуется голубая 

область. Данная область обозначает место, куда будет установлено перетаскиваемое окошко, 

когда пользователь отпустит правую клавишу мышки. 

Поскольку данные вкладки имеют очень большое значение при работе с редактором, то 

стоит остановиться на них подробно. К тому же вкладка Visibility может быть настроена под 

конкретного пользователя.  

Вкладка Visibility и настройка цвета в окне Color Dialog. 

Данная вкладка отвечает за видимость всех объектов в проекте пользователя. Вся 

информация, которая содержится в проекте, разделяется на классы данных. Есть класс 

“проводящий рисунок”. Существуют классы: пины, геометрия платы и т.д. Таких делений на 

группы объектов по определенному признаку довольно много. 

Во вкладке Visibility пользователь может включать или отключать определенный вид 

объектов на печатной плате. Например, можно выключить все медные полигоны, или все 

пины на слое TOP, или вообще все пины в проекте.  

Так же во вкладке Visibility возможно включать уже преднастроенные состояния видимости 

объектов на ПП, виды (View). Назовём их плёнками, т.к. изначально этот механизм 

использовался для вывода нужных объектов на пленки фотошаблонов для изготовления 

печатных плат. Данные состояния содержат информацию о том, какие объекты в проекте 

выключены и не видны, а какие видимы. 

 

Рис.  1.14 Краткое описание вкладки Visibility. 

Пользователь может видеть, что информация о проводящем рисунке делится на 

информацию о следующих видах объектов: 

 Etch – все проводящие линии на ПП. 

 Via – все переходные отверстия на ПП. 

 Pin – все пины на ПП. 

 DRC – все ошибки, возникающие при проверке платы на соответствие правилам 

проектирования и ТЗ. 



 

 All – собирательный тип данных. Включает или отключает все виды объектов на 

указанном типе слоёв. 

В левой части окна можно увидеть, что слои на печатной плате делятся по своему 

функциональному назначению. Слои земли и питания называются Planes. Слои, содержащие 

трассировку сигнальных линий, называются Conductors. Слои масок называются Masks. Если 

напротив определенного типа слоёв поставлена галочка, то данный тип слоёв будет 

отображаться в нижней части окна Visibility. Например, если снять галочку с Planes, то можно 

будет управлять видимостью только сигнальных слоёв, а слои земли и питания выбрать будет 

нельзя. Однако если воспользоваться преднастроенными видами, то видимость внутренних 

слоёв будет взята из преднастроенных видов (плёнок). 

 

 

Рис.  1.15 Одно из состояний вкладки в проекте. 

 



 

 

Рис.  1.16 Состояние вкладки, когда галочка видимости снята со слоёв Conductors. 

 

На данной вкладке можно управлять видимостью не только указанных типов объектов. 

Можно добавить сюда дополнительные типы объектов для быстрого включения или 

выключения. Для этого необходимо найти в верхней части экрана иконку, указанную на Рис.  

1.17, и нажать на неё. Иконка называется “color192”. Именно столько цветов доступно 

пользователю при выборе цвета объектов. После нажатия перед пользователем откроется 

диалоговое окно Color Dialog. 

 

Рис.  1.17 Иконка Color192 – управление цветом объектов. 

 



 

 

Рис.  1.18 Вкладка Visibility Pane диалогового окна “Color Dialog”. 

На Рис.  1.18 даны пояснения к различным областям диалогового окна. Если пользователь 

перенесёт определенный тип объектов из раздела Available classes в раздел Visible classes, то 

данный тип объектов схематически отобразится рядом цветных квадратов на вкладке Visibility. 

Однако для управления видимостью доступны не все виды объектов, а только лишь 

преднастроенный перечень. Если пользователю необходимо добавить новый тип объектов 

для быстрого отображения или скрытия, к примеру маски над пинами в слое TOP, то 

необходимо перейти на самую левую вкладку окна “Color Dialog”. Необходимая пользователю 

вкладка называется “Layers”. Выглядит она примерно так, как показано на Рис.  1.19. После 

этого надо нажать на любом цветном квадрате в центральной части окна правую клавишу 

мышки и выбрать пункт Add to visibility. Для рассматриваемого примера пользователю 

необходимо раскрыть класс объектов Stackup, затем подкласс Non Conductor, затем найти тип 

объектов Pin. Далее найти подкласс объектов Soldermask TOP.  



 

 

Рис.  1.19 Вкладка Layers диалогового окна Color Dialog. 

 



 

 

Рис.  1.20 Добавление масок над пинами в слое TOP. 

 

Возможно, начинающему пользователю данная организация данных в проекте покажется 

излишне сложной. Однако как только пользователь выучит то, какие классы и подклассы 

данных существуют в проекте, и какая информация отнесена в те или иные классы, 

управление видимостью объектов на ПП станет простым и удобным. 

Рассмотрим другие вкладки окна Color Dialog. 



 

 

Рис.  1.21 Вкладка Nets окна Color Dialog. 

На Рис.  1.21 представлена вкладка Nets. Она позволяет управлять цветом различных 

электрических сигналов, а также цветом объектов, принадлежащих этим сигналам. Для 

изменения цвета объекта необходимо сначала выбрать нужный оттенок в нижней области 

окна, а затем нажать левой клавишей мыши на тот тип объектов, который пользователь 

желает изменить. Все цепи в проекте могут быть поделены на группы, содержаться в шине 

сигналов, могут быть простыми или составными. Данное деление цепей видно в левом 

верхнем углу диалогового окна. Если какой-то раздел не пуст, то его можно раскрыть, нажав 

на небольшой серый прямоугольник, расположенный слева от названия раздела. 

 

Рис.  1.22 Вкладка Display окна Color Dialog. 

Во вкладке Display пользователь может управлять прозрачностью трассировки, а также 

цветом виртуальных связей, соединяющих пины компонентов. Назовём эти электрические 



 

виртуальные связи “резинками”. На английском языке они называются Rats. Прозрачность 

слоёв трассировки изменяется ползунками от полной невидимости (прозрачности), до полной 

непрозрачности. Это удобно при анализе трассировки на смежных слоях. 

Во вкладке Favorites содержится список подклассов, которыми инженер часто пользуется и 

не хочет искать их каждый раз во вкладке Display. 

Вкладка Find и поиск объектов с помощью Find By Query. 

Данное диалоговое окно позволяет производить настройку фильтра для текущей команды, 

которую активировал пользователь. Программа будет иметь возможность производить некие 

действия только с тем видом объектов, напротив которого пользователь установил галочку. 

Причём, если галочек установлено несколько, и в области выбора находится несколько 

различных объектов, то будет выбран самый “старший” объект. Самый старший объект в 

проекте – это группа (Groups). Затем следует посадочное место компонента (Comps) и так 

далее до “резинок” (Ratsnests). Резинки – самый младший объект в проекте. Если необходимо 

выбрать его, то нужно либо отключить все остальные галки, либо очень точно 

позиционировать свой курсор мышки. 

 

Рис.  1.23 Вид вкладки Find. 

Если пользователю необходимо выбрать несколько объектов, руководствуясь сложным 

критерием, то необходимо воспользоваться инструментом формирования запросов. Он 

называется “Find by Query”. Рассмотрим его работу на примере. 

Допустим, пользователю требуется выделить все компоненты, в названии которых 

содержится цифра “20”. После открытия диалогового окна, в левой его части пользователь 

видит список всех классов, на которые поделены данные в проекте. Необходимо кликнуть на 

класс компонентов (Components). Во вкладке Fields появится список подклассов или же 



 

свойств, которые могут принадлежать классу компонентов. У компонентов есть порядковые 

номера – RefDes. Необходимо найти данное свойство и два раза кликнуть по нему левой 

клавишей мышки. Данное свойство перенесётся в правую область, которая называется Filters. 

Далее пользователю необходимо настроить фильтр правильным образом. Это похоже на 

формирование поисковых запросов в для поиска файлов ОС Windows. После того, как запрос 

будет сформирован, в нижней части окна появится список всех объектов, которые 

удовлетворяют условиям запроса. Далее пользователь может выделить любой компонент, 

либо все компоненты вместе при помощи клавиши SHIFT. Следующим действием 

пользователь должен выбрать команду, которую он собирается применить к выбранным 

компонентам. И необходимое действие произойдет над всеми выбранными компонентами. 

 

Рис.  1.24 Диалоговое окно Find by Query. 

Более простым инструментом для поиска является область вкладки под названием “Find by 

Name”. При помощи инструмента “Find by Name” пользователь может найти и выделить 

интересующие его типы объектов по их имени. 

 

Рис.  1.25 Область Find by Name. 



 

 

Рис.  1.26 Типы объектов, которые можно искать при помощи Find by Name. 

В целом, назначение вкладки Find в том, чтобы выделить объекты, над которыми 

пользователь собирается произвести действия. Будьте внимательны – дело в том, что ее 

состояние запоминается индивидуально для каждой команды. Поэтому, если вы работаете 

способом «сначала команда – потом выбор объектов», то в зависимости от активной команды 

у вас каждый раз будет отдельное состояние фильтра, запомненное именно для этой 

команды в прошлый раз. Если же вы предпочитаете работать способом «сначала выбор 

объектов – потом команда», то состояние фильтра всегда будет одинаковое, запомненное для 

ситуации, когда никакая команда еще не активна. 

Вкладка Options.  Настройка текущей команды. 

Данная вкладка является диалоговым окном настроек активной команды или активного 

действия, которое в данный момент выполняется пользователем. Внешний вид вкладки 

изменяется в зависимости от действия или команды. Описание параметров в этой вкладке мы 

будем давать по мере того, как будем описывать ту или иную команду. 

 

Рис.  1.27 Внешний вид вкладки Options для команды Move. 



 

При выполнении команд обращайте особое внимание на вкладку Options, проверяйте, что 

ваши настройки для команды соответствуют тому, что именно вы хотите сделать. Например, 

при выполнении команды Move (перемещение) можно указать в опциях конкретный номер 

вывода компонента, к которому будет осуществляться привязка курсора. Но если вы 

попытаетесь потом переместить другой компонент, у которого вообще нет вывода с таким 

номером (у разъемов часто бывает буквенно-цифровая нумерация) – система не сможет 

выполнить это действие, и надо будет в окне Options поменять номер вывода на 

существующий, или вообще выбрать вариант Symbol Origin или User Pick, чтобы позволить 

системе выполнить команду (Рис.  1.27). 

Принцип организации информации в САПР Cadence Allegro PCB editor. 

В ходе повествования уже упоминалось, что вся информация в проекте САПР Cadence 

Allegro PCB Editor делится по определенным признакам. На этом делении основана работа со 

всеми объектами в проекте. 

Существует деление на основные группы. В программе они называются классами. 

Основные группы делятся на подгруппы. Они называются подклассами.  

Приведем пример: 

Для формирования сборочного чертежа пользователю всегда необходим контур печатной 

платы и контура компонентов, установленных на этой печатной плате. Так вот контур 

печатной платы находится в классе Board Geometry (геометрия ПП) и подклассе Outline 

(Границы). А вот контура корпусов компонентов находятся в классе Package Geometry 

(геометрия компонентов), подклассе Assembly_TOP (если компонент расположен на cлое 

TOP) или Assembly_BOT (если компонент расположен на слое BOTTOM). 

Рассмотрим основные классы, на которые разделена информация в проекте ПП: 

- Package geometry – Класс содержит всю информацию, которая относится к компоненту. 

Сюда прежде всего относятся непроводящие линии и геометрические объекты на слоях 

маркировки, сборочных, слоях маски и пасты. Сюда же относятся различные зоны такие как 

Place Bound TOP/Bottom, DFA TOP/Bottom. Т.е. в этом разделе собрано всё, что относится к 

компоненту (посадочному месту) и не проводит электрический ток. 

- Pin – В данном разделе собраны объекты, принадлежащие пинам компонентов. Сюда 

входят в первую очередь контактные площадки пинов на всевозможных уровнях. Т.е. их 

проводящие ток части. А также здесь расположена информация о вскрытиях пинов на слоях 

масти и пасты.  Стоит обратить внимание, что, хотя пины и принадлежат компонентам, в 

раздел Package Geometry пины не попали. 

- RefDes – Класс содержит информацию о позиционных обозначениях компонентов. Тут 

расположены как обозначения для слоя шелкографии, так и для других слоёв. 

- Board Geometry – Раздел очень похож на Package Geometry, однако расположенная тут 

информация принадлежит не определенному посадочному месту, а всему проекту печатной 

платы. Т.е. если пользователь в процессе проектирования что-то нарисовал для сборочного 

чертежа или же вскрыл какие то области от паяльной маски на печатной плате 

самостоятельно, то такие объекты следует располагать в разделе Board Geometry. Сюда не 

входят проводящие ток объекты. 

- DRC Error Class – В данном классе располагаются маркеры DRC ошибок. Маркеры 

расположены на различных слоях ПП. Слои и составляют подклассы данного объекта. 



 

- Via Class – Раздел содержит всю информацию, относящуюся к переходным отверстиям. 

Тут расположена информация о проводящих ток частях переходного отверстия, так и о 

вскрытиях от маски и паяльной пасты.  

- Constraint Region – Тут содержится информация о границах регионов, в которых 

действует набор правил, отличный от проекта в целом. Т.е. при перечечении этих границ 

трассировка начинает подчиняться другим наборам DRC констант. 

- Etch – Класс содержит информацию о линиях и полигонах, проводящих электрический ток. 

Т.е. о всей трассировки на печатной плате за исключением пинов и переходных отверстий, 

которые вынесены в отдельные разделы. 

- Route Keepin/Route Keepout – Содержит границы областей на различных слоях или 

целом проекте, в пределах которых должна/не должна присутствовать трассировка. Логично 

обрисовывать областью Route Keepin->All контур печатной платы с неким отступом от края. 

Области Route Keepout могут во множетсве располагаться на печатной плате в различных 

местах, куда не должна заходить трассировка. 

- Package Keepin/Package Keepout – Смысл практически идентичен с Route Keepin/Route 

Keepout только речь идет о корпусах компонентов. 

Остальные классы не столь важны в процессе работы над проектом и описываться не 

будут. Пользователь может ознакомиться с их назначением в разделе Help. 

Если пользователь хочет получить информацию об определенном объекте на ПП, он 

должен хотя бы примерно представлять, к какому типу относится данный объект. Это нужно 

для того, чтобы правильно настроить фильтр выделения во вкладке Find и применить 

выбранную команду к нужному пользователю объекту. 



 

 

Рис.  1.28 Список классов объектов для вкладки Color Dialog. 

На Рис.  1.28 можно видеть весь список объектов, видимостью которых можно управлять. 

Т.е. это список классов видимости. Более подробное описание классов объектов приведено в 

разделе Служебные слои (классы и подклассы объектов) в проекте ПП. 

Однако информацию можно делить не только по признаку видимости. На Рис.  1.29 

представлен список классов по признаку принадлежности различным областям печатной 

платы. Или, другими словами, различным типам объектов на печатной плате. 

Некоторые подклассы являются пользовательскими, и их можно добавлять или удалять. 

Инженер вправе давать им произвольные названия и размещать в них ту информацию, те 

виды графических объектов, какие посчитает нужным. 



 

 

Рис.  1.29 Список классов объектов в проекте ПП. Подклассы для класса Board geometry. 

Пользовательские подклассы выделены белым. Подклассы, которые обязательно должны 

присутствовать в проекте, являются системными. Их нельзя удалить или изменить их 

название. Они выделены серым цветом. 

Подводя итог, можно сказать, что весь проект состоит из маленьких кирпичиков. Кирпичики 

имеют различную форму (это как раз подклассы объектов). И кирпичики разной формы 

составляют стену здания (это класс объектов). Каждый кирпичик, из которого состоит здание, 

пользователь может раскрасить в свой цвет, налепить на него бирку или удалить из стены. 

 

Настройка панелей инструментов. 

Следующим разделом, который можно настроить под пользователя, являются панели 

инструментов и их иконки. Видимостью тех или иных панелей можно управлять в разделе 

View->Customize Toolbar. После выбора данного пункта меню перед пользователем возникнет 

диалоговое окно, изображенное на Рис.  1.30. 



 

 

Рис.  1.30 Диалоговое окно управления видимостью панелей инструментов. 

Пользователь может перенастраивать порядок следования иконок в панелях на вкладке 

Commands. Можно создавать свои панели инструментов. Достаточно на вкладке Toolbars 

нажать на New, ввести имя панели, а на вкладке Commands добавить необходимые команды 

в новую панель инструментов. 

Настройка горячих клавиш. 

Интерфейс САПР Cadence Allegro гибко подстраивается под привычки пользователя с 
помощью горячих клавиш и настроек. 
Для создания горячей клавиши применяется команда funckey 
Для создания функциональной команды применяется alias 
Вы можете задавать их в текущей сессии в командной строке, проверить, и добавить 
проверенные команды к файлу настроек ENV. 
Например, можно создать следующие команды: 
funckey + subclass -+ “+” -выбрать следующий слой как активный 

alias F5 show element F5 -показать информацию о выбранном объекте 

alias rps "replace padstack" rps-заменить падстек 

Вы можете добавить в файл ENV ваши определения для горячих клавиш и текстовых 

команд. 

Горячие клавиши можно вызывать в окне редактирования топологии. Причем они могут 
состоять из нескольких нажатий подряд, например, pt для создания трассы, pv для via и т.д. 
Команды можно набирать в окне Command. Вы можете программировать последовательность 
команд редактора как одну макрокоманду. Можно выполнять перебор значений из заданного 
списка по каждому вызову команды. Можно вызывать скрипты с диска. 

Горячие клавиши и команды чувствительны к регистру и языку. 

Настройки редактора Allegro PCB Editor 

 
Глобальные настройки Allegro хранятся в папке %CDSROOT%/share/pcb 



 

Никогда не изменяйте файлы в этой папке и подпапках!!! 
1. Глобальные настройки редактора PCB хранятся в файле 
%CDSROOT%/share/pcb/text/env 

2. Общие настройки компании находятся по умолчанию в папке: 
%CDSROOT%/share/local/pcb – но для крупной компании лучше расположить их в сетевой папке, и 
настроить переменную среды CDS_SITE на нее. 
3. Личные настройки пользователя хранятся в папке, на которую указывает переменная HOME 
на локальном компьютере. 

Максимальный приоритет имеют личные настройки, потом общие. 

Файл настроек ENV 

Пути к файлам ENV можно узнать в окне Command: 
echo $envpath 

Путь к личному (локальному) файлу ENV:  
echo $LOCALENV 

Не корректируйте секцию локального файла ENV, содержащую последовательность команд 
set – эта секция изменяется редактором при вызове диалога Setup - User Preferences. 
Все ваши дополнения и горячие клавиши вносите перед строкой: 
### User Preferences section 

после первой строки source $TELENV. 

Задание команд – Alias 

Можно использовать Функциональные кнопки F2-F12, большинство алфавитно-цифровых клавиш с 
модификатором CTRL/SHIFT/ALT (хотя Control - C, V и X зарезервированы для copy, paste и cut) и 
Навигационные кнопки (Home, Up arrow, Esc, и т.д.). Доступны следующие модификаторы: 
Модификатор Обозначение Пример 
Shift S SF2  
Control  C (function keys) CF2 
Control ~ (alpha-numeric) ~NMetaAAF2 
Модификаторы можно комбинировать.  
Примеры:  
Обозначение Комбинация клавиш 
CSF2 Control-Shift F2 
ASF2 Meta-Shift F2 
CAF2 Control-Meta F2 
CASF2 Control-Meta-Shift F2 
~SZ Control-Shift Z 
Sup Shift-Up  
ArrowCUp Control-Up Arrow 

Горячие клавиши – Funckey 

Используйте funckey, когда вы хотите, чтобы буквенно-цифровые клавиши (без 
модификатора) работали как Функциональные кнопки во время нахождения курсора в области 
редактирования топологии. 
Пример – выбрать команду «переместить» без нажатия Enter: 
funckey m move нажатие “m” задаст команду «переместить» 



 

При использовании команд и горячих клавиш обращайте внимание на то, чтобы в командной 
строке не было случайно введенных ранее символов, т.к. это может помешать распознаванию 
ваших команд: 
Command > [тут не должно быть случайно введенных символов] 

Лишние символы удалите клавишей Backspace. 

Как узнать имя и параметры команды, которую вы хотите назначить 

Используйте команду в окне Command: 
scriptmode +e 
для отображения команд, которые вы выполняете в редакторе. 
Затем скопируйте отобразившиеся команды и соедините их в одну строку, разделяя точкой с 
запятой и заключив в кавычки, и назначьте на функциональную клавишу или команду. 
Если вы хотите скрыть отображение диалоговых окон при исполнении скриптов, используйте 
команду: 

scriptmode +i 

Более подробно читайте в документе:   
“Настройка интерфейса Allegro PCB Designer” ООО «ПСБ СОФТ», г.Москва 
 

Окно Design Parameters Editor. Настройка параметров проекта. 

Перед тем, как начать совершать первые действия в своём проекте ПП, необходимо 

настроить единицы измерения, шаг сетки и некоторые другие аспекты визуального 

отображения. Для этого необходимо активировать пункт меню Setup -> Design parameters 

 

Рис.  1.31 Активация меню настройки параметров проекта. 

После этого пользователю станет доступным следующее диалоговое окно, изображенное 

на Рис.  1.32 



 

 

Рис.  1.32 Один из вариантов настроек визуального отображения проекта ПП. 

Вкладка Display. Отображение резинок, отверстий, единиц измерения и шага 
сетки. 

Разберём значение каждого параметра и проиллюстрируем на примерах: 

Connect point size – размер символа, отображающего подсоединение объектов.  

Пример: Если повторяющаяся часть трассировки, которая принадлежит шаблону, 

подключена к неповторяющейся части, то на месте соединения появляется графический 

символ в виде ромба, обозначающий подсоединение. 

 

Рис.  1.33 Connect point size – 0.5мм. 



 

Пример 2: Если проводник находится близко от переходного отверстия, но не завершён на 

отверстии, то “резинка” принимает форму незавершенного треугольника. Это делает 

незавершенные линии хорошо заметными. Рис.  1.34 

 

Рис.  1.34 Вид “резинки при значении Connect point size – 0.5мм. 

Если изменить значение параметра на 0.2 мм , то ситуация изменится. См. рис. 35. 

  

Рис.  1.35 Изменившееся отображение “резинок” и точек соединения различных видов трассировки 
при значении Connect point size – 0.2мм.  

Если ещё больше уменьшать значение параметра, то внешний вид резинок придёт к тому, 

который хорошо знаком пользователям PCAD200x. Ситуация, типичная для PCAD, когда 

проводник подошёл к переходному отверстию, но ещё не завершён, в Allegro не будет 

возникать, т.к. будет срабатывать привязка к объекту трассировки. Линия будет сама 

“напрыгивать” на переходное отверстие при достаточном приближении. 



 

 

Рис.  1.36 Изменившийся вид “резинки”. 

DRC Marker Size – размер маркера ошибок. Рис.  1.37. 

  

Рис.  1.37 Маркеры ошибок при значении параметра 0.5мм (слева) и 1мм (справа). 

Rat T (Virtual pin) size – Размер маркера виртуального пина. Это в большинстве 

случаев точка разветвления сигнала при наличии “Т” структуры при прохождении сигнала от 

источников к потребителям. 



 

 

Рис.  1.38 Иллюстрация отображения виртуального пина. 

Max Rband count – Максимальное количество “резинок”, которые будут видны на 

экране. Для современных машин данный параметр может иметь значение и больше 500. 

 

Рис.  1.39 Варианты значений параметра Ratsnest geometry. 

Ratsnest geometry – варианты визуального отображения “резинок”.  

- Jogged – незаконченные треугольники будут отображаться при близком приближении 

линии к другому объекту с тем же именем цепи. Если две контактные площадки имеют 

одну координату по оси Х или Y, то изломы “резинок” также будут отображаться. 

- Straight – вид “резинок”, как в PCAD200x. Простые линии, соединяющие две точки. 

 

 

 

 



 

 

Рис.  1.40 Отображение “резинок” при Jogged. 

 

 

Рис.  1.41 Отображение резинок при Straight. 

 

Рис.  1.42 Варианты значений параметра Ratsnest points. 

 

Ratsnest points – “Резинки” будут рисоваться только от пина до пина при значении Pin to 

Pin, либо от ближайшего сегмента проводящего рисунка до ближайшего при значении Closest 

endpoint.  



 

 

Рис.  1.43 Опции отображения имён цепей на проводящих линиях, полигонах, пинах. 

Отдельно стоит сказать про режим удалённого подключения к рабочему столу 

пользователя. Движок OpenGL, на котором построены некоторые графические возможности, 

может не работать на удалённом рабочем столе. Из-за этого возможности настройки 

прозрачности, отображения имён цепей и некоторые другие отключатся. 

 

Рис.  1.44 Опции отображения различных объектов в проекте ПП. 

Plated holes – Если галочка поставлена, то все металлизированные отверстия в проекте 

будут отображаться на экране.  



 

 

Рис.  1.45 Отображение металлизированных отверстий. 

 

Рис.  1.46 Отверстия скрыты. 

Backdrill holes – Отображение высверливаемых отверстий при обратной сверловке на 

заданную глубину. 

Non-plated holes – Отображение неметаллизированных отверстий в проекте. 

Padless holes – отображение отверстий, у которых нет КП. 

Connect points – Отображение маркеров соединения двух групп трассировки. 

(незакрашенные ромбики) 

Filled pads – залитые КП. 

Connect line endcaps – дорисовка концов линий. Без этой галочки линии будут 

представляться прямоугольными сегментами. 

Thermal pads – отображение не КП, а их термобарьеров при негативных слоях ПП. 

Негативные слои были нужны в САПР типа PCAD для снижения количества вычислений на 

слабых машинах. Сейчас почти не используются. 

Waived DRC – отображение скрытых ошибок DRC. 

Drill labels – отображения слоёв, связываемых несквозным переходным отверстием. При 

наличии обратной сверловки отображается информация о слое, до которого она 

осуществляется. 

Design origin – отображение начала координат в проекте. 

Diffpair driver pins – Отображение при помощи фигур начала сигналов в дифф.паре. 



 

Use secondary STEP models in 3D Viewer – использование альтернативных STEP моделей 

в 3D просмотре (если они вообще подключены) 

 

\  

Рис.  1.47 Отображение КП при снятой галке Filled pads. 

 

 

Рис.  1.48 Отображение проводящих линий при снятой галке Line endcaps. 



 

 

Рис.  1.49 Отображение Drill labels. 

 

Рис.  1.50 Отображение Driver pins треугольниками. 

 

Рис.  1.51 Область управления отображением сетки и её параметрами. 

Управлять видимостью сетки на экране и её параметрами можно вкладке Display. См.Рис.  

1.51. Также можно активировать пункт меню Setup->Grids .  

Более подробное описание см. в разделе редактирования посадочных мест. 

 

Вкладка Design окна Design Parameter Editor. Общие параметры проекта.   

Рассмотрим вторую вкладку диалога – Design Parameters (см. Рис.  1.52), где задаются 

основные параметры редактирования проекта. 



 

 

Рис.  1.52 Вкладка Design окна Design Parameters Editor. 

User units – Единицы измерения проекта. Могут быть изменены по желанию пользователя. 

Size – Размер рабочего поля проекта. Может быть выставлено стандартное значение, либо 

пользовательское. 

Accuracy – Количество знаков после запятой в координатах. 

Long name size – Длина имени цепи, имени падстека, имя функции пина. Значение 

выставлено в максимальное (255). 

Extents – Границы рабочего поля проекта. Значения координат левого нижнего угла и 

длина/ширина поля. 

Move origin – координата нового начала координат. Если начало координат будет 

передвинуто на новое место, то координаты этого места станут 0:0. 

Lock direction – угол, под которым будут проводиться линии. Проводящие линии или 

простая графика – не имеет значения. Можно поставить значение off. Тогда станет возможным 

проводить линии под любым углом. 

Lock mode – Тип графических элементов, которыми будет производиться трассировка, 

либо рисование графики. Это может быть простая линия, либо сопрягаемая окружность. 

Minimum radius – минимальный радиус окружности, который может быть в проекте. 

Fixed 45 length – Длина 45 градусных участков линий. Если галочка напротив значения не 

стоит, то 45-градусные отрезки могут быть любой длины. 

Fixed radius – Фиксированный радиус сопрягаемых окружностей. 

Symbol Angle – Угол, под которым будет устанавливаться символ на печатной плате.  



 

Default Symbol height – Высота посадочного места компонента по умолчанию. Если 

какому-либо компоненту на печатной плате не задано свойство высоты, то оно будет 

автоматически назначено и будет равно указанному значению. Это необходимо при 

выполнении DRC проверок и при построении упрощённой 3D-модели печатной платы. 

Вкладка Text диалогового окна Design Parameter Editor. Настройка текстов. 

 

Рис.  1.53 Вкладка Text. 

Вкладка Text содержит ряд опций для настройки текстов. 

Justification – выравнивание текста по указанной стороне: при значении Left направление 

написания текста осуществляется слева направо. При значении Center текст раздвигается в 

обе стороны от середины.   

Parameter block – номер блока параметров текста, которые используются при написании.  

Parameter name – имя блока параметров текста, которые используются при написании.  

Text marker size – Размер курсора при написании текста. 

Теперь, после описания всех полей настройки текста, стоит поговорить о тексте в Allegro 

PCB editor подробнее. 

Весь текст в PCB editor может состоять только из латинских символов. Русские символы не 

допускаются ни при каких ситуациях. Если необходимо написать русский текст, то существует 

механизм импорта русских символов в виде заполненных полигонов. Может быть 

импортирован любой шрифт, поскольку это будет графический объект, а не текст. Эту 

ситуацию обещают исправить в релизе 17.4, а пока для размещения русских текстов в проекте 

платы применяются специальные скрипты: например, скрипт для ввода текста шрифтом ГОСТ 



 

с сайта www.pcbsoft.ru, или скрипт для ввода текстов шрифтами TrueType с сайта OrCAD 

Marketplace. 

Шрифт в PCB editor используется по факту только один. Пользователь не может выбрать 

стиль текста, отличный от установленного по умолчанию. Однако параметрами текста можно 

управлять. Если пользователь нажмёт на кнопку, которая расположена напротив надписи 

Setup text sizes, то откроется диалоговое окно в котором можно редактировать некоторые 

параметры текста. 

 

Рис.  1.54 Окно управления параметрами текста в проекте. 

У разных видов текста, или т.н. «текстовых блоков», – разные номера и имена. Каждый 

текстовый блок имеет несколько параметров: 

 Width – ширина символа в единицах измерения проекта. 

 Height – высота символа. 

 Line Space – расстояние между двумя горизонтальными строками. 

 Photo width – толщина линии, которой будут рисоваться буквы. 

 Char space – расстояние между двумя соседними символами. 

 Name – имя текстового блока. 

Для получения необходимых размеров текстовых надписей необходимо отредактировать 

соответствующие параметры текста, запомнить номер этих параметров и пользоваться 

данным набором параметров при написании текста. 

Вкладка Shapes окна Design Parameter Editor. Настройки полигонов 

Перед тем, как начать рассматривать полигоны более подробно, необходимо упомянуть, 

что проводящие области на ПП в Allegro (то есть полигоны) могут быть двух видов: 

- Статические полигоны.  



 

- Динамические полигоны. 

Статические полигоны не подчиняются правилам DRC. Имеют всегда полностью 

заполненное состояние. Эти полигоны не изменяются при обновлении полигонов в проекте, но 

пользователь может вручную добавлять в полигоны этого вида вырезы, изменять их границы, 

менять стиль заливки. 

Динамические полигоны подчиняются правилам DRC. Их вид не является чем-то 

постоянным на протяжении времени. Пользователь определяет границы динамического 

полигона, а возможность заливки данной границы определяет программа. Динамический 

полигон может иметь не залитое состояние, находясь на проводящих слоях ПП. Такая 

ситуация возможна, когда два динамических полигона находятся один над одним и приоритет 

прорисовки одного из них более низкий. Однако такая ситуация вызовет ошибку при попытке 

генерации Gerber файлов и должна быть устранена для успешного выполнения операции 

генерации Gerber файлов. 

Заметим также, что поведение динамического полигона, создаваемого вне контуров платы, 

на «свободном» месте (например, при предварительной подготовке фрагментов размещения 

и трассировки), будет отличаться от обычного. Например, на этом участке не будут 

автоматически создаваться термальные подключения к выводам компонентов, т.к. эта 

топология находится вне зоны «разрешенной трассировки». Тогда в дальнейшем, при 

переносе этих фрагментов внутрь контура платы, динамический полигон будет повторно 

сгенерирован с созданием необходимых подключений. 

 

Рис.  1.55 Вкладка Shapes. 



 

Кнопка Edit global dynamic shape parameters. 

Эта кнопка раскрывает перед пользователем окно настроек параметров динамических 

полигонов. Данные параметры будут использоваться по умолчанию при создании нового 

динамического полигона, если пользователь не назначит иное. 

 

Рис.  1.56 Вкладка Global Dynamic Shape Parameters. 

Заполнение полигонов. Вкладка Shape Fill: 

Данная вкладка показана на Рис.  1.56. В верхней части вкладки расположены две кнопки: 

“Update to Smooth” и “Force Update”. Обе они отвечают за перерисовку полигонов по 

требованию пользователя. Однако “Update to Smooth” кнопка активна только тогда, когда один 

или несколько полигонов не соответствуют требованиям “Constraint manager” или их вид 

устарел на данный момент. Обычно это происходит, если параметр Dynamic Fill выставлен в 

значения Rough или Disabled. Если параметр выставлен в значение Smooth, то полигоны 

автоматически устаревают при редактировании каких-либо параметров в Constraint manager. 

Различные значения параметра Dynamic Fill служат для достижения компромисса между 

быстродействием программы и правильностью отрисовки полигонов. Если пользователю 

достаточно видеть только схематическое отображение полигонов и их границы, то 

необходимо выставить Disabled. Если необходимо, чтобы полигоны изображались упрощённо, 

но соответствовали константам проекта, необходимо выставить Rough. Smooth – это полное 

соответствие всем константам и отображение полигона так, как он будет выглядеть на ПП. 

Xhatch style – вид штриховки. Если пользователь желает использовать не полностью 

залитые полигоны, тогда необходимо отредактировать данные параметры. Сетчатые 

полигоны при сегодняшнем уровне развития технологии производства ПП оправданны только 

в гибко-жёстких печатных платах. Сетчатые полигоны уменьшают жёсткость гибкого шлейфа, 

а значит сокращают минимально допустимый радиус изгиба. В остальных случаях следует 

всегда применять полностью залитые полигоны. 

 



 

 

Рис.  1.57 Ситуация, когда были изменены некие константы в проекте и все полигоны требуют 
обновления для соответствия новым константам. 

Вырезы в полигонах. Вкладка Void controls: 

 

Рис.  1.58 Вкладка Void Controls окна Global dynamic shape parameters. 

Artwork format – Формат данных, в котором будут генерироваться Gerber-файлы, 

касающиеся полигонов. Поскольку сейчас в подавляющем количестве случаев 

производственные файлы принимаются заводами в формате RS274x, то нет необходимости 

изменять данный параметр на другие значения. 

 

Minimum aperture gap width – минимальный размер апертуры, которым будет рисоваться 

полигон в Gerber-файле.  



 

Пример: если необходимо нарисовать часть полигона, один из размеров которого менее 

указанной апертуры, то полигон не будет нарисован и не будет отображаться на экране. 

Следовательно, если нужно, чтобы полигон “затёк” между двумя переходными отверстиями, 

то следует немного уменьшить размер апертуры. Хорошим значением будет 0.05мм. При 

данном значении полигон хорошо обтекает все VIA под BGA компонентами, но не создаёт 

слишком тонких структур, которые всё равно не будут проработаны на ПП.   

Suppress shapes less than – Подавление полигонов, площадь которых менее указанной. 

Create pin voids – Возможны два варианта. Individually и In-line. 

 

Рис.  1.59 Различные значения параметра Create pin voids. 

  Данный параметр введён для того, чтобы полигон не пытался затечь между переходными 

отверстиями или пинами, которые расположены между друг другом очень близко. Дело в том, 

что между полигоном и границей КП образуется распределённая ёмкость, которая негативно 

влияет на целостность высокочастотных сигналов. Для её снижения необходимо отодвигать 

полигоны как можно дальше от переходных отверстий, что не всегда возможно. Другой способ 

– это снижение периметра контакта полигона с КП, что и предлагается в этой опции. 

 

Рис.  1.60 Иллюстрация паразитной ёмкости между КП и полигоном. 

Acute angle trim control – Параметр, отвечающий за отрисовку острых углов в полигоне. 

Для более простого объяснения легче всего проиллюстрировать внешний вид полигона при 

всех трёх параметрах. 

 



 

                      

  ROUND                             CHAMFERED                  FULL ROUND 

Рис.  1.61 Acute angle trim control 

Snap voids to hatch grid – – привязка вырезов к линиям штриховки (см. Рис.  1.62). Эта 

опция применяется для сложных плат с целью уменьшения размеров Gerber-файлов и 

паразитных емкостей на переходных отверстиях. 

 

Рис.  1.62 Иллюстрация работы параметра Snap voids to hatch grid. 

Fill Xhatch cells – заливка неполных участков штриховки (см. Рис.  1.63). Эта опция 

позволяет повысить качество и процент выхода годных печатных плат за счет устранения 

некорректных областей со слишком малым зазором. Данный параметр невозможно 

использовать одновременно с опцией Snap voids to hatch grid. 

 



 

 

Рис.  1.63 Иллюстрация работы параметра Fill Xhatch cells. 

Diffpair combined void for vias added with return path option – создание объединенного 

выреза для двух переходных отверстий дифференциальной пары в случае, если включена 

опция автодобавления переходных отверстий для возвратного тока (см. Рис.  1.64). На 

текущий момент этот параметр находится на стадии тестирования. 

 

Рис.  1.64 Иллюстрация работы параметра Diffpair combined void for vias added with return path option. 

Глобальные зазоры. Вкладка Clearances: 

На данной вкладке выставляются превышения относительно исходных зазоров между 

полигоном и другими объектами проводящего рисунка. Исходные зазоры могут браться из 

значений констант для зазоров в проекте, а могут из значений термобарьеров и антипадов, 

разработанных для каждого индивидуального вида КП. Значение зазоров может быть 

изменено только в сторону увеличения относительно исходного. 

Данная вкладка в глобальных параметрах не очень полезна. Если все полигоны в проекте 

должны обтекать SMD пины с увеличенным отступом, то логичнее отредактировать величину 

отступа в настройках констант для зазоров в проекте. А данную вкладку использовать уже для 

редактирования свойств отдельных полигонов. Окно, показанное на Рис.  1.65, может быть 

вызвано и для отдельного полигона, для изменения свойств только одного из множества 

полигонов в проекте. 



 

 

Рис.  1.65 Вкладка Clearances окна Global Dynamic Shape Parameters. 

Термальные зазоры. Вкладка Thermal Relief Connects: 

 

Рис.  1.66 Вкладка Thermal relief connects окна Global Dynamic Shape Parameters. 

Вкладка разделена на три области, которые задают правила подключения термобарьеров к 

различным видам объектов. Для каждого типа объектов можно выбрать способ подключения. 

Затем необходимо указать минимальное и максимальное число линий подключения, 

которыми пин или переходное отверстие будут соединяться с полигоном. Если подключение 

минимальным количеством не будет возможно, то полигон не подключится вовсе. 

Best contact – Если количество подключений к полигону важнее их конфигурации, то 

следует выбирать данную опцию. Тогда программа будет поворачивать линии подключения 

вокруг центра пина с шагом 15 градусов. После этого будет производиться попытка 

нарисовать линии. 

Use fixed thermal width of – ширина соединительных линий берется не из значений 

физических констант проекта для этого типа цепей, а равняется заданному числу. 



 

Use thermal width oversize of – Превышение ширины соединительной линии над 

значением физических констант проекта. Конечная ширина линии будет равна ширине, взятой 

из констант, плюс заданное число. 

Use xhatch thermal width – Использование ширины соединительных линий равной ширине 

штриховки в сетчатых полигонах. 

На этом описание вкладки Edit global dynamic shape parameters оканчивается. 

 

Кнопка Edit static shape parameters. Статические полигоны. 

Хотя внешний вид диалоговых окон данной вкладки немного отличается от уже описанных 

для динамических полигонов, логика настройки и названия параметров остаются прежними. 

Нет смысла описывать настройку данной вкладки подробно. 

Кнопка Edit split plane parameters. Планы земли и питания. 

Данное окно отвечает за полигоны, принадлежащие цепям земли и питания, и 

расположенные на внутренних слоях. Слои, содержащие только такие полигоны, называются 

опорными слоями. В этих слоях протекают возвратные токи от сигнальных линий. И 

относительно них рассчитывается импеданс в разделе Xsection. 

Пользователь может рисовать проводящий рисунок на опорных слоях и при помощи 

простых полигонов. Однако это будет уже другой тип объектов. Разницы при генерации 

файлов для производства или при разводке платы практически нет. Различия появляются на 

этапе моделирования, но и там они довольно малы. Так что можно не пользоваться 

объектами split plane при работе. Краткое описание будет дано ниже. 

 

Рис.  1.67 Диалоговое окно настроек вкладки Split plane params. 

На Рис.  1.67 пользователь может выбирать стиль заполнения объектов Split plane. 

Добавляется данный тип объектов через команду Setup->Outline->Plane outline. 



 

 

Рис.  1.68 Добавление объекта Split plane. 

 

Рис.  1.69 Окно добавления Split plane объекта. 

Command Operations (действия над объектом) 

 Create – создать новый объект 

 Edit – редактировать существующий 

 Move – передвинуть 

 Delete – удалить 

Shape Data (параметры объекта) 

 Layer – Слой, на котором будет создан объект. 

 Net – Название цепи, которой будет принадлежать объект. 

 Voltage – Напряжение данной цепи в Вольтах. 

Create options (способ создания объекта) 

 Draw rectangle – нарисовать прямоугольный контур 



 

 Place rectangle – задать размеры прямоугольного контура, и программа сама нарисует 

контур. Пользователь останется только расположить его по нужным координатам. 

 Draw polygon – Нарисовать полигон сложной формы. 

 Copy from plane – Скопировать из другого Plane (возвратного) слоя. 

 Copy board outline – Скопировать границы с контура печатной платы. 

Вкладка Flow Planning раздела Design Parameter Editor. Настройка 
планирования. 

Обсудим, в чем заключается операция «планирования» проекта перед его трассировкой, 

т.к. это очень мощная и полезная функция Allegro.  

Проекты больших и сложных печатных плат, как правило, перегружены цепями, идущими в 

разных направлениях. Вначале работы над проектом трудно определить, где, сколько и какие 

цепи следует провести для успешной трассировки проекта. Однако логично было бы 

разделить все цепи по группам, руководствуясь определенными параметрами. Их можно 

разделить по принадлежности к интерфейсам (DDR3, USB, SFP+), по назначению цепей (цепи 

данных или адресов) и т.д. После разделения цепей по группам следует задать в разделе 

констант (DRC) отношения между цепями в группе и отношения между группами/классами 

цепей.  

Другими словами, необходимо задать ширину линий трассировки цепей и величину зазоров 

между элементами проводящего рисунка. 

После этих действий можно не отображать все «резинки» в проекте, заменив их объектами, 

которые отвечают за группы цепей. Эти объекты обозначат место, которое займут цепи при их 

трассировке в определенном слое печатной платы. Данные объекты называются Pipe, а 

затем, при распределении порядка следования сигналов, – Flow. На рисунке Рис.  1.70 и 

далее показана часть проекта ПП до и после операции Flow Planning. Максимальные 

возможности по операциям над путями Flow, включая их автоматизированную трассировку, 

открываются при наличии опции Allegro PCB Design Planning. 

Пользователь может выполнить предварительную разводку проекта сразу группами цепей. 

Станет ясно, сколько места займут цепи в разведенном состоянии, по каким слоям они пойдут, 



 

т.к. видимостью объектов Flow можно управлять. Можно отключить все объекты кроме 

расположенных на интересующем пользователя слое. 

Процесс работы с объектами Flow и его настройки рассмотрены в разделе документации, 

описывающем опцию Planning. 

 

Рис.  1.70 Часть проекта ПП до применения операции Flow Planning. 

 

Рис.  1.71 Часть проекта ПП после применения операции Flow Planning. 

Вкладка Route раздела Setup Parameter Editor. Настройка трассировки 

Вкладка, представленная на Рис.  1.72, содержит несколько разделов с настройками. 

Рассмотрим их последовательно. 

Трассировка. Раздел Add Connect. 

Layer mode – режим переключения между слоями 

- alternate subclass 



 

- working layers 

Определяет метод создания переходных отверстий при двойном клике мышкой во время 

разводки. Если выбрано значение “alternate subclass”, то для формирования переходного 

отверстия пользователю необходимо будет указать слой, куда перейдёт трассировка, и 

выбрать падстек переходного отверстия. Если выбрано значение “working layers”, то логика 

работы при добавлении переходных отверстий изменится. Необходимо будет нажать на 

кнопку “Working layers” во вкладке Options. После этого появится диалоговое окошко со 

списком слоёв, на который возможен переход трассируемого сигнала. Необходимо будет 

выбрать нужный слой и два раза кликнуть мышкой на месте, где будет поставлено переходное 

отверстие. Появится отверстие, и станет активным новый выбранный слой трассировки. 

 

 

Рис.  1.72 Вкладка Route, раздел Add Connect. 



 

 

Рис.  1.73 Вид окна options при значении параметра Layer mode равном Alternate subclass. 

 

Рис.  1.74 Вид окна options при значении параметра Layer mode равном Working Layers. 

Line lock – Параметр отвечает за то, какими примитивами будет производиться 

трассировка.  

- Line – трассировка производится отрезками линий 

- Arc - трассировка производится отрезками дуг 

Число, которое следует после параметра, отвечает за угол поворота линий или дуг.  

Line width – Ширина линии, которой производится трассировка. Ширина по умолчанию 

берётся из физических констант проекта. Но пользователь может сменить её на любое другое 

значение, если того требует ситуация. 

Miter – Значение минимального отрезка линии или радиуса скругления при повороте 

трассы на заданный угол. Структура похожа на фаску. Можно вводить значение в единицах 

проекта. Пример: 0.1, 0.2, 0.3, или кратно текущей ширине линии, с суффиксом “x”, например, 

2x. Если в следующем поле указано Min, то предыдущее значение будет являться 

минимально возможным. Если указано Fixed, то при скруглении линии радиус поворота будет 

равен строго указанному значению. 

Bubble – Управление расталкиванием трасс. Может работать в трёх режимах. 



 

- Shove preferred – Расталкивание проложенных линий происходит максимально легко и 

на любое расстояние. 

- Hug preferred - Расталкивание проложенных линий происходит только в крайних 

случаях. 

- Hug only - Расталкивание проложенных линий не происходит. Трассировка прижимается 

к уже существующей. 

- Off – Выключаются все проверки на соответствие прокладываемой трассировки 

правилам и константам. 

Shove vias – Расталкивание переходных отверстий при трассировке. Схоже с 

расталкиванием трассировки. 

Gridless – Позволяет трассировке не попадать в узлы сетки. 

Clip dangling clines – Удаляет не подключённые проводники или петли, появляющиеся в 

процессе трассировки. Обычно применяется с режимом Showe preferred. 

Smooth – Сглаживание линий при расталкивании трассировки. Удаление ненужных или 

излишних сегментов линий, точек излома. 

Snap to connect point – когда трассируемая линия приближается к переходному отверстию 

или пину, трассировка будет автоматически завершена в центре отверстия или пина. Нет 

необходимости точно попадать в центр объекта. 

Replace etch – удаление старых сегментов при прокладке нового пути следования 

проводника. Старый путь полностью удаляется после окончания прокладки нового пути уже 

разведенного сигнала. 

Auto blank other rats – при начале трассировки одной цепи «резинки» других цепей 

исчезают с экрана, а при завершении трассы – опять появляются. Это упрощает 

ориентирование пользователя в процессе трассировки. 



 

 

Рис.  1.75 Вкладка Route, раздел Delay Tune. 

Выравнивание длин. Раздел Delay Tune. 

При трассировке скоростных сигналов бывает необходимо обеспечить одинаковую 

задержку распространения от источника до приемника для нескольких цепей в группе. Данный 

раздел отвечает за то, какими структурами осуществляется набор длины проводников внутри 

одной группы при выравнивании задержки. 

Style – Определяет вид структуры.  

Gap – зазор между двумя соседними линиями, из которых состоит структура. Желательно 

выбрать как минимум 3х width, а для высокоскоростных цепей – 5x, иначе влияние соседних 

плеч проводника друг на друга скажется на качестве сигнала. 

Corners – Значение угла поворота линий, формирующих структуру, в градусах. 

Miter size – Значение “фаски” при повороте линии на 90 градусов.  



 

 

Рис.  1.76 Иллюстрация Miter. 

Allow DRC’s – Программа при подгонке длин будет учитывать значения констант проекта 

по зазорам и ширинам и создает маркеры ошибок при нарушении DRC.  

Корректировка трасс. Раздел Edit Vertex. 

Настройки раздела очень похожи на те, которые рассматривались в “Add Connect”. Так что 

не будем останавливаться на них подробно. Отметим только, что команда редактирования 

вершин может быть выбрана в меню Edit->Vertex, либо при одновременном нажатии 

SHIFT+F9. 

 

 

Рис.  1.77 Вкладка Route, раздел Edit vertex. 

Смещение трасс. Раздел Slide.  

Данный раздел отвечает за изменение существующей топологии при смещении 

(слайдировании) сегментов трассировки.  



 

 

Рис.  1.78 Вкладка Route, раздел Slide. 

Min corner size / Min arc radius – Минимальный размер “фаски” или скругления при 

редактировании точки излома линии. 

Vertex action – Действия, которые будут автоматически предприниматься при выделении 

пользователем точки излома линии. 

- Line corner / Arc corner – Программа будет пытаться заменить место излома линии 

“фаской” либо участком окружности. 

- Move – Движение точки излома, которую выделил пользователь. Угол подхода линий к 

точке излома остаётся неизменным. Т.е. и концы линий, и их начала сдвигаются так, 

чтобы угол линии не изменялся. 

- Edit – Движение точки излома с изменением угла подходящих к точке линий. Т.е. начало 

линий остаётся на прежнем месте, а концы сдвигаются за указателем мышки. 

- None – Редактирование положения точки излома не происходит. Возможно только 

перемещение какого-либо сегмента линии целиком. Т.е. пользователь может выделять 

только сегменты линий для редактирования, но не их концы. 



 

 

Рис.  1.79 Иллюстрация работы настройки Line corner. 

Bubble – Настройка возможности расталкивания уже существующей трассировки при 

прокладке новой линии. Имеет несколько вариантов действий. Все варианты уже были 

описаны во вкладке “Add Connect”. 

Enhanced arc support – При смещении трассировки будут создаваться сопряжённые 

участки окружностей, если трассировка будет встречать на своём пути круглые объекты. 

 

Рис.  1.80 Иллюстрация работы настройки Enhanced arc support. 

Allow DRC’s – Позволяет нарушать правила трассировки сигналов в проекте при 

выполнении операции слайдирования. В месте нарушения будет поставлен маркер ошибки. 

Если данную опцию отключить, то перемещения трассировки не будет происходить, если это 

вызовет возникновение ошибки, или (внимание!) если уже существует ошибка на данном 

участке цепи. 

Auto join – если опция включена, то соседние сегменты цепи, которые пересекает редактируемый 

сегмент при перемещении, автоматически подсоединяются к нему. См. Рис.  1.81 



 

 

Рис.  1.81 Иллюстрация механизма работы настройки Auto join. 

Extend selection – Позволяет включать в выделение передвигаемых объектов участки 

трассировки, которые расположены близко от выбранного. Очень помогает при 

редактировании “П”-образных структур.  

 

Рис.  1.82 Иллюстрация механизма работы опции Extended Selection. 



 

Авто-скругление углов. Раздел Auto-I Convert Corner.  

 

Рис.  1.83 Вкладка Route, раздел Auto-I Covert Corner. 

Инструмент “Convert corner” на данный момент находится в разделе Unsupported prototypes, 

и его полная работоспособность не гарантируется. Активируется этот инструмент из пункта 

меню, показанного на Рис.  1.84 

 

Рис.  1.84 Пункт меню, запускающий инструмент Auto-I Convert Corner. 

 Данный инструмент скругляет все углы в точках излома, заменяя части линий 

окружностями заданного радиуса. Подробно останавливаться на описании параметров 

настроек в данный момент нет смысла, поскольку данная функция официально пока не 

поддерживается. 



 

Создание переходных отверстий на компонентах. Раздел Create Fanout. 

Данный раздел необходим для настройки инструмента по созданию структур для вывода 

сигналов из-под BGA-компонентов и других компонентов со сложными для трассировки 

корпусами. Инструмент запускается из меню “Route->Create Fanout”. После активации данной 

команды пользователь увидит во вкладке Options все те настройки, которые показаны на Рис.  

1.85. Объекты, принадлежащие Fanout, хороши тем, что привязаны к компоненту и двигаются 

за ним в любое место. 

Рассмотрим описание настроек: 

Include unassigned pins – Fanout будет сгенерирован для всех пинов, принадлежащих 

выбранному корпусу. Даже, если эти пины не подключены к цепи. 

Include all same net pins - Fanout будет сгенерирован для всех пинов, которые 

принадлежат одной цепи. В противном случае, Fanout будет сгенерирован только для 

одного пина для каждой цепи. 

Start/End layers – Слои определяют тип доступного отверстия, которое будет 

использоваться для генерации Fanout. 

Via structure – Для генерации Fanout будет использован кусок трассировки, 

включающий в себя одно или несколько переходных отверстий. Этот кусок трассировки 

пользователь должен перед этим определить, как доступную для использования структуру. 

VIA – Тип отверстия, который доступен в проекте, если переход сигналов 

осуществляется со Start слоя на End слой. 

Via Direction – Автоматический шаблон для генерации Fanout. Данных шаблонов 

существует несколько. 

Override Line width – Толщина линии, которой переходное отверстие Fanout будет 

соединяться с пином микросхемы. Если галочку не поставить, то значения ширин линий 

будут взяты из физических констант проекта. Если галочка стоит и значение указано, то 

все линии будут одинаковой ширины. 

Pin-VIA space – Расстояние от края пина до края переходного отверстия. Расстояние 

измеряется ото всех окружающих переходное отверстие пинов. Исходя из этого в 

большинстве ситуаций логично будет указывать не конкретное числовое значение, а 

выставлять “centered”. 

Curve – скругление при сочленении проводников, см. Рис.  1.86. 



 

 

Рис.  1.85 Настройки инструмента Create Fanout. 

 

Рис.  1.86 Иллюстрация настройки Curve. 



 

 

Рис.  1.87 Пример Fanout, автоматически сгенерированного для BGA компонента. 

 

Рис.  1.88 Пример Fanout, сгенерированного человеком. 

На рисунке Рис.  1.87 показан пример создания разветвлений, автоматически 

сгенерированных для BGA-компонента. Рассмотрим, как создавать свои шаблоны Fanout.  

Самым простым способом создания своего шаблона Fanout является импорт/экспорт 

участка трассировки в файл Subdrawing, а затем наложение трассировки на выбранный 

человеком корпус. После этого наложенная трассировка помечается, как Fanout и 

прикрепляется к требуемому корпусу. 

Чтобы прикрепить трассировку к корпусу, необходимо активировать команду Route->Convert 

Fanout-> Mark. После этого настроить фильтр во вкладке Find, как показано на Рис.  1.89. 



 

 

Рис.  1.89 Настройки окна Find для операции подсоединения Fanout к корпусу микросхемы. 

Далее необходимо зажать левую клавишу мышки и потянуть мышку от левого верхнего угла 

видимой области на экране до правого нижнего. Затем отпустить левую клавишу. При 

движении мышки на экране начнёт изображаться увеличивающаяся область прямоугольной 

формы. Всё, что попадёт в данную область, привяжется к компоненту. Поскольку одним 

концом трассировка всегда попадает на пин, принадлежащий определенному компоненту, то 

трассировка и будет привязана к тому компоненту на пин которого она попадает. Так что от 

пользователя требуется только аккуратно наложить требуемый участок трассировки так, 

чтобы концы проводящих линий совпадали с центрами пинов. 

Файлы для производства. Вкладка Mfg Applications раздела Design Parameter Editor. 

Данная вкладка содержит в себе несколько утилит, выполняющих функции подготовки 

различных данных для производства.  



 

 

Рис.  1.90 Вид вкладки Mfg Applications. 

Кнопка Testprep 

Предназначена для управления расположением тестовых точек на печатной плате. 

Размещение этих точек на всех цепях проекта ПП осуществляется в случаях большой 

серийности проекта либо необходимости проведения полного функционального контроля. У 

большинства проектов ПП имеются альтернативные механизмы для проведения контроля, 

например, JTAG-тестирование. 

Кнопка Thieving. Добавление медного заполнения. 

Утилита, позволяющая добавлять группы небольших изолированных участков меди, 

которые необходимы при производстве сложных многослойных ПП по следующим причинам. 

Причина 1. Эти участки меди разгружают внутренние слои по плотности тока при операции 

гальванической металлизации переходных отверстий, а также способствуют более 

равномерному заполнению медью, что улучшает качество и равномерность травления. Для 

более детального пояснения см. описание технологии комбинированного позитивного метода 

изготовления ПП. 

Причина 2. Участки меди компенсируют остаточные внутренние напряжения в 

стеклотекстолите. В итоге ПП меньше коробятся и не выгибаются винтом. 

Причина 3. Эти изолированные участки создают дополнительное препятствие для 

вытекания эпоксидного наполнителя при прессовании. В итоге значение толщины вдоль всей 

площади платы изменяется в меньшей мере.Эти изолированные участки, как правило, не 

влияют на целостность сигналов из-за своих небольших размеров. Однако в случае наличия 



 

прецизионных аналоговых или СВЧ-цепей конструктор должен проконсультироваться со 

схемотехником перед добавлением этих элементов на плату. 

 

Рис.  1.91 Параметры настройки инструмента Thieving. 

Thieving style – Форма медных примитивов, которыми будет выполняться заполнение 

пустых мест. 

Thieving outline – Определение области, в которое будет производиться выравнивание 

меди. 

Size X/Y – Размер медных примитивов по оси Х и Y. 

Clearance – Зазор до элементов проводящего рисунка (линий, пинов, переходных 

отверстий). 

Spacing X/Y – Расстояние между центрами двух соседних графических примитивов. 

Border width – толщина контура, определяющего область заполнения. 

Staggered pattern – Графические примитивы будут располагаться в шахматном порядке. 

Clip to Route Keepin – Можно приблизительно определить заполняемую область. В 

процессе заполнения она будет обрезана до границы Route Keepin. 

All Etch layers – Один контур для заполнения на всех проводящих слоях. Таким образом, 

заполнение всей платы происходит за одну операцию. 

All soldermask layers – элементы генерируются также в слоях маски. 

Кнопка Silkscreen 

Данный инструмент анализирует графику, относящуюся к маркировке, и определенным 

образом модифицирует её. Происходит обрезка линий, находящихся над вскрытиями от 



 

маски. Текстовые объекты перемещаются на свободное место и определенным образом 

поворачиваются. В ходе работы утилиты создаётся дополнительный слой в проекте, который 

расположен в классе Manufacturing и называется Autosilk TOP/BOTTOM. В дальнейшем при 

выводе производственных файлов разработчик может использовать именно эти слои, как 

более корректные с производственной точки зрения. 

 

Рис.  1.92 Диалоговое окно настроек утилиты Autosilk. 

Layer TOP/BOTTOM/BOTH – Выбор сторон печатной платы для которых будет выполнена 

операция автоматической модификации графики маркировки. 

Classes and subclasses – Указание на то, в каких классах и подклассах следует искать 

информацию относящуюся к маркировке. Дело в том, что маркировка компонентов может 

располагаться как в классе Board geometry, так и в классе Package geomentry. В первом 

приближении лучше выставить значение поля в SILK. Считается, что пользователь правильно 

распределял информацию и графические примитивы при создании посадочных мест. 

Elements – Указание на виды объектов, которые следует обрабатывать. Это могут быть 

только текстовые поля, только графические объекты или всё вместе. 

Text Rotation – Указание допустимых углов поворота для текстовых полей. 

Allow under components – RefDes элементов будут располагаться в том числе под 

корпусами компонентов, к которым они принадлежат. 

Lock autosilk text for incremental updates – Запрещает редактирование и передвижение 

объектов, расположенных на Autosilk TOP/BOTTOM слоях при помощи автоматических 

средств. Пользователь всё ещё может осуществлять редактирование. Данная опция 

необходима для того, чтобы маркировка оставалась неизменно при передвижении компонента 

на новое место. 

Detailed text checking – Позволяет располагать КП внутри символов. Например, КП внутри 

буквы О или между сегментами буквы L. Каждый символ в данном случае представляется 

набором линий. 



 

Maximum displacement – определяет максимально допустимое расстояние, на которое 

текст может быть смещен для ликвидации пересечения с КП. 

Displacement increment – Шаг смещения при попытках сдвинуть текст с КП. 

Clear solder mask pad – Текст не должен находиться над вскрытием от маски. В данном 

случае все медные площадки игнорируются.  

Minimum line length – Минимальная длина сегмента линии, которая ещё может оставаться 

на слое маркировки. Слишком короткие отрезки линий будут автоматически удалены. 

Element to pad clearance – минимальный зазор между элементом маркировки и контактной 

площадкой компонента. 

 

Рис.  1.93 Результат работы утилиты Auto Silkscreen. 

Стоит отметить, что на рисунке Рис.  1.93 показан результат совместной работы над 

маркировкой утилиты и живого человека. В сложных ситуациях программа не может 

совершить чудо, но очень полезна для подрезки графики налезающей на КП компонентов. 

Утилита хорошо выполняет поворот отредактированного человеком текста. Т.е. 

необязательно вращать RefDes самому, достаточно только определить оптимальное 

расположение надписи. Чтобы запустить утилиту Auto Silkscreen, необходимо либо нажать на 

иконку , либо выбрать пункты меню Manufacture->Silkscreen. 

Edit Drafting Parameters 

При помощи данного диалогового окна происходит настройка параметров простановки 

размерных линий и числовых значений размеров. 



 

 

Рис.  1.94 Диалоговое окно для настройки параметров простановки размеров. 

Размеры могут проставляться в соответствии с несколькими стандартами. Для российских 

разработчиков рекомендуем выбирать стандарт ISO, наиболее близкий к ГОСТ.  

Далее мы поясним назначение некоторых параметров в диалоговых окнах при выборе 

стандарта ISO. 

Вкладка Text 

 

Рис.  1.95 Вкладка Text диалогового окна Dimensioning Parameters. 



 

Text block – Номер набора параметров для текста при указании размеров. 

Place holder – Разделитель для целых и дробных частей. Будет ставиться точка при 

значении “Period” и запятая при значении “Comma” Пример: 0.5 и 0,5. По ГОСТ надо ставить 

запятую. 

Use leading zero before decimal point – Простановка нуля перед точкой, разделяющей 

целые и дробные части. По ГОСТ – нужно. 

Use trailing zeros after decimal point – Простановка нуля после цифр из дробной части для 

того, чтобы длина размера совпала с указанной в поле Decimal places. Максимальное 

значение данного поля 4 символа. По ГОСТ – не требуется, но желательно, чтобы точность 

числа соответствовала заданным допускам на размеры. 

Align text with dimension line – Располагать текст вдоль размерной линии. По ГОСТ – 

требуется. 

Use diameter symbol for linear dimension – К значению линейного размера будет добавлен 

знак диаметра. По ГОСТ – не нужно. 

Diameter symbol location Leading/Trailing – Положение значка диаметра перед либо после 

текстового значения. 

Secondary dimensions – Опция используется для простановки размеров в двух системах 

измерения. По ГОСТ – не требуется. 

Angular Dimensions – количество знаков после запятой в угловых размерах. 

Вкладка Lines 

 

Рис.  1.96 Вкладка Lines диалогового окна Dimensioning Parameters 

Terminations – Вид графических примитивов на концах размерных линий. 

Leader – Вид примитива для указания объекта простановки радиального размера или 

диаметра.  



 

 

Рис.  1.97 Примеры простановки размеров радиуса и диаметра. 

При простановке размеров вида Radial dimension не происходит захват центра дуги, к 

которой проставляется размер. И размерная линия может располагаться под любым углом к 

дуге. Это стоит учитывать и по возможности пользоваться размерами вида Diametral 

dimension. В данном виде размеров размерная линия всегда располагается перпендикулярно 

к дуге или окружности. 

 

Linear top/left – Вид примитива сверху и слева для простановки линейных размеров. Т.е. 

сверху и слева линейного размера будет всегда ставиться точка, если смотреть Рис.  1.96. 

Linear bottom/right  - Аналогично предыдущему значению. Однако определяется вид 

примитива снизу при простановке линейного размера вдоль оси Y и справа при простановке 

вдоль оси Х. 

 

Рис.  1.98 Один из вариантов простановки линейных размерных линий. 

Arrows – Раздел, отвечающий за размеры примитивов в форме стрелок. 

Bullet diameter – Размер точки на размерной линии. По ГОСТ – не нужна. 

Slash length – Длина косой линии, если выставлен графический примитив Slash. 

Вкладка Balloons 

Вкладка, отвечающая за параметры выносок. 

Tolerancing 

Вкладка, отвечающая за параметры простановки допусков на размеры. 

Методика простановки размеров 

Для того, чтобы начать поставлять размеры, в версии 17.2 необходимо активировать так 

называемую среду простановки размеров (Dimension Environment). Эта среда активируется 

при помощи иконки Dimension Edit, показанной на Рис.  1.99. 



 

 

Рис.  1.99 Активация среды простановки размеров. 

После того, как пользователь нажмёт на соответствующую иконку и активирует среду 

простановки размеров, контекстное меню, выпадающее при нажатии правой клавиши мышки, 

изменится. 

 

Рис.  1.100 Вид контекстного меню при нажатии правой клавиши мышки, если среда простановки 
размеров активна. 

После нажатия правой клавиши и появления выпадающего меню пользователю 

предлагается выбрать необходимое действие. Можно произвести настройку внешнего вида 

размеров, выбрав Parameters. Либо пользователь может производить другие действия. 

Варианты размеров, доступных для простановки 

Linear dimension – Простановка линейного размера. Объекты, к которым можно 

проставить размер, указываются во вкладке Find. Либо пользователь может привязаться к 

любому требуемому месту на ПП при помощи инструмента “Snap pick to”. 

Идеология работы с инструментом привязки: для того, чтобы успешно осуществить 

привязку к требуемому объекту, необходимо знать тип этого объекта. См. Рис.  1.101. 

Допустим, пользователю необходимо привязаться к концу сегмента линии или к точке излома 

линии. В данном случае необходимо выбрать Segment Vertex. Однако выбирать пункт 

необходимо тогда, когда курсор мышки уже находится в пределах данного объекта.  



 

Последовательность действий: 

- Необходимо активировать простановку линейных размеров 

- После активации нужного вида размеров необходимо навести курсор мышки на нужный 

объект, к которому пользователь хочет привязаться. 

- Затем следует нажать правую клавишу мышки, находясь в пределах этого объекта. 

- После нажатия клавиши пользователь выбирает тип объекта, к которому будет 

осуществлена привязка. 

- После данных действий на конце сегмента линии для рассматриваемого примера 

появится значок засечки/маркера. 

Необязательно попадать в конец линии идеально точно. Достаточно, чтобы конец линии 

находился в пределах перекрестия, которым изображается курсор. Если необходимо 

привязаться к пину компонента, то курсор должен находиться над нужным пином в момент 

осуществления привязки. В общих словах - необходимо находиться либо над объектом 

привязки, либо достаточно близко от него. На Рис.  1.102 иллюстрируется механизм 

определения точки привязки по команде Snap pick to. 

 

 

Рис.  1.101 Виды объектов, к которым может быть осуществлена привязка. 



 

 

Рис.  1.102 Иллюстрация работы механизма определения точки привязки по команде “Snap pick to”. 

Datum dimension – Определение нулевой точки, относительно которой будут 

проставляться размеры до объектов по оси Х и Y. При выборе данного вида размеров 

необходимо совершить следующие действия: 

 

Рис.  1.103 Определение начала координат для простановки Datum Dimension. 

- Определить точку начала координат и длину выносных линий с засечками по осям Х и Y 

см. Рис.  1.103. 

- После отрисовки линий засечек необходимо выбрать объект простановки размеров, 

кликнув на символ, пин, линию и т.п. 

- Затем необходимо определить место расположения текста размера по оси Х и Y. 



 

 

Рис.  1.104 Итоговое состояние простановки размеров относительно ноля. 

При простановке данного вида размеров существует возможность генерации 

дополнительных сегментов линий, ведущих от линий по оси X/Y, изображенных на Рис.  1.104, 

до той точки, которую укажет пользователь. Если в генерации дополнительных сегментов 

линий нет необходимости, то после первого же клика левой клавишей мышки в определенной 

точке проекта, необходимо нажать правую клавишу и в выпадающем меню выбрать строку 

Next. Тем самым пользователь перейдёт к простановке размера относительно следующей 

оси. После указания места размера относительно следующей оси необходимо опять нажать 

правую клавишу мышки и выбрать Done для завершения операции. На Рис.  1.105 показана 

ситуация при простановке параметра Datum dimension, которая возникнет, если правую кнопку 

мыши не нажать вовремя. 

 

Рис.  1.105 Ситуация при простановке Datum dimension, которая возникнет, если правую кнопку 
мышки не нажать вовремя. 

Angular dimension – Постановка значения угла между двумя сегментами линий. 

Механизм работы с данным типом размеров интуитивно понятен. Необходимо указать два 

сегмента линий и расположение текста.  



 

 

Рис.  1.106 Пример постановки углового размера. 

Leader line – Это простая многосегментная линия со стрелкой. Необходимо выделить 

объект, к которому будет привязан конец линии и стрелка. Затем указать столько сегментов, 

сколько требуется. 

 

Рис.  1.107 Пример Leader Line. 

Diametral leader – Многосегментная линия со стрелкой, показывающая диаметр 

окружности. Процедура создания такая же, как и для Leader line. 

 

Рис.  1.108 Пример Diametral leader. 

Radial leader - Многосегментная линия со стрелкой, показывающая радиус окружности. 

Процедура создания такая же, как и для Leader line. 



 

 

 

Рис.  1.109 Пример Radial leader. 

Baloon leader – Многосегментная линия со стрелкой на конце которой расположена ссылка 

на конструкторское требование. 

 

Рис.  1.110 Пример Baloon leader. 

Chamfer leader – Многосегментная линия со стрелкой, указывающая размер фаски. 

 

Рис.  1.111 Пример Chamfer leader. 

В большинстве случаев при рисовании различных видов многосегментных линий не 

получается точно отложить определенное расстояние вдоль оси Х или Y при помощи только 

одной мышки. Однако это довольно легко сделать при помощи указания сдвижки/инкремента 

вдоль определенной оси. Чтобы отложить отрезок, параллельный оси Х, необходимо набрать 

в командной строке “ix длина сдвижки”. Если длина сдвижки будет положительной, то отрезок 

будет отложен слева направо. Такая же идеология поддерживается при сдвижке по оси Y. 

Примеры: ix 2 iy 3, ix -5 iy -8. Первым должно идти всегда значение сдвижки по оси Х. Команда 

чувствительна к регистру. Перед набором команды убедитесь, что в командной строке 

отсутствуют мусорные символы. 



 

Краткое описание действий с размерами. 

Show dimensions – Сделать размеры видимыми. 

Align dimensions – Выровнять размеры вертикально или горизонтально относительно 

выбранного первым.  

Lock/unlock dimensions – Запретить/разрешить редактирование размеров. 

Z-move dimensions – Перенести размеры на другой класс/подкласс. 

Delete dimensions – Удалить выбранные размеры. 

Instance parameters – Редактировать параметры выбранного размера. Перед 

пользователем будет представлено окно настройки параметров размеров. Однако данные 

параметры будут действительны только для выбранного размера. 

На этом описание вкладки Design Parameter Editor завершается. 

Режимы редактора. Setup - Application mode. 

Поскольку компания Cadence прислушивается к пожеланиям пользователей, а 

пользователи всё время желают чего-либо нового, количество функций САПР Allegro 

постепенно увеличивается. С определенного релиза, для облегчения работы с большим 

количеством функций было принято решение разделить функции на разные режимы работы – 

размещение, трассировка, работа с полигонами, и т.д. Разделение произошло по признаку 

функционального назначения.  

Существует несколько режимов, или так называемых “Application mode”. Выбор режима из 

списка доступных показан на Рис.  1.112. 

 

Рис.  1.112 Список Application mode. 

Режим General edit - позволяет выполнять задачи редактирования, такие как: расстановка 

элементов, разводка проекта, передвижение объектов, копирование или отражение. 

Placement Edit – Посвящён вопросам расстановки компонентов. Так же при 

активированном Placement edit модуле доступно создание репликаций расстановки элементов 

и участков трассировки. Подробнее о процессе расстановки элементов будет рассказано 

позднее. 

Etch edit – В данном модуле выполняются все действия, связанные с созданием и 

редактированием проводящего медного рисунка. В терминологии программы это называется 



 

Copper line или сокращённо Cline. Данный тип объектов присутствует во вкладке Find. 

Действия с проводящими полигонами вынесены в отдельный модуль. 

Flow planning – Данный инструментарий очень полезен для начального планирования 

трассировки в сложных многослойных проектах. 

Signal integrity – Предоставляет доступ к часто используемым при моделировании 

командам. Позволяет частично автоматизировать процесс подготовки проекта к 

моделированию. Позволяет производить различные проверки цепей проекта. Однако стоит 

заметить, что при всех операциях, которые не связаны с запуском программных модулей из 

пакета Sigrity, используется расчётчик предыдущего поколения BEM 2D. Данный движок не 

учитывает неоднородности земли и питания в проекте и может использоваться только для 

предварительных оценок работоспособности, либо для предтопологического моделирования. 

Shape edit – Предоставляет расширенный инструментарий для работы с полигонами. 

Будет рассмотрен позднее. 

Кроме данных режимов, существует ещё несколько. Однако их доступность определяется 

лицензиями, запущенными на рабочем месте. В повседневных действиях, которые совершает 

трассировщик ПП, другие режимы не нужны. Их описание можно найти в соответствующих 

разделах документации.  

 

Рис.  1.113 Необходимый раздел в Help, содержащий описание всех режимов на английском языке. 

Установка параметров сеток. Setup - GRIDS. 

Данный раздел уже рассматривался на этапе описания процесса редактирования символов 

посадочных мест. 

Изменение точки начала координат в проекте. Setup – Change drawing origin. 

При активации данной команды достаточно кликнуть левой клавишей мышки на любом 

месте в проекте, и ноль координат будет перенесён в это место. Можно ввести координаты 

при помощи диалогового окна “Pick”, с помощью небольшой кнопки P в нижней части экрана 

редактора. После активации окна Pick достаточно указать координаты нового места через 

пробел и нажать кнопку Pick (Рис.  1.114). Первая координата по оси Х, вторая по оси Y. 



 

 

Рис.  1.114 Иллюстрация процесса активации Pick command. 

 

 

Добавление пользовательских слоёв. Setup->Subclasses. 

 

Рис.  1.115 Меню добавления пользовательских подклассов/слоёв в проект ПП. 

Если пользователю необходимо хранить графическую информацию на слоях/подклассах, 

отличающихся от создаваемых по умолчанию, то такая возможность существует. Необходимо 

кликнуть на нужном классе объектов, куда планируется внести новый подкласс. И далее 

создать требуемый подкласс, указав его имя латиницей.  



 

 

Рис.  1.116 Новый подкласс REPER_DOTS успешно добавлен. 

Пользовательские подклассы можно переименовывать, добавлять и удалять. Подклассы, 

создаваемые по умолчанию, не подлежат такому виду редактирования и обозначены серым 

цветом. См. Рис.  1.116. 

Создание преднастроенных видов и настройка Gerber. Manufacture – Artwork. 

В процессе работы инженера над проектом ПП возникает задача управления видимостью 

тех или иных объектов на печатной плате. К примеру: пользователю необходимо включить 

слой шелкографии или увидеть всё, что находится на одном из внутренних слоёв. Рассмотрим 

методологию управления видимостью объектов в Allegro PCB. 

Как уже говорилось ранее, вся информация проекта печатной платы распределена на 

классы. Классы разделяются по видам информации, которые они содержат. Внутри класса 

возможно более детальное дробление информации по различающимся признакам. Таким 

образом, каждый пин посадочного места, каждое переходное отверстие, каждый проводник 

принадлежат своему подклассу. Чтобы увидеть определенный тип объектов, достаточно 

сделать видимым нужный подкласс. 

Видимостью подклассов можно управлять из панели Visibility (Рис.  1.117). Но это не всегда 

удобно и быстро. 



 

 

Рис.  1.117 Одно из состояний окна Visibility для случая двусторонней ПП. 

Другой способ управления видимостью групп объектов – это использование уже 

преднастроенных заранее состояний видимости. Пользователь заранее сделал видимым всё, 

что ему необходимо, и запомнил это состояние под определённым названием. Далее 

пользователю необходимо только выбрать нужное состояние в перечне View панели Visibility. 

Управление перечнем View осуществляется в меню Manufacture->Artwork. 

 

Рис.  1.118 Активация диалогового окна управления преднастроенными состояниями видимости. 

После выбора указанного на Рис.  1.118 пункта меню пользователь увидит диалоговое окно, 

изображённое на Рис.  1.119. 



 

 

Рис.  1.119 Диалоговое окно для создания преднастроенных состояний видимости. 

Данное диалоговое окно служит нескольким целям. Одна из целей – получение Gerber-

файлов для производства печатной платы. Данные файлы как раз и получаются в 

соответствии с настроенными состояниями видимости объектов на ПП, поэтому их довольно 

удобно использовать для визуализации «наборов слоев» одной кнопкой. 

Рассмотрим процесс создания нового преднастроенного вида с нуля. Для этого необходимо 

выделить левой кнопкой мышки любой существующий вид в этом диалоговом окне и нажать 

левую кнопку мышки.  

 

Рис.  1.120 Выпадающее меню, появляющееся при нажатии правой кнопки мышки. 

Из выпадающего меню необходимо выбрать строку Add Manual и задать имя нового 

преднастроенного состояния видимости, например, SILK_TOP. После введения имени перед 



 

пользователем откроется список всех классов и подклассов, содержащихся в проекте. 

Необходимо указать видимые в данном случае подклассы. Процесс похож на совершение 

покупок в супермаркете. У пользователя есть пустая тележка с названием SILK_TOP, в 

которую необходимо накидать покупок, то есть групп объектов. 

 

Рис.  1.121 Преднастроенные виды для слоёв TOP BOTTOM и маркировки. 

После того, как пользователь отметит все необходимые для включения подклассы и 

нажмёт на ОК, он увидит картинку, схожую с изображенной на Рис.  1.121. Если пользователь 

забыл добавить какой-либо подкласс объектов в видимые, то необходимо раскрыть 

преднастроенный вид, установить фокус на любом подклассе объектов, нажать правую 

клавишу мышки и выбрать Add. Затем повторить процедуру. 

 

Рис.  1.122 Запуск процесса добавления новых объектов в список видимых. 

После того, как пользователь создал все виды/плёнки, которые ему понадобятся при работе 

над проектом, необходимо нажать на Ok и в строке View окна Visibility выбрать необходимый 

вид для текущей работы. 



 

 

Рис.  1.123 Выбор преднастроенного вида. 

Опишем наиболее важные параметры из раздела Film options на Рис.  1.119 

Undefined line width – В проекте ПП Allegro PCB могут присутствовать линии нулевой 

толщины. Однако в формате Gerber RS274X такая ситуация невозможна. Данный параметр 

отвечает за то, какую толщину приобретут линии нулевой толщины при переводе их в формат 

Gerber. Причём это будет верно только для выбранного в данный момент слоя в левой части 

экрана. 

 

Рис.  1.124 Параметры линий нулевой толщины в правой части экрана, которые указываются для 
каждого вида слева. 

 

Plot mode positive/negative – Позитивные или негативные фотошаблоны будут получены 

при генерации Gerber файлов. 

Suppress unconnected pads – Подавлять или нет неиспользуемые КП на внутренних слоях 

ПП. На самом деле данная опция должна применяться при трассировке ПП, а не на 

заключительном этапе. Подавлять неиспользуемые КП на этапе получения Gerber-файлов 

методически неверно. Одна из целей подавления КП – это получение дополнительного места 

для прокладки проводников. И это одна из важнейших функций. Настраивать подавление КП 

необходимо на этапе создания этих КП в Padstack editor. 

Vector based pad behavior – Круглые отступы в полигонах, которые образуются вокруг 

переходных отверстий и других окружностей, будут упрощены и заменены многоугольниками. 

Это упрощает конечные Gerber файлы. 

  



 

2. Создание посадочных мест компонентов 

для PCB Editor. 
 

Для того, чтобы успешно провести импортирование списка межсоединений из схемы на 

печатную плату, необходимо иметь библиотеку посадочных мест. Это контактные площадки, 

расположенные определенным образом, и дополнительная графика для формирования 

сборочных чертежей, а также слоёв шелкографии. Для того, чтобы создать посадочное место 

компонента, необходимо задействовать два инструмента. 

- OrCAD/Allegro PCB Editor в режиме создания посадочных мест. 

- Редактор контактных площадок Padstack Editor. 

Создание контактных площадок различной формы 

Рассмотрим процесс создания контактных площадок, поскольку без них нельзя будет 

создавать посадочное место. 

 

Рис.  2.1 Расположение Padstack Editor. 

Стоит отметить, что в версии пакета 17.2 этот инструмент был переработан и сильно 

отличается от своего младшего собрата версии 16.6.  

После запуска Padstack Editor пользователь увидит примерно такое же окно, какое 

изображено на Рис.  2.2. 



 

 

Рис.  2.2 Диалоговое окно Padstack Editor. 

Для создания новой контактной площадки пользователю необходимо выбрать в левом 

верхнем углу опцию FILE и далее NEW. После данных действий появится диалоговое окно, 

изображенное на Рис.  2.3. 

 

Рис.  2.3 Диалоговое окно создания файла контактной площадки. 

После появления диалогового окна пользователь должен указать папку в которой будет 

располагаться новая контактная площадка, а так же указать вид данной контактной площадки. 

Рекомендаций по названию контактных площадок дано не будет, поскольку на каждом 

предприятии правила организации и названия библиотеки площадок разные. 

После того, как все необходимые действия будут выполнены, необходимо нажать на “OK”. 

Никаких файлов пока что создано не будет, поскольку ещё практически ничего не задано, но 

программа будет знать в какую папку сохранять файлы и как будет называться новая КП. 

Далее можно необходимо переключиться на вкладку “Design layers”. Вкладку START мы 

больше рассматривать не будем. Можно конечно выбрать форму и вид КП на вкладке START.  



 

 

Рис.  2.4 Порядок действий при создании КП и результат. 

Контактная площадка круглой формы 

На Рис.  2.4 изображен порядок действий при создании круглой КП, расположенной только с 

одной стороны печатной платы. Т.е. так называемой SMD контактной площадки. 

Параметры Thermal pad, antipad, keepout на данном этапе задавать не следует. Это 

пережиток прошлого, которым пользуются некоторые инженеры проектировщики. И 

производителям программного обеспечения приходится поддерживать данный атавизм. 

Все эти параметры могут быть заданы на уровне проекта ПП. И как раз в проекте ПП легче 

управлять параметрами для всех площадок сразу. Существует возможность для изменения 

параметров для каждой площадки в отдельности. Однако такая необходимость возникает 

очень редко. 

Логика Cadence при работе с проектом и константами заключается в том, что инженер 

предстаёт в роли генерала, командующего войсками. Генерал не раздаёт указания каждому 

солдату в отдельности. Он отдаёт приказы целым дивизиям и полкам. Такая же ситуация и 

при проектировании ПП. Неэффективно задавать правила для antipad каждого вида КП. 

Достаточно задать этот параметр на уровне всего проекта ПП. 

После того, как пользователь отредактирует параметры контактной площадки для 

проводящих слоёв, необходимо будет переключиться на вкладку “mask layers” и произвести 

примерно такие же действия, что и на вкладке “Design layers”. 

После заполнения вкладки “Mask layers” остаётся записать на диск только что созданную 

КП, выбрав File->Save/Save as. 

Контактная площадка на обратном слое 

В процессе создания посадочных мест иногда возникает задача создания контактной 

площадки, расположенной на слое Bottom. Тогда при создании SMT площадки следует 

выбрать не “Begin layer”, а “End layer”. Тогда контактная площадка переместится на слой 

Bottom. Переносить контактные площадки со слоя на слой при создании посадочного места 

компонента нельзя. 



 

Площадка для переходного отверстия 

Теперь рассмотрим процесс создания контактной площадки, которая будет использована 

для переходного отверстия. Площадка будет называться Via030_060. Первое число – это 

диаметр отверстия, который равен 0.3мм. Второе – это размер КП для выбранного 

переходного отверстия. Необходимо запустить процесс создания новой КП, выбрав File->New 

. После ввода нового имени, необходимо выбрать вид нового объекта. 

 

Рис.  2.5 Выбор типа новой контактной площадки. 

После того, как процесс создания новой КП начат, заполняется вкладка Drill примерно так, 

как показано на Рис.  2.6.  

Finished diameter – диаметр отверстия в печатной плате после металлизации. 

+/- Tolerance – Допуск на размер отверстия. Для всех отверстий, не предназначенных для 

монтажа разъёмов под запрессовку, следует указывать 0.1мм. Такой допуск указывает 

производителю, что данное отверстие стандартное и к нему не предъявляется каких-либо 

специальных требований. Для отверстий под запрессовку указывается допуск 0.05мм. Эти 

числа стандартные и выбирать какие-либо другие не имеет смысла. Все производители 

печатных плат уже отработали технологический процесс на своём предприятии и в частности 

процесс сверления отверстий. Задачей инженера является правильно передать 

производителю информацию о том, что он хочет получить. Изготовить требуемое – это задача 

производителя. 

 

 



 

 

Рис.  2.6 Заполнение вкладки Drill для переходного отверстия. 

Вкладку Secondary Drill заполнять на этапе создания переходного отверстия не следует. В 

PCB Editor существует инструмент генерации программы обратного высверливания. Он 

запускается в конце работы над проектом, когда порядок следования слоёв и трассировка уже 

однозначно определены. Если задать параметры обратной сверловки на этапе создания 

контактной площадки, то пользователь ограничивает область применения данной контактной 

площадки. 

Вкладка Drill Symbol также не заполняется по схожим причинам: в PCB Editor существует 

механизм генерации символов отверстий в печатной плате. Если определить символическое 

отображение отверстия вначале, то пользователь рискует получить в проекте символы 

одинакового вида и/или размеров, что затруднит восприятие. Лучше доверить данную задачу 

программе на этапе подготовки данных для производства печатной платы. 

Вкладка Drill offset отвечает за смещение отверстия относительно контактной площадки. 

Вкладка Design layers заполняется для трёх слоёв: Begin layer, Default internal, End layer. По 

порядку следования – это вид контактной площадки на верхнем слое печатной платы, во 

внутренних слоях и на нижней стороне. После заполнения рассматриваемой вкладки она 

примет вид, похожий на Рис.  2.7. 



 

 

Рис.  2.7 Заполнение вкладки Design layers. 

Вкладка Mask layers отвечает за вскрытия от паяльной маски. Большинство разработчиков 

печатных плат предпочитает не вскрывать переходные отверстия от паяльной маски, чтобы 

они не создавали лишних мест для непредусмотренных закороток проводящего рисунка. 

Однако если нужно повысить максимально возможный ток через переходное отверстие, 

придётся его вскрыть. Величину вскрытия можно выбрать не равной размеру контактной 

площадки, а сделать размера лишь немногим больше диаметра отверстия, например, в 

данном случае на 0.05мм, см. Рис.  2.8. 



 

 

Рис.  2.8 Заполнение раздела Mask layers для переходного отверстия 0.3Х0.6 мм. 

Пользователи могут обнаружить на вкладке дополнительные поля:  

- Film mask TOP/BOTTOM  

- Coverlay TOP/BOTTOM 

Film mask – слои дополнительных плёнок или масок, не имеющие какого-либо 

определенного назначения. Пользователь может использовать данные слои для своих целей, 

которые могут быть совершенно различными. Чаще всего информация на этих слоях 

используется для обозначения Plugged Vias, а также контактных площадок, отличающихся от 

других финишным покрытием. К примеру, КП, покрытых золотом, никелем и тому подобное. 

Coverlay TOP/BOTTOM – данные слои используются для получения вскрытий в защитном 

покрытии гибкой части печатной платы. Если в вашем проекте нет гибких шлейфов, то данные 

поля заполнять не следует. 

Вкладка Options редактора КП. 

Теперь пришло время поговорить про вкладку Options. На данной вкладке существует две 

настройки управления поведением КП в проекте. 

Suppress unconnected internal pads – данная настройка отвечает за подавление 

неиспользуемых контактных площадок на внутренних слоях печатной платы. Данная опция 

позволяет освободить “ещё немного” места для протаскивания проводников между рядами 

контактных площадок под BGA компонентами либо под многорядными разъёмами. Однако 

следует помнить, что много дополнительного места при использовании данной опции 

пользователь не получит. Дело в том, что существует такой параметр, как отступ трассировки 



 

от отверстия в печатной плате. Минимальное значение этого параметра обычно равно 0.3мм. 

Однако мы знаем, что в большинстве случаев величина гарантийного пояска в переходных 

отверстиях составляет менее 0.3мм.  Т.е. контактная площадка гарантирует пользователю 

выполнение условия достаточности отступа проводника от дырки.  

 

Рис.  2.9 Иллюстрация реального выигрыша от подавления КП на внутреннем слое. 

Lock layer span – данный параметр предотвращает “растягивание” погребённого либо 

глухого переходного отверстия при изменении количества слоёв в стекапе печатной платы.  

Приведём пример: переходное отверстие начинается на 4-ом слое печатной платы и 

заканчивается на 5-ом. Если пользователь введёт слой 4А, расположенный между 4 и 5-ым 

слоями, то при включенном параметре Lock layer span переходное отверстие будет 

оканчиваться на слое 4А. При отключенном параметре отверстие окончится по-прежнему на 5-

ом слое.  

После того, как все необходимые вкладки были рассмотрены, можно сохранить нашу новую 

контактную площадку на жесткий диск. 

Контактные площадки сквозных отверстий типа THROUGH HOLE. 

Площадки компонентов, в которые монтируются штыревые элементы, ножки разъёмов и 

т.п. элементы, очень похожи по своему составу и внешнему виду на переходные отверстия. 

Процесс их создания в точности такой же, как для переходных отверстий, за исключением 

размера вскрытий в слоях паяльной маски. 

Контактные площадки неправильной формы. 

В посадочных местах теплосъёмные КП обычно имеют сложную форму. Рассмотрим этот 

процесс подробно.  



 

Необходимо сказать, что такие контактные площадки состоят из нескольких собранных 

вместе полигонов, расположенных на различных слоях ПП. Целью пользователя при создании 

посадочного места является отрисовка нескольких полигонов и назначение их на различные 

слои при редактировании новой контактной площадки. 

Отрисовка полигона для контактной площадки сложной формы.  

Для этого необходимо запустить Allegro/OrCAD PCB Designer с любой доступной лицензией. 

Затем выбрать “File->New” и создать новый Shape symbol. На Рис.  2.10 изображен вид 

диалогового окна для создания Shape symbol. 

 

Рис.  2.10 Диалоговое окно создания файла shape symbol. 

При создании нового файла «с нуля» PCB Editor создаст пустой файл в дюймовой системе 

координат. Если пользователь собирается работать в метрической системе, то необходимо 

будет поменять единицы измерения во вкладке “Setup->Design parameters->Design”. Затем 

выставить удобный шаг координатной сетки “Setup->Grids”. Во вкладке настроек “Setup-

>Design parameters->Display” лучше выставить галочки так, как показано на Рис.  2.11 для 

улучшенного отображения переходных отверстий и гарантированной отрисовки начала 

координат. 

 

Рис.  2.11 Пункты меню, которые желательно включить для улучшенного отображения дырок на 
ПП и отрисовки символа начала координат. 



 

Как уже говорилось ранее, лучше всего иметь файл - заготовку для рисования Shape symbol 

со всеми необходимыми настройками, и перед началом работы над новым символом надо 

пересохранить заготовку под новым именем. 

Далее надо нарисовать площадку требуемой формы на слое TOP. На слое BOTTOM 

рисовать ничего не нужно. Следует помнить, что создаваемый объект – это только форма КП, 

которая в последующем будет расположена на том слое, где это необходимо. 

 

Рис.  2.12 Заготовка для КП произвольной формы. 

После этого необходимо сохранить полученную форму под именем, например, 

“Heatsink_TOP”. Приставка “TOP” означает верхний слой металла и необходима пользователю 

только для того, чтобы не запутаться в создаваемых файлах. После этого необходимо 

пересохранить файл под новым именем “Heatsink_TMS”, где приставка TMS означает верхний 

слой маски.  После этого нужно переключиться в режим Shape Edit. После переключения 

выбрать шейп контактной площадки левой клавишей мышки. Затем нажать на правую 

клавишу и из выпадающего меню выбрать Expand/Contract. После выбора этой команды 

вкладка Options изменит свой вид. Необходимо будет указать числовое значение 

увеличения/уменьшения и нажать на + в случае, если полигон требуется увеличить. 

Если КП очень сложной формы, то можно импортировать графическую информацию о 

форме контактной площадки из файла, например,  формата DXF, “File->Import DXF”. 



 

 

Рис.  2.13 Работа команды Expand/Contract при активированном режиме Shape Edit. 

После описанных действий у пользователя будет изображение, подготовленное для 

площадки на слое TOP/BOTTOM и для вскрытия маски на слоях TOP/BOTTOM_MASK.  

Остаётся нарисовать вскрытия для нанесения паяльной пасты (они требуются при 

поверхностном монтаже с помощью трафаретов). Для больших площадок эти вскрытия 

обычно разбиваются на несколько сегментов, чтобы общая площадь наносимой паяльной 

пасты занимала не более 50% площади площадки. Это можно сделать двумя способами: 

- Изобразив вскрытия при помощи полигонов на этапе создания посадочного места. 

- Изобразив вскрытия при помощи Flash Symbol. 

Процесс создания Flash Symbol очень прост. Это создание нескольких независимых друг от 

друга многоугольников произвольной формы для последующего их использования на слоях 

защитной паяльной маски и паяльной пасты. Т.е. это то, как будет выглядеть вскрытие 

контактной площадки на непроводящих слоях. Отметим, что, если пользователь попытается 

изобразить несколько многоугольников при создании Shape symbol (для проводящих слоев), 

он получит сообщение об ошибке при сохранении файла на жёсткий диск. Металлическая 

площадка не может состоять из нескольких отдельных элементов. 



 

 

Рис.  2.14 Пример Flash Symbol. 

На данном этапе мы не будем пользоваться Flash Symbol, и нарисуем вскрытие трафарета 

для паяльной пасты позже, на этапе создания посадочного места.  

Причины: 

- Поскольку конфигурация расположения теплосъёмных переходных отверстий под 

компонентом ещё не определена, то нет информации о том, где необходимо 

располагать вскрытия для паяльной пасты. Дело в том, что вскрытия нежелательно 

располагать над отверстиями. Иначе весь припой в процессе пайки стечёт вниз через 

отверстия. 

- Размер вскрытий для паяльной пасты, их количество и конфигурация расположения на 

КП обычно определяются экспериментально на пробных партиях изделий. 

Производители микросхем, как правило, дают только рекомендации для создания 

посадочных мест. Окончательно посадочное место разрабатывается под конкретное 

сборочное производство. Каждый сборочный цех уникален. Где-то используют 

трафареты из стали для больших партий. На других предприятиях пользуются медными 

трафаретами для небольших партий изделий. Их толщины также могут различаться. 

Паяльная паста может иметь различную консистенцию и марку. Именно по этим 

причинам инженер и технолог должны уважительно относиться к своим коллегам и 

работать в тесном взаимодействии. Высококлассный специалист не может делать свой 

участок работы в отрыве от всего остального коллектива. Это приводит к плачевным 

результатам. 

Итак, пришла пора закрыть редактор печатных плат, запущенный в режиме создания 

сложных форм для КП, и перейти к созданию самой КП. 



 

Размещение площадки сложной формы на падстеке 

Необходимо запустить Padstack Editor. Затем выбрать тип КП – SMD, и добраться до 

вкладки Design Layers. Именно здесь будет определено местоположение создаваемой КП. В 

случае, если необходимо, чтобы КП располагалась изначально на слое BOTTOM, необходимо 

выбрать END LAYER, как показано на Рис.  2.15. 

 

Рис.  2.15 Создание КП сложной формы. END LAYER – для расположения КП на ВОТТОМ. 

Поиск среди доступных для выбора форм при нажатии на кнопку с многоточием будет 

осуществляться в той же папке, в которой расположен сам файл создаваемой КП. 

После того, как будет выбрана необходимая форма и определена сторона расположения 

КП, нужно переключиться во вкладку Mask Layers и проделать практически те же самые 

действия (Рис.  2.16). 

После этого необходимо сохранить вновь созданную КП. 



 

 

Рис.  2.16 Редактирование КП на слое маски. 

 

Рис.  2.17 Результат действий. 

 

Создание конденсатора. Команды редактирования графики. 

Для создания посадочных мест компонентов можно использовать несколько инструментов: 



 

- Создавать посадочные места вручную. 

- Создавать их автоматизированно при помощи OrCAD Library Builder. 

- Воспользоваться мастером PCB Editor (Wizard) для полуавтоматического создания 

 

Рис.  2.18 Пример диалогового окна OrCAD Library Buider. 

Использование OrCAD Library Builder ускоряет процесс создания посадочных мест и 

обеспечивает соответствие стандарту IPC-2221 для качественной пайки выводов, так как 

используются готовые шаблоны посадочных мест и соответствующих им 3D-моделей 

корпусов компонентов Однако работа в этой программе описываться на данном этапе не 

будет. 

 

Рис.  2.19 Пример конденсатора с сайта murata.com 

Рассмотрим процесс ручного создания посадочного места для типоразмера конденсатора 

0402 фирмы Murata. Сперва необходимо выяснить размеры корпуса компонента из 

документов, которые предоставляет производитель. 

 

Таблица размеров конденсатора 

L size  1.0 ±0.05mm    

W size  0.5 ±0.05mm    



 

T size  0.5 ±0.05mm    

External terminal width e  
0.15 to 

0.35mm    

Distance between external 

terminals g  
0.3mm min.    

Size code in inch(mm)  
0402 

(1005M)    

Исходя из приведённых данных рассчитываются параметры контактных площадок и 

расстояние между ними. Расчёты производятся в соответствии со стандартом IPC-7351. 

Однако читать стандарт и разбираться в правилах расчёта размеров КП может быть довольно 

затратно по времени. Большинство производителей предоставляют уже готовые 

рекомендованные размеры посадочных мест для своих элементов. 

 

Рис.  2.20 Пример размеров посадочного места, рекомендуемого производителем. 

a (mm) b (mm) c (mm) 

0.3 to 0.5 0.35 to 0.45 0.4 to 0.6 

Размеры даны для допусков корпуса + 0.1мм. 

Итак, нам понадобится контактная площадка размером 0.45х0.6 мм. Размеры взяты по 

максимальному значению. Какое значение брать – необходимо решать в частном порядке для 

каждого конкретного случая. Если проектируемая печатная плата довольно сложная, при её 

сборке будет применяться автоматический монтаж элементов, и паяться элементы будут тоже 

автоматически, то целесообразно уменьшить размеры посадочных мест.  

Пропустим описание этапа рисования необходимой контактной площадки, поскольку задача 

такого типа уже описывалась. В качестве тренировки предлагаем читателю самостоятельно 

выполнить эту задачу. Затем мы запускаем OrCAD/Allegro PCB Editor с любой доступной 

лицензией. После выбора пунктов “File->New” конфигурируем диалоговое окно для создания 

Package symbol, так, как показано на Рис.  2.21. 



 

 

Рис.  2.21 Конфигурация диалогового окна для создания символа посадочного места. 

После нажатия на ОK будет создан новый файл посадочного места, и перед пользователем 

появится пустое рабочее поле с изображением центра координат. Необходимо изменить шаг 

сетки на 0.1мм и сделать сетку видимой. Теперь необходимо разместить контактные 

площадки на рабочем поле в строго определённых координатах. Подразумевается, что пути к 

папкам-библиотекам, по которым PCB Editor будет осуществлять поиск контактных площадок, 

уже правильно заполнены в настройках редактора (см. раздел «Пути к папкам библиотек 

компонентов и площадок»). 

Для установки КП необходимо активировать команду “Add pin”.  

 Графическая иконка, активирующая команду добавления пинов. 

В некоторых релизах PCB Editor данная иконка по-умолчанию скрыта. Если пользователь 

желает, то он может её добавить в любую линейку инструментов при помощи меню “View-

>Customize toolbar”. 

Для установки КП также можно просто набрать в командной строке “add pin”. 

После запуска команды диалоговое окно Options изменит свой вид. Он будет похож на 

изображённый на Рис.  2.22. 

Описание полей: 

Padstack – имя контактной площадки, которая будет устанавливаться на рабочем поле. 

Необходимо нажать на троеточие и выбрать требуемое. Возможен поиск по названию 

контактной площадки. 

Copy mode – Если пользователь хочет разместить массив контактных площадок, то 

необходимо задать способ копирования. Возможно копирование при использовании полярных 

координат. 

Qty – Число объектов по оси X и Y. 

Spacing – Расстояние между объектами. 

Order – Направление копирования последующих объектов относительно предыдущего. 

Rotation – Угол поворота устанавливаемой контактной площадки. 

Pin# - Номер первой устанавливаемой контактной площадки. Может состоять как из одних 

цифр, так и иметь цифро-буквенное обозначение. 

Inc – Шаг увеличения номера контактной площадки. 



 

Text block – Номер набора параметров текста, которым будет писаться Pin Number. 

Text Name – Имя выбранного набора параметров текста. 

Offset X/Y – Смещение номера контактной площадки относительно центра. 

 

Рис.  2.22 Вкладка Options при активной команде Add pin. 

После того, как необходимая контактная площадка будет выбрана, необходимо перенести 

курсор мышки в область рабочего поля, и требуемая площадка нарисуется под курсором. См. 

Рис.  2.23. 

 

Рис.  2.23 Контактная площадка прикреплённая к курсору мыши и готовая для расположения. 

Разместить контактную площадку в нужных координатах можно несколькими способами: 

- По команде Pick. 

- Отсчитать от центра координат необходимое количество шагов сетки. 

- Расположить площадку в центре координат и затем сместить её на определённый шаг 

при помощи ix/iy команд. 

Как отсчитывать необходимое количество шагов сетки, описываться не будет. 

Для задания необходимых координат нужно нажать на небольшую квадратную кнопку с 

надписью P, расположенную в нижней части экрана, см. Рис.  2.24. 



 

Команда Pick. Ввод координат. 

 

Рис.  2.24 Кнопка активации команды Pick. 

После этого необходимо ввести нужные координаты через пробел. 

 

Рис.  2.25 Диалоговое окно команды Pick. 

После нажатия на Pick контактная площадка расположится по заданным координатам, ей 

будет присвоен начальный номер, и под курсором мышки появится следующая площадка, 

готовая к установке. Таким образом можно располагать все элементы, вводя их абсолютные 

или относительные координаты. Чтобы завершить команду добавления КП, необходимо 

нажать на правую клавишу мышки и выбрать пункт Done в выпадающем меню. После этого 

пользователь получит картину, похожую на Рис.  2.26. 

 

Рис.  2.26 Две контактные площадки. 

Необходимо дать пояснения к рисунку. Прямоугольники тёмно-зелёного цвета показывают 

вскрытие паяльной маски используемых КП. Прямоугольники светло-зелёного цвета 

олицетворяют медь на слое TOP. Так же видны номера пинов. Если пользователю 

необходимо изменить цвет отображаемых элементов, то он может сделать это при помощи 

инструмента Color192, выбирая следующие классы: 

Stackup->Conductor->Pin->Top – Цвет пинов на слое TOP. 



 

 

Рис.  2.27 Раздел, содержащий поле управляющее цветом пинов на TOP. 

Stackup->Non Conductor->Pin->Soldermask_Top – Цвет вскрытий маски пинов на слое TOP. 

 

Рис.  2.28 Раздел, содержащий поле управляющее цветом маски пинов на TOP. 

Цвет указанных элементов можно изменять, используя диалоговое окно Visibility. 

Достаточно кликнуть правой клавишей мыши на цветной квадрат и выбрать интересующий 

пользователя цвет. 

 

Рис.  2.29 Альтернативный способ изменения цвета отображаемых элементов. 

После расположения контактных площадок необходимо изобразить корпус элемента для 

того, чтобы в последующем можно было сгенерировать заготовку для сборочного чертежа. 

Схематическое изображение (чертеж) корпусов компонентов обычно располагается в 

подклассах Package geometry ->Assembly top и Board geometry->Assembly top. В классе 

Package geometry помещается вся информация, которая принадлежит к посадочному месту 

компонента. Board geometry содержит данные, которые добавлялись на этапе работы над 

проектом платы. И эти данные не принадлежат конкретному посадочному месту, а 

принадлежат всему проекту в целом. 



 

Корпус конденсатора будем изображать схематично при помощи незакрашенного 

прямоугольника заданных размеров. Создать прямоугольник можно как минимум тремя 

способами: 

- При помощи команды Add->Rectangle (рисует пустой прямоугольник) 

- При помощи команды Add->Line (рисует линию) 

- Импортировать графическую информацию из чертежа AutoCAD или Compass при 

помощи формата DXF. 

Команда Add-Rectangle. Добавление прямоугольника. 

При активации команды Add->Rectangle окошко Options примет вид, указанный на рисунке 

Рис.  2.30. 

 

Рис.  2.30 Вид диалогового окна Options при активной команде Add->Rectangle. 

Active Class and Subclass – Имена класса и подкласса на котором будет изображен 

прямоугольник. Следует выбрать Package Geometry и Assembly top.  

Line font – Тип линии, которой будет изображаться граница прямоугольника. 

Rectangle Creation – Способ рисования прямоугольника. Можно нарисовать 

прямоугольник, указав вершины по диагонали. Можно просто расположить прямоугольник 

указанных размеров (Place Rectangle). 

Проще всего будет сначала нарисовать прямоугольник в произвольно выбранном месте, 

выбрав любую точку на рабочем поле и указав затем смещение диагональной вершины через 

команды ix/iy: 

- Активируем команду Add->Rectangle 

- Выбираем класс и подкласс, на котором будет расположен прямоугольник. 

- Кликаем левой кнопкой мыши на любом месте рабочего поля. 

- В командной строке вводим “ix 1 iy 0.5” . 

Если пользователь пожелает рисовать прямоугольник из линий, то необходимо будет 

ввести толщину создаваемой линии. За это отвечает параметр Line width во вкладке Options 

при активной команде “Add->Line”. 

Так или иначе прямоугольник заданных размеров получен. Теперь необходимо передвинуть 

его так, чтобы центр фигуры совпал с началом координат. Это выполняется при помощи 



 

команды move. При активации этой команды вкладка Options примет вид, показанный на Рис.  

2.31. 

Команда Edit-Move. Перемещение объектов. 

 

Рис.  2.31 Вид диалогового окна Options при активной команде Edit->Move. 

Ripup etch/Slide etch/Stretch etch – Поведение трассировки при передвижке элемента. 

Если к передвигаемому элементу прикреплена трассировка, то она может растягиваться, 

сдвигаться или удаляться. 

Rotation Type/Angle – В данном случае не используется. Если пользователь при активной 

команде Move нажмёт на правую клавишу мышки и выберет строчку Rotate, то поворот будет 

осуществляться по выбранной схеме. 

Point Body Center – Точка, за которую будет осуществлена привязка при передвижении 

элемента. Может принимать различные значения в зависимости от нужд пользователя. 

Так же необходимо проверить, что во вкладке Find галочками отмечены именно те 

элементы, которые пользователь собирается подвинуть. Если это четыре отрезка линий, то 

следует отметить Other segs. Если предполагется перемещение прямоугольника, 

выполненного полигоном, то следует отметить Shape. Неправильный выбор объектов поиска 

во вкладке Find – наиболее распространённая ошибка начинающих пользователей. Особенно 

внимательно надо относиться к этой вкладке при смене команд, т.к. она запоминает выбор 

типов объектов отдельно для каждой команды, и восстанавливает этот выбор при повторном 

использовании той команды. При работе с любой командой в Cadence Allegro/OrCAD PCB 

Editor необходимо руководствоваться следующим девизом: “Выбрал, настроил, применил.”.  

После того, как чертеж контура компонента расположен в заданных координатах и 

находится на слое “Package geometry->Assembly top”, настала пора изобразить то, как будет 

выглядеть элемент в слое маркировки печатной платы. Маркировка выполняется из набора 

линий, а не полигоном, поскольку линии могут иметь толщину, а границы объекта Shape – нет. 

Линия рисуется при помощи команды “Add->Line”. После выбора нужной команды необходимо 

её настроить во вкладке Options. 



 

Команда Add-Line. Добавление линий. 

 

Рис.  2.32 Настройки команды Add->Line. 

Line lock – Имеет два параметра настройки.  

- Line/Arc – рисуются линии либо дуги. 

- Off/45/90 – Добавляемые объекты могут изменять угол на заданный параметр.  

Line width – Толщина добавляемых линий/дуг. 

Line font – Тип линий. 

После настройки команды осталось нарисовать замкнутый контур. Контур легче всего 

рисовать по узлам сетки в образовательных целях. При создании более сложных посадочных 

мест обычно либо пользуются программами, автоматизирующими процесс создания, либо 

рисуют графическую информацию на слое маркировки максимально упрощённо. Если 

необходимо разместить на слое маркировки сложный графический объект, то эта задача 

решается импортом файла графики через DXF формат. Разработчик должен следить, чтобы 

линии маркировки не шли поверх площадок компонента, т.к. это может ухудшить качество 

пайки. 

 

Рис.  2.33 Вид компонента после добавления контура на слое шелкографии. 



 

Далее добавим текстовый объект, который будет представлять собой RefDes компонента – 

позиционное обозначение. Изначально в это поле можно внести любое значение. 

Учитываются только координаты и ориентация первого символа, куда и произойдет 

копирование конкретного RefDes при размещении посадочного места на ПП. Нам достаточно 

написать “*” в соответствующих подклассах класса Refdes.  

- Refdes->Assembly_TOP 

- Refdes->Silkscreen_TOP 

Текст добавляется командой “Add->Text”.  

Команда Add-Text. Добавление текста. 

После выбора команды настройка панели Options заключается в указании классов и 

подклассов, где необходимо разместить новый текст. Далее на любом свободном месте по 

правому клику мышки возникает курсор, и пользователь вводит текст. После ввода текста на 

одном подклассе следует кликнуть правой кнопкой мышки и выбрать команду Next. Это 

завершит текущее действие, но не отменит команды целиком. Затем надо переключиться на 

следующий нужный подкласс и опять ввести звёздочку. 

Создание областей DFA_Bound_Top и Place_Bound_Top 

После этого необходимо нарисовать служебные области, которые будут необходимы для 

правильной расстановки компонентов друг относительно друга и мониторинга высот 

компонентов, для исключения пересечений с корпусом прибора или другими компонентами. 

Эти области являются полигонами, которые расположены на подклассах служебного класса 

Package geometry: 

- Package geometry->DFA_Bound_Top 

- Package geometry->Place_Bound_Top 

DFA_Bound_Top – на данном подклассе расположены Shape, которые олицетворяют 

место, занимаемое компонентом на печатной плате. Именно между границами этих объектов 

и происходит измерение зазора. Если зазор недостаточен, то программа формирует ошибку 

при проведении DRC (Design Rules Check). 

Place_Bound_Top – на данном подклассе расположены многоугольники, которые 

олицетворяют собой реальные очертания корпусов компонентов. Данным многоугольникам 

может быть назначено свойство «высота», и они могут быть экспортированы в формат STEP 

для получения примитивной 3-хмерной модели ПП. 

В каждом вновь создаваемом посадочном месте следует рисовать данные области. 

Начнём с области на подклассе DFA_Bound_TOP. Следует обрисовать посадочное место 

по контурам контактных площадок, поскольку они занимают место на печатной плате. 

Затем обрисовывается корпус компонента на подклассе Place_bound_TOP. Поскольку это 

будет примитивной моделью, то ее контуры могут совпадать с изображением корпуса на 

подклассе Assembly_TOP.  Для более сложных корпусов можно задавать несколько областей 

Place_bound_TOP с разными значениями высоты (см. далее). 

После отрисовки обеих областей создаваемое посадочное место примет вид, показанный 

на Рис.  2.34. 



 

 

Рис.  2.34 Вид компонента после добавления необходимых областей. 

Необходимо задать минимальную и максимальную высоту создаваемого компонента. Для 

этого необходимо выбрать команду “Setup->Areas->Package height” и кликнуть на середину 

компонента. Будет захвачен объект, расположенный на подклассе Place_bound_Top. Осталось 

ввести значения максимальной и минимальной высоты. 

 



 

 

Рис.  2.35 Расположение пункта меню Setup->Areas->Package Height. 

 

Рис.  2.36 Задание высоты создаваемого элемента. 

На Рис.  2.36 показан пример задания высоты компонента в окне Options. Задание 

минимальной высоты позволяет располагать под его корпусом другие компоненты. 

Создание переходных теплосъёмных отверстий. 

 



 

При создании посадочных мест для силовых компонентов часто бывает необходимо 

разместить в самой большой контактной площадке несколько переходных отверстий для 

стекания тепла во внутренние слои печатной платы или на обратную сторону. 

Необходимо помнить следующее: 

- Отверстия малого диаметра плохо проводят тепло. Они похожи на длинную железную 

спицу. Такую спицу легко можно держать в руках за один конец, а другой конец засунуть 

в огонь. Соответственно, теплосъёмные отверстия должны быть как можно большего 

диаметра, 0.3…0.5 мм. 

- Стеклотекстолит сам по себе плохо проводит тепло. Необходимо делать на внутренних 

слоях ПП теплосъёмные полигоны и подключать их именно к той цепи, к которой 

подключены отверстия. 

- Отверстия всегда следует делать на уровне посадочного места, а не на уровне 

контактной площадки. 

Почему не следует массив теплосъёмных отверстий на уровне контактных площадок? 

Потому, что в этом случае ни удалить, ни передвинуть их пользователь не сможет. А с 

отверстиями, созданными на уровне символа элемента, можно сделать всё, что угодно. 

Добавление доступных переходных отверстий к классу цепей «по 
умолчанию». 

Для добавления переходных отверстий на уровне посадочного места необходимо 

проделать следующее. 

У пользователя уже должны быть созданы контактные площадки для переходных 

отверстий. Далее необходимо запустить Constraint manager и открыть раздел “Physical-

>Physical constraint set->All layers”. В данном разделе есть столбец VIAS, на котором 

необходимо нажать левой клавишей мышки. 

 

Рис.  2.37 Порядок добавления нового типа переходного отверстия для трассировки. 

На Рис.  2.37 изображен порядок действий для добавления переходного отверстия, которое 

будет применяться для трассировки в последующем. Стоит сказать, что можно добавлять 

множество типов переходных отверстий, выбирая необходимые типы via из списка доступных. 



 

При начале трассировки автоматически будет использоваться самое верхнее переходное 

отверстие из списка. На все остальные пользователю придётся переключаться вручную уже в 

процессе трассировки. 

После того, как необходимое отверстие добавлено, “Constraint manager” можно закрыть.  

Установка переходных отверстий. 

Теперь для добавления переходного отверстия необходимо выбрать команду “Layout-

>Connections”. Далее надо убедиться, что во вкладке Find отмечена галочка напротив пункта 

Pins. Затем пользователю остаётся навести курсор мыши на любой пин и нажать на левую 

клавишу. Из центра пина будет начата трассировка проводящей медной линии, которая нам 

сейчас не нужна. Для получения переходного отверстия остаётся произвести двойной клик 

левой клавишей мышки. Желательно сделать это на центре или недалеко от центра 

выбранной контактной площадки, чтобы не осталось проводящих линий после появления 

переходного отверстия. 

Команда Edit-Copy. Копирование объектов. 

Затем остаётся скопировать полученное отверстие столько раз, сколько это необходимо. 

Данное действие выполняется командой “Edit->Copy”. Обязательно необходимо правильно 

настроить данную команду во вкладке Options перед копированием. 

 

Рис.  2.38 Посадочное место компонента с добавленными теплосъёмными переходными 
отверстиями. 

Отверстия вовнутрь контактной площадки необходимо вдвигать либо командой “Edit->Move” 

, либо “Layout->Slide”. Обязательно нужно проконтролировать, чтобы во вкладке Find напротив 

поля vias была поставлена отметка. Если применяется команда “Layout->Slide”, то вкладка 



 

Options должна иметь поле Bubble в состоянии Off. Это означает, что проверки на DRC не 

проводятся, и пользователь свободно сможет вдвинуть отверстие в контактную площадку. 

В процессе работы на трассировкой печатной платы эти отверстия пользователь сможет 

спокойно удалять и передвигать. В тоже время отверстия будут являться частью посадочного 

места и будут перемещаться за посадочным местом по всей печатной плате. 

Зависимость качества пайки от посадочного места 

Часто при пайке элементов на площадки больших размеров происходит поворот 

компонентов или смещение компонентов относительно центра контактных площадок. Элемент 

как бы “плывёт” на подушке из расплавленного припоя во время пайки. Это происходит из-за 

того, что на контактной площадке содержится слишком много припоя. Необходимо уменьшить 

его количество, разработав такой трафарет для нанесения паяльной пасты, в котором будет 

открыта только часть основной теплосъёмной контактной площадки. Обычно открывают от 40 

до 65% всей площади площадки. Конфигурация вскрытий подбирается индивидуально под 

каждый тех. процесс сборки. Неплохим решением будут вскрытия вытянутой прямоугольной 

формы “щели”. Однако не допускается расположение щелей поперёк направления движения 

ракеля – ножа, которым наносится паяльная паста. Иначе ракель будет растягивать тонкие 

участки трафарета и впоследствии разрывать их. 

 

Рис.  2.39 Одна из возможных конфигураций вскрытий на трафарете для нанесения паяльной пасты. 

Создание механических посадочных символов. 

В заключении раздела о создании посадочных мест необходимо немного рассказать о 

создании механических символов на печатной плате. В большинстве случаев механическими 

символами являются крепежные отверстия или логотипы компаний. Отличие механического 

символа от обычного в том, что номера пинов в символе отсутствуют и его нельзя подключить 

к электрической цепи. Т.е. этот символ будет электрически изолирован от всех объектов на 

ПП. 

Процесс создания механического символа начинается в редакторе ПП с команды File->New. 

Далее в типе вновь создаваемого объекта следует выбрать Mechanical Symbol. Следует 

ввести имя символа и далее действовать как будто создается обычное посадочное место. В 

разрабатываемом посадочном месте могут содержаться различные зоны, непроводящая ток 

графика, КП без номеров. После окончания редактирования символа его следует сохранить в 

папке библиотеки посадочных мест. 



 

Чтобы разместить механический символ на печатной плате, следует войти в режим ручной 

расстановки компонентов Place->Manually. Затем переключиться на вкладку Advanced Settings 

и установить галочку напротив Display definitions from Library. Если переключиться после этого 

обратно в закладку Placement List и в самой верхней строчке выбрать опцию Mechanical 

Symbols, то пользователь увидит список всех механических символов из доступных 

библиотек. Далее следует галочками отметить необходимые для установки символы и 

расставить их, как обычные посадочные места. При установке большого количества 

крепежных отверстий придется неоднократно выбирать символ отверстия и устанавливать на 

плату очередную его копию. Т.е. выставить несколько одинаковых механических символов за 

один раз нельзя. 

На этом можно считать разговор о создании посадочных мест компонентов оконченным. 

 

  



 

3. Переход от схемы к печатной плате 
Перед тем, как приступить к импорту информации о межсоединениях компонентов из 

схемного редактора, необходимо создать контур печатной платы и определить различные 

зоны в пределах этого контура. Самые базовые зоны, которые желательно иметь в каждом 

проекте – это зона расположения компонентов Component Keepin и зона трассировки Route 

Keepin.  

Импорт контура печатной платы из механических САПР. 

Создавать контур печатной платы можно как вручную, так и при помощи сторонних САПР, 

которые предназначены для разработки механики или создания чертежей. В сторонних 

механических САПР можно нарисовать контур сложной формы, а затем импортировать этот 

контур через файлы формата DXF в Allegro PCB Editor. 

Процедура импорта контура ПП из формата DXF начинается с активации команды File-

>Import->DXF После этого возникает диалоговое окно, показанное на Рис.  3.1. 

 

Рис.  3.1 Окно импорта информации из DXF формата. 

Надо указать файл, который необходимо импортировать. Путь к файлу указывается в 

строке напротив надписи DXF file. Далее указываются единицы измерения, в которых 

выполнен чертёж. Если не поставить галочку напротив Incremental addition, то вся 

информация из проекта будет утеряна, и после импорта сохранится информация только из 

DXF файла. Если галочку поставить, то информация из DXF файла добавится к уже 

существующим данным проекта.  

После указания пути к файлу контура платы необходимо назначить соответствие слоёв из 

DXF файла классам и подклассам из Allegro PCB editor. Это делается в диалоговом окне, 

показанном на Рис.  3.2. Активируется данное окно при нажатии на кнопку “Edit/View layers” в 

нижней части окна “DXF in”. 



 

 

Рис.  3.2 Окно для указания соответствия слоёв из различных САПР. 

 

Рис.  3.3 Порядок действий для назначения соответствия. 



 

 

Рис.  3.4 Конечный вид окна соответствия слоёв. Осталось нажать на Ок. 

После совершения всех действий, указанных на Рис.  3.4, необходимо нажать на ОК, а 

затем на “Import”. Новые данные будут импортированы в проект. 

Стоит отметить, что в импортируемых данных не должно содержаться информации на 

русском языке, поскольку Allegro PCB Editor не воспринимает русские буквы, и процесс 

импорта будет прерван. Также Allegro не воспринимает дополнительную информацию в DXF-

файле, например, «виды», которые добавляет САПР Компас, и др. Если импорт DXF-файла 

не проходит, можно открыть его в текстовом редакторе и удалить ненужные секции файла. 

После завершения импорта информации пользователь увидит на экране контур печатной 

платы в том классе и подклассе, который был выбран при настройке соответствия. 

Создание контура. 

После импорта информации из DXF создаются объекты типа “непроводящая линия” в 

классификации объектов PCB редактора такой тип объектов называется “Line segments”. 

Пример такого рисунка, импортированного из DXF, показан на Рис.  3.5. 

Однако в редакторе печатных плат область – это объект типа “незаполненный полигон” или 

“unfilled shape”. Таким образом необходимо преобразовать разрозненные участки линий в 

единый контур. Это делается при помощи команды Shape->Compose shape.  

 



 

 

Рис.  3.5 Простейший контур ПП, полученный из DXF файла. 

Команда Shape-Compose Shape. Создание полигона. 

После активации данной команды необходимо переместить указатель мыши в правую часть 

экрана и во вкладке Find снять все галочки, за исключением одной, находящейся напротив 

объектов “Lines”. Во вкладке Options необходимо указать, на каком классе и подклассе в 

проекте будет создан полигон. Далее необходимо последовательно отметить левой кнопкой 

мыши все линии, составляющие четыре стороны контура, если контур имеет прямоугольную 

форму. Если контур очень сложный, то кликать по каждому сегменту линии долго и не 

исключает ошибки. В этом случае необходимо установить курсор мыши в левый верхний угол 

рабочей области, затем зажать левую клавишу мышки и потащить курсор в правый нижний 

угол так, чтобы контур ПП оказался внутри появляющейся прямоугольной области. Если весь 

контур поместился в область, достаточно отпустить клавишу мышки, и на указанном классе и 

подклассе создастся незаполненный полигон нужной формы, обозначающий контур платы. 



 

 

Рис.  3.6 Состояние вкладок Find и Options при настройке команды Shape->Compose shape. 

После выполнения данной операции в окне Command появятся надписи следующего 

содержания: 

Select the lines / line segments to be composed into shape(s). 

Enter selection point 

Processing the selected segments. For a large number of segments, this may take a few 

minutes. 

Use the "Close Shape" option from the RMB popup to close any shape(s) left open. 

A total of 1 shapes were created. 

Это означает, что новый контур был успешно создан. 

После создания контура платы в виде полигона становится возможным применить к нему 

команду копирования полигонов, что нам требуется для создания зон отступов от края платы 

при размещении и при трассировке. 



 

Команда Edit->Z-Copy. Копирование полигонов с увеличением размера. 

После активации этой команды необходимо указать класс и подкласс, где будет создан 

новый полигон. А также указать, будет ли новый полигон больше или меньше относительно 

исходного контура. Если создавать новый полигон на проводящих слоях, то он автоматически 

станет заполненным, поскольку незаполненные полигоны на проводящих слоях не 

допускаются. 

 

Рис.  3.7 Вид окна options для настройки команды Z-copy.  

На Рис.  3.7 пользователь указал, что новый полигон будет создан на классе “Route Keepin”, 

то есть зона, где разрешена трассировка, и подклассе “ALL”, то есть для всех проводящих 

слоев общая зона. Он будет меньше исходного полигона по каждой стороне на 0.6 мм (см. 

параметр Size-Contract). 

Остаётся только кликнуть мышкой на исходном полигоне - контуре ПП, чтобы выделить его 

и получить второй полигон меньших размеров в новом подклассе. 

Данная команда очень удобна при копировании информации с класса на класс. Перенос 

каких-либо объектов простой командой Copy между классами запрещён. Например, 

пользователь может перенести проводник с одного проводящего слоя на другой, но не может 

скопировать данный проводник, как линию, на слой маркировки. 

Разработка стекапа платы. Раздел Setup->Cross-Section. 

На Рис.  3.8 представлен один из вариантов настройки Cross-Section. Прежде всего стоит 

сказать, что если для пользователя масштаб ячеек с данными в разделе Cross-Section мал, то 

его всегда можно увеличить. Для этого необходимо кликнуть левой клавишей мышки на какую-

либо ячейку, затем зажать клавишу CTRL и покрутить колесико мышки. Масштаб будет 

увеличен или уменьшен соответственно. В верхней части расположены названия колонок. 

Видимостью колонок можно управлять. Для того, чтобы скрыть неиспользуемую группу 

колонок, необходимо выделить её, нажав на названии левой клавишей мышки. Затем 

пользователю необходимо нажать правую клавишу мышки и выбрать пункт “Hide column 

group”.  



 

 

Рис.  3.8 Один из вариантов Cross-Section реального проекта ПП. 

 

Рис.  3.9 Скрытие группы колонок. 

Для того, чтобы добавить новые колонки в разряд видимых, необходимо выбрать пункт 

меню, показанный на Рис.  3.10. 

 

Рис.  3.10 Активация диалогового окна добавления новых колонок в Cross-Section. 



 

 

Рис.  3.11 Окно управления видимостью колонок. 

Далее необходимо расставить галочки в соответствии с запросами пользователя. 

При первом запуске Cross-Section в новом проекте присутствуют только слои TOP, 

BOTTOM. Переходные отверстия не определены. См. Рис.  3.12. 

 

Рис.  3.12 Начальный вид раздела Cross-Section. 

Конечно же, пользователь может пропустить этап определения порядка следования слоёв и 

разработки нового стекапа платы, если используется стандартный стекап, и файлы для него 

заранее сохранены на диске. Для этого в меню File->Import необходимо выбрать 

соответствующую опцию – файл стекапа в формате IPC2581. Если никаких файлов для 

стекапа печатной платы не было сохранено ранее, пользователю придётся построить новый 

стекап самостоятельно.  

Прежде всего необходимо определиться с количеством и порядком следования слоёв в ПП. 

В проектирование многослойных печатных плат существует множество различных ситуаций, 

комбинаций требований и параметров, и универсального стекапа ПП на все случаи жизни не 

бывает. Однако в большинстве случаев надо придерживаться определенных правил. Надо 

чередовать слои сигнальных проводников со слоями, содержащими только сплошной полигон 

земли. Необходимо прятать слои питания между двумя слоями земли.  

Типовой стек слоёв многослойной платы. 

Приведём типовой порядок следования слоёв для ПП с двумя сигнальными слоями и двумя 

слоями питания. 

- TOP 



 

- GND 

- INT1 

- GND 

- PWR 

- PWR 

- GND 

- INT2 

- GND 

- BOTTOM 

Чтобы набрать такой стекап, необходимо совершить следующие действия в редакторе 

Cross Section: 

- Выделить ячейку, расположенную между слоями TOP и BOTTOM. 

- Нажать правую кнопку мышки и выбрать Add layer pair below. 

- Проделать данную операцию столько раз, сколько требуется слоёв в проекте. 

 

Рис.  3.13 Промежуточное состояние Cross Section после добавления необходимого количества слоёв. 

После того, как необходимое количество слоёв было добавлено, изменим имена 

проводящих слоёв. Для этого необходимо выделить ячейку с именем слоя и ввести новое 

название. 

После того, как все названия будут изменены, настанет время для подбора толщины 

диэлектриков и ядер. Необходимо подобрать толщины так, чтобы в общем случае толщина 

платы составила типовое значение 1.6мм (если в ТЗ не указано иное).  



 

 

Рис.  3.14 Промежуточное состояние стека после задания толщин ядер и препрегов. 

Необходимо учитывать, что в типовых структурах МПП наружные слои диэлектрика 

являются препрегом. Далее следует ядро, затем опять препрег и т.д. В нашем примере 

первое значение толщины диэлектрика после слоёв TOP и BOTTOM равно 0.102 мм. Эта 

толщина складывается из суммы толщин двух препрегов типа “106”.  

Между двумя слоями Power желательно положить как можно более толстый диэлектрик, 

чтобы взаимовлияние одного слоя питания на другой было как можно меньше. 

Толщина меди на внешних слоях ПП складывается из исходной 18 мкм, плюс толщина 

химического меднения 2-3 мкм, плюс толщина гальванической металлизации 15-25 мкм – 

итого суммарная толщина внешних слоев МПП составляет примерно 45 мкм. Толщина на 

внутренних слоях меди в первом приближении взята равной 18 мкм, хотя многие 

производители предпочитают использовать медь толщиной 35 мкм как более надёжный 

вариант.  

Теперь необходимо выставить правильный тип слоёв для земли и питания – их тип должен 

быть Plane, а тип Conductor используется для сигнальных слоёв.  

Теперь настала пора задать правильное значение поля Dielectric constant и Etch factor. 

Значения бокового подтрава проводников Etch factor зависят от качества технологии на 

конкретном заводе-производителе. В нашем примере угол бокового подтрава зададим 80 

градусов. Значит, верхняя поверхность проводника немного меньше по ширине, чем нижняя. 

Значение диэлектрической проницаемости возьмём равным 4, как типовое для FR-4 на 

частоте 1 ГГц. Конкретное значение необходимо брать из данных, предоставляемых 

производителем на используемый материал. 



 

 

Рис.  3.15 Промежуточное состояние Xsection после введения значений бокового подтрава и 
диэлектрической проницаемости. 

Расчет импеданса проводников. 

Теперь настала пора путём подбора значений ширины проводников найти такую, при 

которой значение импеданса одиночной линии будет равным 50 Ом.  

Некоторых пользователей смущает, что значение диэлектрической проницаемости 

напротив проводящих слоёв тоже выставлено равной 4. На самом деле – это значение 

диэлектрической проницаемости диэлектрика, который окружает проводящий рисунок на 

данном слое. Тогда логично было бы выставить на TOP и BOTTOM значения диэлектрической 

проницаемости воздуха - 1. Но на самом деле в подавляющем количестве случаем плата 

покрыта паяльной маской, а её диэлектрическая проницаемость близка к 4 (для некоторых 

марок материала маски – ближе к 3). 

 

Рис.  3.16 Конечный вид Xsection после первой итерации. 

После первой попытки подобрать ширину проводников мы видим, что это нельзя сделать, 

оставаясь в пределах 0.1мм по ширине проводника. Если дальше заужать ширину, то начнёт 

возрастать стоимость изготовления ПП. Следовательно, необходимо немного отодвинуть 

опорные слои земли от проводящих слоёв Int1 и Int2 для того, чтобы волновое сопротивление 

проводников возросло. После коррекции толщин препрегов и ядер можно будет увидеть 

картину, похожую на ту, что изображена на Рис.  3.17. 



 

 

Рис.  3.17 Вид Xsection при новых значениях толщин диэлектриков и ширин проводников. 

Процесс подбора диэлектриков и параметров проводников – это прежде всего итеративный 

процесс. Не стоит пытаться подобрать эти значения с первого раза. После того, как значения 

одиночных проводников были подобраны, необходимо рассчитать параметры диф. пар, если 

они присутствуют в проекте. 

 

Рис.  3.18 Значения ширины проводников и зазора в диф.парах. 

Расчет импеданса дифференциальной пары. 

Не стоит пытаться подбирать ширину проводников, составляющих диф.пару, так, чтобы по 

отдельности их волновое сопротивление было равно 50 Ом. Такая ситуация хороша, но 

совсем не обязательна. Если обратить внимание на новые ширины проводников диф.пар на 

Рис.  3.18, то они не равны ширинам для одиночных линий. Все значения ширин и зазоров для 

одиночных линий и для диф. пар необходимо выписать на бумажку для последующего 

занесения их в Constraint manager проекта. 

Стоит отметить, что существует возможность зонирования проекта ПП и определения 

отдельного стекапа для каждой зоны. Это очень удобно при проектировании гибко-жестких 

ПП. Эта возможность рассматривается в соответствующих разделах документации. 



 

На этом описание порядка действий при формировании стекапа ПП завершается. 

Если пользователю необходимо более детально ознакомиться с процессом подбора 

стекапа ПП, то рекомендуется ознакомиться с методическими материалами по расчету 

импеданса от поставщика печатных плат – компании «ПСБ технологии». 

Импорт списка соединений – Netlist. 

После того, как пользователь импортировал или нарисовал контур будущей печатной 

платы, определил стекап своего проекта и создал зоны отступов трассировки Route Keepin и 

размещения Package Keepin, можно приступать к этапу импорта Netlist из схемного редактора. 

Существует маршрут импорта списка межсоединений из схемного редактора OrCAD 

Capture, Allegro Design Entry Capture, Allegro DEHDL и сторонних программ, таких как 

PCAD200x, Altium, MentorEE и других.  

Приступим к описанию процесса передачи Netlist из схемного редактора OrCAD, как 

наиболее простого в использовании. 

Для начала процесса импорта необходимо выбрать пункты меню File->Import->Logic… 

Перед пользователем появится диалоговое окно, показанное на Рис.  3.19. 

 

Рис.  3.19 Окно импорта Netlist. 

Design entry HDL / Design entry CIS (Capture) – Указание: какой схемный редактор 

использовался при рисовании схемы и получении Netlist. 

Place changed component – Может возникнуть ситуация, когда в ходе работы над проектом 

схема может измениться. Соответственно, потребуется повторный импорт межсоединений в 

файл печатной платы. Данная настройка указывает программе на то, как поступать с уже 

существующими компонентами, если их свойства изменились. 



 

- Always – Ставить изменившийся символ всегда. Программа не принимает во внимание: 

какой компонент и в каком корпусе имеет старый RefDes. Если в первой версии платы на 

месте R1 стоял резистор в корпусе 0603, а в новой версии корпус поменялся на 1210, то 

резистор в новом корпусе будет установлен на место старого. 

- Never – Не устанавливать изменившиеся компоненты. Если в свойствах компонента 

произошло хоть какое-либо изменение, то компонент будет перенесён в разряд 

неустановленных. 

- If same symbol – Устанавливать компонент, если его корпус не изменился. Если 

изменилось любое другое свойство, то программа не будет принимать это во внимание и 

оставит компонент на ПП. 

Allow etch removal during ECO – Если в ходе импорта списка межсоединений в уже 

существующую трассировку ПП возникнут участки трассировки, “повисшие в воздухе”, то они 

будут удалены из проекта ПП. 

Ignore FIXED property – Игнорировать зафиксированные пользователем объекты. Т.е. их 

редактирование разрешается. В противном случае программа не сможет изменить их 

состояние или подключение к другим элементам. 

Create user-defined properties – Создавать свойства элементов, определенные 

пользователем. В противном случае будет перенесена только та информация, которая 

содержится в стандартных полях свойств. 

Create PCB XML from input data – Генерировать список межсоединений в формате XML 

для проверки двух версий ПП на различия. Данный файл можно сгенерировать и другим 

инструментом Tools->Design compare…  

Import directory – Указание директории, где содержатся файлы Netlist, описывающие 

межсоединения вашего проекта. 

После того, как все необходимые настройки произведены, необходимо нажать на кнопку 

Import Cadence. Если процесс импорта пройдёт успешно, то на экране возникнет быстро 

пропадающее окошко с надписью, показанное на Рис.  3.20. 

 

Рис.  3.20 Окошко с отчётом об успешном завершении процесса импорта Netlist. 

Ошибки при передаче списка соединений в плату. 

В процессе импорта могут возникать различные ошибки. Рассмотрим только наиболее 

часто встречающиеся ошибки при импорте Netlist. 

#1 WARNING(SPMHNI-192): Device/Symbol check warning detected. [help] 

WARNING(SPMHNI-194): Symbol 'C0402' used by RefDes C5 for device 

'CAP_NP_C0402_DISCRETE_0.1UF' not found in PSMPATH or must be "dbdoctor"ed. 



 

Данная надпись означает, что в директории, которая указана в качестве исходной 

библиотеки для посадочных мест, отсутствует посадочное место C0402. 

#1 WARNING(SPMHNI-192): Device/Symbol check warning detected. [help] 

ERROR(SPMHNI-196): Symbol 'CC0402' for device 'CAP_NP_0_CC0402_DISCRETE_0.1UF' 

has extra pin '2'. 

ERROR(SPMHNI-196): Symbol 'CC0402' for device 'CAP_NP_0_CC0402_DISCRETE_0.1UF' 

has extra pin '1'. 

ERROR(SPMHNI-195): Symbol 'CC0402' for device 'CAP_NP_0_CC0402_DISCRETE_0.1UF' 

is missing pin '11'. 

ERROR(SPMHNI-195): Symbol 'CC0402' for device 'CAP_NP_0_CC0402_DISCRETE_0.1UF' 

is missing pin '22'. 

Данная надпись означает, что у посадочного места CC0402 на печатной плате, и у схемного 

символа, использующего это посадочное место, не совпадают номера пинов. Надо 

отредактировать либо схемный символ, либо номера пинов посадочного места. 

#1 WARNING(SPMHNI-192): Device/Symbol check warning detected. [help] 

WARNING(SPMHNI-337): Unable to load symbol 'CC0805' used by RefDes C1 for device 

'CAP_NP_CC0805_DISCRETE_10UF_10%': WARNING(SPMHUT-127): Could not find padstack 

R051X059S. [help] 

Данная надпись означает, что у посадочного места CC0805 отсутствует контактная 

площадка. В самом файле посадочного места с расширением DRA площадка может 

содержаться. Но она не присутствует как отдельный файл R051X059S.PAD. 

Надо исправить все ошибки в схеме или файле Netlist и добиться безошибочного импорта. 

На этом процесс передачи данных из схемы в плату можно считать оконченным. 

4. Заполнение разделов редактора правил 

Constraint Manager. 
В процессе создания символов посадочных мест нам пришлось немного познакомиться с 

Constraint manager. 

Это надстройка, при помощи которой происходит управление всеми константами, 

содержащимися в проекте. Все данные представляются в табличной форме, что очень 

удобно. Поддерживается “принцип генерала”. Это означает, что совершенно ненужно 

заполнять константы для каждой отдельной ситуации или линии. 

Идеология работы в Constraint manager: 

- Необходимо определить наборы правил, которым будут подчиняться цепи, зазоры и т.д. 

- Затем необходимо определить группы объектов, которые будут подчиняться правилам. 

- Назначить наборы правил группам объектов. 

Данное решение удобно прежде всего своей лёгкой масштабируемостью и гибкостью, 

поскольку управление идёт на самом верхнем уровне иерархии. А доведение правил до 

каждой отдельной цепи или контактной площадки осуществляет уже программа. 

Рассмотрим работу с правилами и константами более подробно. 



 

Прежде всего необходимо запустить Constraint manager командой CMGR в командной 

строке, либо выбрав “Setup->Constraints->Constraint manager”. 

Перед пользователем откроется окно Constraint manager (будем называть его CM). Пример 

см. на рис. 192 

 

Рис.  4.1 Пример окна CM. 

Для пользователей, которых не устраивает размер шрифта в ячейках, либо размер самих 

ячеек Constraint Manager, существует возможность изменить размеры ячеек и текста. 

Необходимо зажать CTRL и покрутить вниз-вверх колесико мышки. 

Физические правила (размеры объектов) 

Первое, на что стоит обратить внимание – должен быть открыт раздел физических 

ограничений – Physical. Именно с данного раздела мы начнём заполнять правила для 

трассируемой ПП. Как видно на Рис.  4.1, в проекте существует набор правил, который 

называется Default. Данные правила созданы по умолчанию и всегда присутствуют в любом 

новом проекте. Чтобы создать свой набор физических констант, необходимо выделить набор 

правил Default левой клавишей мышки.  

 

Рис.  4.2 Набор правил Dafault выделен. 

Далее нажать правую клавишу мышки и выбрать из выпадающего меню “Create -> Physical 

Cset” 



 

 

Рис.  4.3 Создание нового набора физических правил. 

Осталось задать новое имя, и набор правил будет скопирован с набора Default в набор с 

указанным именем.  

 

Рис.  4.4 Новый набор правил с именем 50-ОМ. 

Теперь необходимо отредактировать новый набор в соответствии с теми числами, которые 

были получены на этапе расчёта стекапа печатной платы. Прежде чем вносить изменения, 

стоит обратить внимание на цвет столбцов в Constraint Manager. Иногда будет встречаться 

жёлтый цвет ячеек или столбцов. Это означает, что какая-либо проверка, соответствующая 

данной ячейке/столбцу, не может быть проведена. Это может происходить по нескольким 

причинам. Самые распространённые: 

- Проверка просто отключена пользователем. 

- Объекта проверки ещё физически не существует. Пример: Линия не доведена до конца. 

ВНИМАНИЕ! Возможно возникновение ситуации, когда пользователь, выделяя какой-либо 

набор констант, выделяет все ячейки, принадлежащие этому набору. И любое изменение 

параметров в любой из ячеек приведёт к тому, что все выделенные чёрным цветом ячейки 

изменят своё значение на введённое число. Это групповое изменение не исправляется в 



 

обратную сторону. Надо внимательно следить за выделением ячеек, и убирать групповое 

выделение, нажимая Esc на клавиатуре. 

 

Рис.  4.5 Ситуация с групповым изменением ячеек, требующая аккуратности. 

На Рис.  4.5 как раз представлена та самая ситуация, когда введение значения в ячейку Min 

Line Width приведёт к изменению всех выделенных ячеек, принадлежащих данному классу 

правил. 

Если раскрыть класс 50-OM, нажав на знак плюса в левом нижнем углу ячейки, то 

пользователь увидит два класса слоёв. Слои разделяются в соответствии с тем, какие 

атрибуты они имеют в разделе Cross-Section – сигналы или плейны. По этой причине следует 

аккуратно распределять типы слоёв при задании стекапа платы.  

Теперь можно задавать толщину линий на всех слоях сразу, либо на классе слоёв, либо по 

каждому слою в отдельности. 

Рассмотрим назначение каждого из параметров, которые будут назначаться: 

Line width – ширина линии на проводящем слое. 

- Min/max – минимальное/максимальное значение ширины. Если максимальное значение 

не задано, то ширина линии не имеет ограничений по максимальному значению. 

Neck – Ширина линии в зоне заужения. Иногда необходимо провести как можно больше 

линий, заняв при этом как можно меньше трассировочного пространства. Это можно сделать, 

несколько сократив ширину линий на заданной длине. Параметры сужения и длину суженного 

участка выбирает пользователь. Как правило, длина суженного участка не превышает 50% от 

предполагаемой длины линии. Это справедливо для электрически коротких линий. Если линия 

электрически длинная, то длина заужения должна оставаться ещё электрически короткой. 

- Min width – минимальная ширина заужения. 

- Max length – максимальная длина заужения. 

Столбец Differential Pair пока что рассматривать не будем и оставим его ячейки пустыми, 

поскольку класс 50-ОМ мы будем использовать для одиночных (Single Ended) цепей. 

Vias – Выбор переходных отверстий. Назначение и заполнение этого поля уже 

рассматривалось в разделе «Добавление доступных переходных отверстий к классу цепей 

«по умолчанию». 

BB VIA STAGGER – В сложных проектах присутствуют погребённые и глухие отверстия, 

Blind via и Buried via. Иногда их нельзя располагать строго одно над одним, в соседних слоях – 

stacked via или staggered via. Надо знать технологически допустимое минимальное смещение 

от центра микроперехода в одном слое до центра микроперехода в соседнем слое. Если 

задать значение полей min/max, то отверстия нельзя будет располагать одно над одним. Если 

проектируемая плата содержит только сквозные переходные отверстия, то на данные поля не 

стоит обращать внимания.  

Рассмотрим пример ситуации, когда глухие и слепые отверстия располагать над друг 

другом нельзя. 



 

Простейший пример – это керамические подложки для кристаллов с проводящим ток 

напылением. На первом этапе на подготовленное основание напыляются проводящие 

дорожки, затем формируются столбики переходных отверстий, затем столбики заливаются 

изолятором, на котором в свою очередь формируются новые проводящие ток дорожки. В 

данной  ситуации нельзя нарастить столбик двойной высоты. Необходимо сдвинуть 

следующий столбик относительно предыдущего в сторону. 

Allow pad-pad connect – Поле разрешает соединять различные части проводящего 

рисунка напрямую друг с другом без использования проводников. 

Allow Ts – Обозначает место, где допускается формирование так называемых виртуальных 

пинов. Виртуальные пины ставятся обычно в точке разделения проводящей линии на 

несколько отрезков (так называемая трассировка «деревом»). О данном виде трассировки и 

виртуальных точках будет рассказано позднее. 

Allow Etch – Разрешает или запрещает использование проводящих полигонов и линий при 

трассировке данного класса цепей. В области печатных плат трудно придумать ситуацию, 

когда трассировка цепей не содержит линий и полигонов. Так что данное значение всегда 

необходимо ставить в True. 

Управление различными видами проверок 

После заполнения нашего первого класса физических констант пришло время поговорить о 

том, где включаются или отключаются те или иные виды проверок. 

Управление проверками происходит из раздела Analyze->Analysis modes. Данный раздел 

расположен в верхней части окна Constraint manager. После активации пункта Analysis mode 

пользователь увидит следующую картину (Рис.  4.6). 

 

Рис.  4.6 Окно управления производимыми проверками. 

Все производимые проверки собраны в разделы. В разделе Physical пользователь может 

включить проверки, принадлежащие физическим константам. В простом проекте 

целесообразно было бы отключить проверки: 

- Min blind/burried via stagger 

- Max blind/burried via stagger 

- Viaslist DRC – проверка на то, все ли падстеки, находящиеся в списке, физически 

присутствуют в папке падстеков. 



 

Чем большее количество проверок включено, тем дольше они будут проводиться. Конечно, 

на современных компьютерах эта задержка почти незаметна. В то же время с ростом 

сложности проектов проведение проверок занимает всё более ощутимое время. 

Групповое задание констант и иерархия ячеек. 

Внимательные пользователи могли заметить при заполнении полей Constraint Manager, что 

некоторые ячейки содержат значения, показанные тонким чёрным шрифтом. Некоторые 

значения показаны более толстым голубым шрифтом. Разница заключается в том, как были 

получены значения ячеек. Если значение было введено человеком вручную, то это значение 

показывается толстым синим шрифтом и не может быть изменено программой. Т.е. такие 

значения самые главные и никогда не изменяются, если их не изменяет человек. Значения, 

показанные тонким чёрным шрифтом, могут изменяться программой. Причём они могут 

изменяться и другими программами, которые имеют право на редактирование областей в 

Constraint Manager. Это могут быть Sig Explorer, Sigrity Power DC, OrCAD Capture, DE HDL. 

Также, если ячейки с чёрным шрифтом зависят от ячеек с синим шрифтом, то они принимают 

значения ячеек с синим шрифтом. Т.е. если на самом верхнем уровне иерархии Conductor на 

Рис.  4.7 инженер ввёл значение Min width равное 0.1мм, то все слои с проводниками, начиная 

от TOP и до BOTTOM, получат данное значение ширины.  

 

Рис.  4.7 Иллюстрация иерархии ячеек. 

Волновое сопротивление. 

Несколько слов о том, что такое волновое сопротивление, и почему для простых 

сигнальных линий выбрано именно 50 Ом. 

Волновое сопротивление, или импеданс – это связь между действующим значением 

напряжения и тока в проводнике для высокочастотных сигналов. Проводник, по которому 

распространяются такие скоростные сигналы, является фактически линией передачи и 

должен иметь определенные электромагнитные характеристики, чтобы обеспечить 

согласование по сопротивлению с передатчиком и с приемником сигнала. В противном случае 

в точках рассогласования будут возникать отражения и потери в линии, приводящие к 

искажениям сигнала, вплоть до невозможности передачи корректных данных. 



 

Типовое волновое сопротивление одиночных проводников выбрано равным 50 Ом только 

потому, что так сложились обстоятельства. Все договорились, что их устраивает такое 

значение волнового сопротивления. Общая ситуация такова, что с понижением волнового 

сопротивления проводящей линии возрастает нагрузка на драйвер, но снижается излучение 

ЭМ поля проводником вовне. Если выходное сопротивление драйвера хорошо согласовано с 

входным сопротивлением приёмника и с волновым сопротивлением линии передачи, то нет 

никаких препятствий для выбора любого значения этой величины. 

Задание параметров трассировки дифференциальной пары. 

Дифференциальная пара – это два сигнала, передающие практически одинаковый сигнал, 

но в противофазе. Проводники дифференциальной пары долгое время идут на небольшом 

расстоянии друг от друга. Из-за этого их коэффициент связности относительно высокий. 

Однако он не столь высок, как в случае витой пары. Если коэффициент связанности в витой 

паре равен практически единице, то максимальный коэффициент дифференциальной пары 

0.6 или менее. Два проводника, передающие разные сигналы, не являются одним целым. У 

каждого из проводников существуют возвратные токи, идущие по полигонам земли и, в 

некоторых случаях, полигонам питания. Об этой особенности дифференциальной пары 

следует всегда помнить. 

Поговорим о параметрах диф. пар, которые присутствуют в Constraint manager в разделе 

Physical -> All layers. 

Primary gap – Это зазор между проводниками диф. пары, который рассчитан инженером.  

Neck gap – Данное расстояние между проводниками в диф. паре будет поддерживаться в 

узких местах проекта. Например: под BGA компонентами для выхода наружу. 

Min line spacing – Это минимально возможный зазор между проводниками, какой только 

может быть в проекте. Т.е. в узких местах проводники диф. пары могут сближаться друг с 

другом, но это ещё не будет минимально возможным расстоянием. 

(+/-) Tolerance – Положительный и отрицательный допуск на расстояние между двумя 

проводниками в диф. паре. 

Дело в том, что при прокладке проводников под углами, отличными от 0, 90, 180 градусов, в 

четвёртом знаке после запятой может накапливаться ошибка измерения, которая будет 

вызывать появление DRC. По сути, эти ошибки не существуют в реальности, и нет нужды их 

рассматривать. Стоит поставить допуск равным 0.001 мм. Однако следует поддерживать 

такую ситуацию, при которой значение <Neck gap минус Tolerance> не было бы меньше, чем 

Min line spacing. Программа не даст ввести пользователю значения, нарушающие данное 

правило. 

Электрические правила. 

Теперь рассмотрим параметры, которые можно задать в других разделах. 

Electrical -> Electrical constraint set -> Differential pair. 

Uncoupled length – Понятие uncoupled применяется для диф.пары в случае, когда её плечи 

расходятся на расстояние, больше того, которое указано в графе primary gap. 



 

 

Рис.  4.8 Иллюстрация Uncoupled и Gather control. 

Сегменты трасс от пинов приёмника/передатчика до точки схождения на расстояние Primary 

gap не считаются Uncoupled length. Однако значение Gather control по умолчанию не задано 

(пустое поле). В таком случае на протяжении всей длины трассы на всех сегментах 

выполняется подсчёт длины Uncoupled length. Чтобы сегменты с красной линией в центре не 

рассматривались, необходимо поставить значение Gather control в Ignore. Если этого поля нет 

в constraint manager, значит, используемая лицензия не позволяет проводить данный тип 

проверок. 

Static phase tolerance – Проверка на расхождение фазы между плечами диф. пары.  

Иногда создается ситуация, когда один из проводников диф. пары оказывается более 

длинным, чем другой.  И такое положение вещей поддерживается на довольно 

продолжительном отрезке. Тогда фронты сигналов, проходящих по плечам диф. пары, 

начинают размываться. 

 

Рис.  4.9 Иллюстрация задержки в распространении сигнала в одном из плечей из-за разницы в 
физической длине сегментов. 



 

Размытие происходит из-за того, что один из сигналов как бы обгоняет другой, бежит 

впереди. Отстающий сигнал “тянет назад”, в то время как обгоняющий сигнал “тянет вперёд”. 

Стремясь компенсировать несимметричность, форма сигнала в плечах диф. пары начинает 

изменяться.  

Приведём небольшой пример, показывающий ухудшение ситуации при несогласованности 

фаз плечей диф. пары. 

 

Рис.  4.10 Различная трассировка диф. пар при выходе из под BGA компонента. 

 

Рис.  4.11 Отражение сигнала от пинов BGA компонента. Получено при помощи Cadence Sigrity 
PowerSI 2017. 

На Рис.  4.11 показано отражение дифференциального сигнала от начала линии для 

трассировки на Рис.  4.10, в заданном диапазоне частот. Чем выше график расположен по оси 

Y, тем хуже, т.к. отражение сигнала обратно в передатчик больше. То есть синяя диф.пара в 

данном случае имеет менее качественную трассировку, из-за того, что в ней не 

выравнивается фаза, а в красной паре фаза двух трасс выравнивается в самом начале. 

Возвратимся к заданию Static phase tolerance в Constraint manager. 

Данный параметр подсчитывается однократно на концах диф. пары. Где находится конец, а 

где начало, программа определяет исходя из функционального назначения пинов.  Это 

значение выставляется в поле “Pin Use” при создании схемного символа в OrCAD Capture. 

Оно может принимать различные значения: IN, OUT, BI, Passive и др. Бывает, что у всех пинов 

выставлено значение BI, либо другое. Это не позволяет однозначно определить начало и 

конец линии. Тогда начало определяется программой в ходе хаотичного выбора какой-либо 

пары пинов в качестве источника сигнала. 



 

Подсчёт Static phase доступен во всех вариантах лицензии PCB Editor. 

Dynamic phase – Данный тип проверки обладает двумя настраиваемыми параметрами. 

Рассмотрим механизм его работы подробнее и поясним на рисунке. 

При трассировке диф. пары бывает необходимо изменить направление следования 

сигналов на 90 – 270 градусов. В ходе поворота диф. пары на определённый угол один из 

сигналов начинает отставать от другого, т.к. из-за поворота ему приходится проходить 

большее расстояние. В пример можно привести бегунов на внутренней и внешней дорожках 

стадиона. Если такое отставание не будет скомпенсировано зеркальным поворотом, либо 

иными способами, то данная ситуация также приведёт к ухудшению качества передаваемого 

сигнала.  

Проверка Dynamic phase беспрерывно подсчитывает расхождение длин проводников в 

плечах диф. пары. Как только из-за поворота либо других факторов расхождение стало 

больше, чем указано в колонке Tolerance, ставится виртуальная засечка, и начинается отсчёт 

длины. Если в ходе трассировки на длине Max length начиная от виртуальной засечки не 

произошла компенсация расхождения по длине, то программа начинает отображать маркер 

ошибки. Начало маркера находится в месте, где разница в длине сигналов превысила 

заданную. Конец маркера находится в месте, где произошла компенсация длин проводников. 

 

Рис.  4.12 Иллюстрация результата работы проверки Dynamic Phase. 

Данный тип проверки доступен только с лицензией Allegro PCB Designer и выше. В 

лицензии OrCAD PCB Designer Professional данная проверка отсутствует. 

 

Рис.  4.13 Результат работы проверки Dynamic Phase в окне Constraint manager. 



 

Назначение наборов правил классам цепей. 

После того, как были заданы ширина линий и параметры диф. пар в разделе Physical, 

следует присвоить эти правила наборам цепей. 

 

Рис.  4.14 Присвоение правил Physical раздела классам цепей. 

Прежде всего следует поделить все цепи в проекте на классы. Обычно делят на классы 50-

Омных одиночных цепей, 100-Омных диф.пар, и классы цепей земли и питания. Для того, 

чтобы создать класс цепей, необходимо выделить при помощи SHIFT либо CTRL 

необходимые цепи и затем нажать правую кнопку мышки. Появится диалоговое окно, 

показанное на Рис.  4.15.  Далее необходимо дать название новому классу цепей. После 

создания нового класса пользователь должен назначить для него определённый набор 

правил. Наборы правил создаются в разделе Physical -> Physical Constraint Set -> All layers.  

 

Рис.  4.15 Создание нового класса цепей. 

На Рис.  4.14 можно видеть, что классу цепей 50OM_CONFIG назначен набор правил 

50OHM. 

Действуя таким образом, необходимо добиться ситуации, когда все цепи будут 

принадлежать каким-либо классам. Это в определённой степени гарантирует инженеру 

трассировщику, что каждой цепи в проекте было уделено хотя бы минимальное внимание. 

После того, как все цепи будут распределены по физическим классам, теоретически можно 

начинать трассировку проекта, так как зазоры между элементами проводящего рисунка 

заданы по умолчанию. И значения по умолчанию уже присутствуют в определённых ячейках. 

Однако так поступать было бы опрометчиво, поскольку значения по умолчанию не подходят 

для трассировки сложных плат 5-го класса точности. 



 

Правила по зазорам. Раздел Spacing. 

Данный раздел посвящён заданию правил для минимально допустимого расстояния между 

элементами проводящего рисунка. Весь проводящий рисунок разделяется на классы 

объектов: сквозные переходные отверстия, контактные площадки SMD компонентов и так 

далее. С полным списком объектов пользователь может познакомиться, зайдя во вкладку 

Spacing -> Spacing Constraint Set -> All layers.  

В данном разделе поддерживается та же логика работы, что и в Physical: необходимо 

сначала создать наборы правил, затем создать классы цепей, и затем присвоить наборы 

правил созданным классам. 

На Рис.  4.16 можно видеть пример набора правил по зазорам. Он называется 0MM2. 

Рассмотрим, как им можно управлять для более лёгкого восприятия информации. Прежде 

всего необходимо обратить внимание на верхнюю часть таблицы. 

 

Рис.  4.16 Пример набора правил по зазорам. 

Шапка, находящаяся в верхней части таблицы, называется “Line to <<”. Если быстро два 

раза кликнуть на данную ячейку левой клавишей мышки, то она свернётся, и пользователь 

увидит картину, похожую на Рис.  4.17. 

 

Рис.  4.17 Раздел “Line to” в свёрнутом состоянии. 

Остался один столбец All. Можно ещё больше сократить видимые для заполнения ячейки, 

свернув разделы Conductor и Plane. В конце концов можно свернуть вообще весь набор 

зазоров между указанным объектом и остальными участками проводящего рисунка. Останется 

только одно поле с тремя звёздочками. 



 

 

Рис.  4.18 Максимально свёрнутое состояние набора правил по зазорам. 

Теперь остаётся только поставить вместо трёх звёздочек некое числовое значение. В 

нашем примере это будет зазор по умолчанию 0.2 мм.  После данного действия пользователь 

увидит ситуацию похожую на Рис.  4.19. 

 

Рис.  4.19 Вместо звёздочек проставлено числовое значение. 

Теперь можно развернуть созданный набор зазоров и убедиться, что во всех ячейках 

появилось значение 0.2. См. Рис.  4.20. 

 

Рис.  4.20 Состояние “Line to” раздела после редактирования зазоров групповым способом. 

Данный способ задания зазоров позволяет довольно быстро задать все необходимые 

параметры по расстоянию от одних элементов проводящего рисунка от других. Однако при 

таком подходе теряется гибкость в настройке. К тому же минимально допустимое расстояние 

от полигона до переходных отверстий на конкретном производстве печатных плат может 

отличаться от минимального расстояния до поверхностных контактных площадок. Также 



 

важно помнить, что расстояние от одного полигона от другого, как правило, всегда больше, 

чем общие зазоры по проекту. Подводя итог, можно заключить, что групповой способ хорош в 

качестве первичного. Можно быстро «раскидать» зазоры между объектами, и в последующем 

при трассировке доработать их в сторону увеличения или уменьшения. 

Если пользователь не хочет видеть определённый раздел по зазорам, то его можно скрыть 

из рассмотрения, выбрав шапку раздела и затем нажав правую клавишу мышки. 

 

Рис.  4.21 Скрытие раздела. 

Если же необходимо вернуть скрытые разделы, то достаточно выбрать в верхней части 

экрана Constraint manager View -> Show All Columns. 

 

Рис.  4.22 Возвращение скрытых разделов. 

Также можно настраивать вид Constraint manager. Выбирать цветовую гамму различных 

состояний ячеек, расположение шапок и т.д. Это делается в разделе View -> View Options.  

Рассмотрим ещё одну очень важную вкладку в левой части раздела Spacing. Эта вкладка 

называется CSET Assignment matrix. Она служит для задания зазоров между различными 

классами цепей.  

Задание таблицы зазоров между классами цепей. CSET Assignment matrix. 

Допустим, в нашем проекте существует два класса цепей: Power-and-ground и DDR_signalki. 

В первый класс входят все питательные и земляные цепи, а во второй все сигнальные цепи 

от ДДР памяти. Внутри класса цепей power-and-ground поддерживаются зазоры 0.5мм. Внутри 

класса сигнальных цепей поддерживаются зазоры 0.2мм. А вот как быть при определении 

взаимных зазоров для сигнальных цепей и цепей питания? В общем случае расстояние цепей 

питания от сигнальных хотелось бы поддерживать как можно большим. Для этого случая на 

помощь пользователю как раз и приходит указанная вкладка CSET assignment matrix – 

матрица назначения взаимных зазоров между классами. 

Для того, чтобы разграничить зазоры между классами цепей, необходимо эти классы 

создать и назначить им наборы правил. Что и было проделано на Рис.  4.23. 



 

 

Рис.  4.23 Классы цепей с заданными правилами по зазорам. 

Теперь, например, пользователю необходимо, чтобы между классом DDR_SIGNALKI и 

классом POWER-AND-GROUND поддерживались зазоры 0.8мм, между любым обьектом из 

одного класса и любым объектом из другого. 

Для этого необходимо создать и соответственно заполнить ещё один набор правил. 

Допустим он будет называться 0mm8. Теперь необходимо перейти в раздел CSet assigment 

mantrix и заполнить “косынку классов” так, как показано на Рис.  4.24. В данном случае 

намеренно создана самая лёгкая ситуация из возможных, когда количество классов 

минимально. Если классов в проекте будет больше, для каждой комбинации классов в 

таблице можно назначить отдельное правило по зазорам. 



 

 

Рис.  4.24 Заполнение “косынки классов”. 

Регионы с другими правилами. 

После рассмотрения раздела Spacing и логики его наполнения, следует поговорить об 

областях на печатной плате, в которых применяются правила трассировки, отличные от 

определённых для всего проекта. Например, при пересечении границы области ширина линии 

изменяется. Такие области в Cadence Allegro PCB Designer называются регионами. 

Для того, чтобы воспользоваться регионом, его необходимо сначала создать. Регион по 

сути своей – обычный незаполненный многоугольник с подключённым к нему набором 

констант.  

Чтобы создать контур региона, необходимо в редакторе плат выбрать команду Add-

>Rectangle.  

 

Рис.  4.25 Добавление Незаполненного контура. 

После активации необходимой команды, её нужно настроить. Под настройкой 

подразумевается выставление требуемых параметров в окне Options, чтобы добавить 

прямоугольный полигон на нужный нам слой Constraint Region / ALL, как на Рис.  4.26. 



 

 

Рис.  4.26 Настройка команды Add->Rectangle. 

В соответствии с настройками на Рис.  4.26 будет добавлен прямоугольник на класс 

объектов Constraint Region и подкласс All, и создаваемый регион будет воздействовать на все 

трассировочные слои печатной платы. Настройка Rectangle creation->Draw Rectangle 

означает, что прямоугольник пользователю придётся нарисовать самостоятельно, указав 

мышью противоположные диагональные вершины. После отрисовки прямоугольной области 

необходимо завершить команду, нажав на правую клавишу мышки и выбрав Done. После 

этого пользователь сможет видеть на экране незакрашенную область, обозначающую 

созданный регион (если, конечно, включена видимость этого подкласса).  

Теперь следует вернуться в Constraint manager. Пользователю будет необходим раздел 

иерархии Physical – Region или Spacing – Region, см. Рис.  4.27. Далее следует выделить 

ячейку с названием проекта и создать новый регион – правой кнопкой мыши Create - Region. 

 

Рис.  4.27 Создание региона в окне Constraint manager. 

После создания региона, необходимо выбрать в ячейке справа нужный набор физических 

правил, которые будут поддерживаться в данном регионе. 



 

 

Рис.  4.28 Назначение нового набора правил вновь созданному региону. 

Теперь необходимо связать наш созданный полигон в поле печатной платы с регионом в 

разделе Constraint manager. Для этого необходимо опять вернуться в рабочее поле с 

трассировкой печатной платы и выбрать только что созданный прямоугольник. Поскольку это 

объект типа Shape, то и выбирается он командой Shape Select. Она находится в разделе 

Shape -> Select shape or Void/Cavity. После активации команды необходимо навести курсор 

мышки на границу области и кликнуть на левую клавишу. Незаполненная область будет 

выделена и в её вершинах появятся квадраты, за которые можно потянуть для изменения 

формы и размеров области.  

 

Рис.  4.29 Редактирование границ региона при помощи команды Shape Select. 

В данном примере никаких действий с границами области мы производить не будем. Нас 

интересует содержание окошка Options. В данном окошке будет присутствовать строка Assign 

to region. Пока что она не заполнена. Необходимо кликнуть на эту строчку и выбрать в ней 

название региона из Constraint manager.  



 

 

Рис.  4.30 Связывание области на печатной плате и региона в Constraint manager. 

 

Рис.  4.31 Иллюстрация изменений параметров трассировки при пересечении границы региона. 

Теперь любая трасса при пересечении границы региона будет подчиняться новым 

правилам и менять свою ширину на ту, которая задана для набора правил, присоединённых к 

этой области. 

Стоит отдельно поговорить о диф. парах и их поведении внутри регионов. Обычно 

пользователю не нужно, чтобы диф. пары изменяли свои параметры при пересечении 

границы региона, поскольку, изменение параметров диф. пары легко добиться через команду 

Neck при трассировке. Да и диф. пары относятся к критическим сигналам, которые без особой 

нужды лучше не подвергать изменениям. Для выполнения данной задачи, необходимо в 

Constraint manager активировать окно настроек проводимых проверок, выбрав analyze-

>analysis mode. Далее поставить галочку напротив пункта Electrical – All differential pair checks 



 

– Diff Pair width and gap overrides supersede Region constraint, указанного на Рис.  4.32. После 

этих действий все диф. пары перестанут подчиняться настройкам констант, действующим в 

регионах. 

 

Рис.  4.32 Опция исключающая влияние региональных констант на диф. пары. 

На этом первичное знакомство с Constraint manager можно считать оконченным. 

Пользователь уже готов приступать к расстановке компонентов на печатную плату и 

трассировке проекта. 

  



 

5. Расстановка компонентов на печатной 

плате. 
Расставлять компоненты внутри контура печатной платы можно несколькими способами: 

- автоматически по файлу координат. 

- полуавтоматически через меню quickplace 

- вручную через меню place manually 

- интерактивно при задействовании схемы. 

Рассмотрим все способы по порядку. 

Автоматическая расстановка при помощи файла координат. 

Если какая-то часть схемы нового устройства уже взята с готового проекта, и трассировка 

печатной платы уже существует, то можно воспользоваться существующим размещением 

компонентов и повторить его в новом проекте. Для этого будет необходим текстовый файл с 

координатами компонентов, следующего формата: 

VERSION = 2.0 

UUNITS = MILLIMETERS   

#    refdes          !   symbol_x !   symbol_y ! rotation ! mirror ! symbol_name        ! embedded_layer                   

#-------------------------------------------------------------------------------------------------- 

R10                  !     87.450 !     22.625 !       90 !        ! NR1_4R             !                                  

R11                  !     49.300 !     21.275 !      180 !        ! NR1_4R             !                                  

R12                  !     93.225 !     22.275 !      180 !        ! NR1_4R             !                 

Такой файл можно написать вручную, либо сгенерировать через команду File->Export-

>Placement с уже готового проекта ПП. 

Далее командой File->Import->Placement необходимый файл читается, и указанные в нём 

компоненты расставляются в соответствии с указанными координатами.  

 

Полуавтоматическая расстановка при помощи меню quick place. 

Инструмент Quick place предназначен для быстрой установки компонентов в поле печатной 

платы. Можно сказать, что главным приоритетом этого инструмента является скорость. Из-за 

этого установка компонентов может быть проведена только группами. Индивидуально каждый 

компонент таким способом расставить не удастся. Группы элементов создаются по 

определённому признаку. Признак пользователь может выбрать самостоятельно, см. Рис.  5.1. 

Инструмент можно вызвать при помощи команды Place->Quick place. 



 

 

Рис.  5.1 Меню инструмента Quick place. 

 

Place by property/value – позволяет устанавливать компоненты, значение свойства 

которых равно определённому параметру. Поясним на примере Рис.  5.2. 



 

 

Рис.  5.2 Установка компонентов с выбранным значением Value. 

В схеме электрической принципиальной OrCAD Capture присутствует данное поле. В него, 

как правило, заносят номиналы пассивных компонентов. Для микросхем транзисторов и др. 

элементов данное поле не так важно, как для пассивных. Однако Value не может быть пустым, 

и в это поле для микросхем попадает значение part number. После того, как определённое 

значение поля Value будет выбрано, в нижней части окна можно будет наблюдать, сколько 

компонентов попадает под критерии выборки.  

Symbols placed – Строчка показывающая: сколько компонентов попали под критери и были 

установлены. 

Place by room – Установка компонентов в определённой области печатной платы. 

Расстановка компонентов по «комнатам» 



 

В работе трассировщика часто возникает задача контроля того, где располагаются те или 

иные компоненты. К примеру, фильтрующие конденсаторы питания процессора должны 

располагаться около процессора. Элементы формирования опорных напряжений должны 

располагаться около входных разъёмов. Шумящие компоненты и экранирующие элементы 

должны располагаться близко друг от друга, но далеко от остальных. Такие задачи хорошо 

решаются при помощи “комнат”. 

Комнаты – это области в проекте печатной платы. Они выполняются при помощи 

незаполненных многоугольников. Комнаты могут иметь имена или названия. Если в свойствах 

компонентов присутствует свойство ROOM и значение этого свойства совпадает с названием 

комнаты на печатной плате, то все компоненты с совпадающими значениями будут 

установлены в нарисованной области. Поясним на примере. 

Существует кусок схемы, элементы которой должны стоять в левом-верхнем углу печатной 

платы в строго определённой области. 

 

Рис.  5.3 Пример схемы для расстановки в комнате. 

Выбираем все компоненты при помощи окна выделения и нажимаем правую клавишу 

мышки. Далее в выпадающем меню выбираем пункт Edit properties, см. Рис.  5.4. 

 

Рис.  5.4 Все элементы выбраны. Осталось отредактировать свойство ROOM. 



 

 

Рис.  5.5 Заполнение свойства ROOM. 

После выбора команды Edit properties пользователь увидит таблицу свойств, которые 

принадлежат выбранным элементам. В этой таблице необходимо найти или создать свойство 

ROOM и заполнить его одинаковым значением для всех строчек. Далее следует этап 

генерации Netlist и импорт его в проект печатной платы. 

После импорта Netlist на печатной плате необходимо нарисовать границы комнаты и 

назначить ей имя Ist3. Комнаты рисуются при помощи команды Setup->Outlines->Room outline, 

см. Рис.  5.6. 



 

 

Рис.  5.6 Активация команды отрисовки комнаты. 

После активации команды пользователь увидит диалоговое окно, показанное на Рис.  5.7. 

 

Рис.  5.7 Настройка свойств добавляемой комнаты. 



 

Side of Board – сторона печатной платы, на которой будут устанавливаться компоненты. 

(верхняя, нижняя или на обоих) 

Room_TYPE Properties – указывает, насколько жестко должны соблюдаться границы 

комнаты при расстановке компонентов. 

- ROOM Hard – Все компоненты, принадлежащие комнате, должны быть установлены 

внутри границы. Если компонент выйдет за границы комнаты полностью, будет сгенерирована 

DRC ошибка. Если компонент, не принадлежащий данной комнате, полностью попадёт в её 

пределы, будет сгенерирована DRC ошибка. 

- ROOM Soft – Компоненты, принадлежащие комнате, будут установлены в пределах 

границы, но если там же окажется посторонний компонент или компоненты из комнаты будут 

переставлены в другое место, ошибок DRC не будет сгенерировано. 

- ROOM INCLUSIVE – Похоже на ROOM Hard, но ошибка DRC начинает возникать, когда 

компонент частично пересекает границы комнаты. 

- ROOM HARD_STRADDLE – Компоненты, принадлежащие комнате, при пересечении 

границы не вызывают появления ошибки. Посторонние компоненты вызывают ошибку только 

тогда, когда полностью оказываются внутри комнаты. 

- ROOM INCLUSIVE_STRADDLE – Компоненты, принадлежащие комнате, и чужие 

компоненты могут свободно устанавливаться внутри комнаты. Ошибка будет сгенерирована 

только тогда, когда компонент из комнаты полностью покинет её пределы.   

Design level – Управляет свойствами всех комнат в проекте. Используется, если в свойстве 

ROOM поставлено <Use design level>. Может принимать аналогичные значения. Если ничего 

не задано, то выставляется значение Soft. 

Create/Edit options – Способ создания границ комнаты. Лучше пользоваться Place rectangle 

и задавать размеры прямоугольника. Потом его можно будет изменить по желанию 

пользователя. 

После того, как комната будет нарисована, можно опять вернуться в меню Quick place. 

Останется выбрать Place by room, установить значение поля в Ist3 и нажать на Place.  

 

 

Рис.  5.8 Результат работы опции Place by room. 



 

Остальные опции Quick place: 

- Place by partnumber – устанавливаются все компоненты, поле Partnumber которых 

совпадает с указанным пользователем. 

- Place by netname – Установятся все компоненты, входящие в указанную 

пользователем линию. 

- Place by schematic page number – Поставить все компоненты, расположенные на 

определенной схемной странице. 

- Place all components – Установить вообще все компоненты. 

- Place by associated components – Установить компоненты, которые привязаны к 

какому-либо определённому компоненту. Такая возможность в схемах OrCAD Capture 

отсутствует. Она реализована в схемном редакторе DE HDL. 

- Place by RefDes – Установить по определённому шаблону RefDes символов. 

 

После того, как группа компонентов, подлежащих установке, сформирована, необходимо 

определить, где именно будут располагаться компоненты. Варианты показаны на Рис.  5.9. 

 

Рис.  5.9 Настройка места установки выбранных компонентов. 

Ручная установка символов через команду Place Manually. 

Этот способ установки элементов самый простой и медленный. Работает он примерно так 

же, как и Quick Place, описанный ранее. Однако определение координат установки и слоя 

расположения производит человек вручную для каждого отдельно взятого символа 

компонента (Рис.  5.10). 



 

 

Рис.  5.10 Меню ручной установки Place manually. 

Возможные режимы сортировки компонентов для установки можно выбрать в левом 

верхнем углу окна. 

Components by RefDes – Сортировать компоненты по RefDes, как показано на Рис.  5.10. 

Components by net group – Сортировать компоненты по группам цепей, созданных в 

Constraint Manager. 

Module Instances – Устанавливать компоненты, входящие в определённый модуль. Модуль 

– это кусок схемы, связанный с трассировкой. Удобно пользоваться, когда какой-либо кусок 

печатной платы повторяется из раза в раз. 

Module definition – Можно повторить модуль необходимое количество раз. Все компоненты 

в модуле получат имя, состоящее из имени модуля и имени RefDes компонента. Цепи модуля 

получат прибавку к имени - имя модуля (Рис.  5.11). 



 

 

Рис.  5.11 Вновь созданный модуль. 

Расстановка повторяющихся модулей 

Поясним подробнее. Допустим, существует определённый ранее созданный модуль. Он 

состоит из элементов и соединяющей их трассировки. Его можно установить единожды при 

помощи раздела Module Instances, если он содержится в схеме электрической 

принципиальной. Если необходимого куска трассировки не содержится на схеме данного 

проекта, его все равно можно установить. Необходимо, чтобы требуемый модуль 

присутствовал в виде файла в папке, указанной в настройках путей (см. Рис.  5.12).  



 

 

Рис.  5.12 Указание папки, содержащей наборы модулей. 

Таким образом пользователь может добавлять на плату даже те элементы, которые 

отсутствуют в исходной схеме. 

Mechanical symbols – Позволяет устанавливать на плате символы, не имеющие 

электрического подключения к каким-либо цепям на плате. У пинов данных символов нет 

номеров, а значит, их нельзя подключить к электрическим цепям. 

Format symbols – Позволяет устанавливать рамки листов, таблицы и любые другие 

символы оформления - для оформления КД и сдачи проекта в архив. 

Интерактивная расстановка – интерактивная связь со схемой в OrCAD 
Capture. 

Если при расстановке компонентов включить схемный редактор OrCAD Capture и открыть 

схему, с которой был получен Netlist, то появится возможность расставлять компоненты, 

выделяя их на схеме.  

Для запуска работы в таком режиме нужно активировать действие, которое пользователь 

собирается совершить с группой объектов. Схема будет нужна для выделения необходимой 

группы объектов. Порядок действий для выполнения интерактивной расстановки: 

- Все компоненты установлены в проект печатной платы при помощи команды Quickplace. 

То есть просто навалены в «кучу» для дальнейшего распределения по областям платы. 

- Необходимо активировать команду движения – Move. 

- В открытой схеме выделить необходимые компоненты. Можно выделять простым 

окном, зажав левую кнопку мыши. 

- Все выделенные компоненты в OrCAD Capture будут выделены и на плате.  

- Останется указать точку привязки, и вынести их из общей массы компонентов на 

свободное поле. 

 



 

Общие возможности режима Placement Edit. 

В режиме Placement Edit доступно выравнивание компонентов с заданными параметрами. 

Для того, чтобы выровнять компоненты или раздвинуть их на определённый шаг, необходимо 

выделить все компоненты. Существует много способов выделить группу компонентов. Самый 

простой: зажать левую клавишу мышки, и, потянув мышку в нужном направлении, обвести 

необходимые компоненты областью выделения. Далее, наведя курсор на какой-либо из 

выделенных компонентов, необходимо нажать правую клавишу мышки и выбрать из 

выпадающего меню команду Align Components. После этого вкладка Options приобретёт вид, 

показанный на Рис.  5.13 

 

Рис.  5.13 Вид вкладки Options при активации команды Align Components. 

Alignment Direction – Направление оси, вдоль которой произойдёт выравнивание. 

Alignment Edge – Грань по которой произойдёт выравнивание: верхняя, нижняя или по 

центру компонентов.  

Spacing – Расстояние между выравниваемыми компонентами. Его можно регулировать при 

помощи клавиш +/- либо задавая значение при активации опции Equal Spacing. 

Создание шаблонов повторяющихся участков трассировки. 

В данный момент говорить про создание шаблонов трассировки рановато, поскольку не 

описан сам процесс создания трассировки, и проводящего рисунка ещё нет. Однако данная 

возможность существует только в режиме Placement Edit, поэтому рассмотрим ее. 

Допустим, что определённый проводящий рисунок уже создан, и он довольно сложный. Нам 

нужно повторить его без изменений несколько раз, мультиплицировать трассировку для 

нескольких одинаковых «каналов» на плате. Сделать это вручную будет очень сложно. Для 

данной цели есть инструмент Place Replicate Create/Apply. 



 

 

Рис.  5.14 Участок трассировки, который необходимо повторить. 

Порядок действий для создания шаблона: 

- Пользователю необходимо переключиться в режим Placement Edit. 

- В окне Find установить галочку напротив строки Symbols. 

- Выделить необходимые объекты (символы) любым способом.  

- Находясь курсором мышки над какой-либо площадкой одного из выделенных компонентов, 

нажать правую клавишу мышки и выбрать пункт контекстного меню Place Replicate Create. 

- Выделится вся завершённая трассировка, принадлежащая выделенным компонентам. 

Иногда часть трассировки не выделяется, либо пользователь хочет добавить в шаблон какие-

либо участки трассировки. Это необходимо сделать, покликав на интересующих объектах 

левой клавишей мышки. 

- После того, как все необходимые объекты трассировки выделены, необходимо нажать на 

правую клавишу мышки и выбрать Done в выпадающем меню. 

- После этого надо указать точку привязки, относительно которой будет происходить 

создание шаблона трассировки. Это может быть абсолютно любая точка по желанию 

пользователя. 



 

- После того, как точка привязки будет выбрана, необходимо будет указать имя 

создаваемого шаблона и его местоположение на жёстком диске. Шаблон будет записан в 

файл. 

Порядок действий применения шаблона: 

- Пользователю необходимо переключиться в режим Placement Edit. 

- В окне Find установить галочку напротив строки Symbols. 

- Выделить необходимые объекты (символы) любым способом. Выделяемые компоненты 

должны находиться отдельно от остальных. Это необходимо для того, чтобы не происходило 

ошибочное назначение фильтрующих конденсаторов, подключённых к одной и той же цепи.  

- Находясь курсором мышки над какой-либо площадкой одного из выделенных компонентов, 

нажать правую клавишу мышки и выбрать строку Place Replicate Apply. 

- Выбрать точку привязки в проекте, относительно которой будет построен новый участок 

трассировки. 

- При построении повторяющихся частей проекта при помощи Place Replicate Apply 

сохраняется не только трассировка, но и расположение и ориентация RefDes. 

Если по каким-либо причинам программе не удалось обеспечить полное соответствие 

выделенных компонентов и компонентов из шаблона, перед пользователем появится 

диалоговое окно, показанное на Рис.  5.15 

 

 

Рис.  5.15 Ситуация, когда не удалось однозначно сопоставить выделенные компоненты с 
имеющимися в шаблоне. 



 

В данном окне программа предлагает самостоятельно поставить соответствие между 

компонентами из шаблона в левой части окна и компонентами из выделения в правой части. 

Для установления соответствия необходимо выделить компонент в левой части окна, и 

выделить один из имеющихся компонентов в правой части при помощи левой кнопки мышки. 

Как только два компонента будут выделены, произойдёт их сопоставление, и они изменят 

статус и перейдут вниз списка. Так необходимо действовать, пока все компоненты не будут 

сопоставлены. Иногда бывает ситуация, при которой в разных каналах существуют 

подстроечные элементы. Например, резисторы. У этих резисторов совпадают в схеме все 

поля, за исключением сопротивления, или поля Value. Это отличие мешает однозначно 

сопоставить их с шаблоном, и человеку придётся выполнить сопоставление вручную. Для 

того, чтобы такие резисторы можно было сопоставить, необходимо поставить галочку 

напротив поля Value в окне определения соответствий. Тогда поле Value не будет 

рассматриваться, и резисторы станут тождественны. 

  



 

6. Трассировка проекта. 
После того, как все компоненты займут свои места, и Constraint Manager будет аккуратно 

заполнен правилами и ограничениями, придёт время создавать проводящий рисунок, который 

реализует электрические подключения одних компонентов к другим. 

Проводящий рисунок состоит из медных линий и полигонов. Трассировка линий и полигонов 

будет рассмотрена раздельно. 

Трассировка линий 

Рассмотрим простейший случай трассировки точка-точка. Для того, чтобы удобно провести 

проводящую линию точка-точка, необходимо прежде всего включить режим Etch Edit. Далее 

необходимо активировать команду Route->Connect. После этого необходимо её настроить, 

выбрав во вкладке Find все типы объектов, от которых будет начинаться трассировка. Лучше 

выбрать в этой вкладке вообще все объекты. Далее остаётся кликнуть левой клавишей мышки 

на площадке или переходном отверстии, или же просто на пустом месте экрана, и за курсором 

мышки потянется проводящая линия. Если пользователь кликнул на пустом месте, то линия 

будет толщиной, которая определена в классе физических констант Default. Если 

пользователь выберет какой-либо объект, то линия будет толщиной, заданной для 

выбранного класса цепей. После начала трассировки окно Options изменит свой вид. 

Рассмотрим его более подробно (Рис.  6.1). 

 

Рис.  6.1 Начало трассировки цепи GND. 

В верхней части окна имеется выбор слоёв, использующихся при трассировке. Первым 

идёт слой, на котором в данный момент проводится линия. Вторым идёт слой, на который 

перейдёт проводник при генерации переходного отверстия. Есть два режима перехода со 

слоя на слой.  

- Alt – обычная работа с многослойными платами со сквозными отверстиями, трассировка в 

двух альтернативных слоях попеременно (Alternative Layers) 



 

- WL - разработан для использования в HDI проектах с микроотверстиями, трассировка в 

наборе рабочих слоев (Working Layers). 

При режиме Alt пользователь вправе выбрать любой слой для перехода сигнала.  

При режиме WL (Рис.  6.2) необходимо будет указать один или несколько слоёв, связанных 

с исходным. Для этого нужно кликнуть на кнопку Working Layers. Именно на эти слои будет 

осуществляться переход при генерации переходного отверстия и смене слоя трассировки. 

Если там определено больше одного доступного слоя, программа предоставит возможность 

выбора в момент создания переходного отверстия (Рис.  6.3). 

 

 

 

Рис.  6.2 Трассировка в режиме WL. Определение доступных слоёв. 

 

Рис.  6.3 Возможность выбрать слой перехода сигнала. 

 

Тип переходного отверстия указан строкой ниже. Его всегда можно поменять вручную, если 

задано несколько типов отверстий для трассировки выбранной цепи. 

Ниже напротив слова Net идёт имя трассируемой цепи. 

Line lock – Способ проведения линий. Линии могут выполняться дугами (Arc) либо прямыми 

линиями (Line). Угол трассировки может быть кратен 45/90 градусам, либо быть 

произвольным. 



 

Route offset – При значении угла трассировки 45 градусов появляется возможность задать 

этот дополнительный параметр. Он разграничивает окружность на сегменты. Можно ввести не 

все числовые значения, а только некоторые. Трассировка привязывается к углам, которые 

получаются от прибавления и вычитания угла из 45 градусов. (45+/-Route offset) 

Miter – В данном случае – это обозначение скоса для угла в 90 градусов.  

 

Рис.  6.4 Иллюстрация Miter. 

При трассировке линии Miter генерируется при повороте на 90 градусов (Рис.  6.4). Т.е. если 

трассировщик хочет изменить направление движения линии на девяносто градусов и сделать 

это на маленьком отрезке пути, то будет сгенерирован Miter. Если же линия поворачивает на 

угол 90 градусов большими сегментами, то Miter генерироваться не будет. Это сложно 

объяснить в тексте. Чтобы почувствовать грань, когда Miter начинает генерироваться, 

необходимо трассировать плату самостоятельно. Значение min/fixed определяет: будет ли 

величина скоса фиксированной, или её значение будет не меньше min. Величину скоса можно 

задавать как в единицах измерения проекта, так и в ширинах линии трассировки. Для задания 

miter в ширинах линии необходимо написать 1x, 2x, 3x и т.д. 

 



 

 

Рис.  6.5 Линия поворачивает с маленьким радиусом, и Miter генерируется. 

 

Рис.  6.6 Линия поворачивает с большим радиусом. Величину скоса под 45 градусов пользователь 
пока что определяет сам. 

Radius – Поле очень похоже на Miter. Заменяет значение Miter, когда трассировка идёт 

дугами. Работает аналогично. 

Line width – Ширина проводящей линии. Берётся из Constraint manager. Можно изменить 

вручную, указав любое значение. Если значение заданной вручную ширины не попадёт в 

интервал min-max line width правил и ограничений, то будет сгенерирована ошибка DRC. 

Bubble – Способ прокладывания линий. 



 

- Shove preferred – прокладываемая линия будет раздвигать существующую 

трассировку, если места для прокладки не хватает. 

- Hug only – Прокладываемая линия будет прижиматься к уже существующей 

трассировке (Рис.  6.7). 

- Hug preferred – Прокладываемая линия будет прижиматься к существующей 

трассировке, если места для прокладки достаточно. И расталкивать трассировку, если 

места недостаточно. 

- Off – Правила DRC для зазоров не соблюдаются. Т.е. пользователь может вести линию 

от точки до точки, не соблюдая значения Constraint manager. 

Shove vias – Разрешает или запрещает двигать переходные отверстия в процессе 

прокладки новых линий. 

Gridless – Позволяет участкам трасс находиться не в узлах сетки трассировки, когда 

значение поля Bubble установлено в Off. Повышает плотность трассировки. 

Clip dangling lines – Опция позволяет убирать короткие конечные сегменты трасс при 

расталкивании трассировки. Т.е. если в процессе расталкивания образовались кусочки трасс, 

которые одним концом не доведены до контактной площадки, то они будут ликвидированы. 

Если опцию отключить, то висящие кусочки останутся. Опция активна только при трассировке 

в режиме Shove preferred. 

Smooth – Минимизирует количество сегментов трассы между начальной и конечной 

точками. Рекомендуемое значение Minimal/Full/Off. Значение Super применяется только в 

редакторах Allegro SiP и APD.  

Snap to connect point – Привязка к конечному объекту трассировки, если линия подошла 

достаточно близко. Линия сама как бы “примагнитится” к конечному элементу. Нет нужды 

доводить её вручную. 

Replace Etch – Удаление ненужных участков трассировки при перепрокладке линии (Рис.  

6.10). 

Auto-Blank other rats – Скрывает все резиновые связи, когда пользователь трассирует 

какой-либо сигнал. 

Optimize in Channel – Раздвигает линии на равное друг от друга расстояние. Линии должны 

быть проведены между двумя контактными площадками или переходными отверстиями. Если 

линия одна, то эта опция выравнивает её посередине между указанными объектами. 

 



 

 

Рис.  6.7 Зелёная линия трассируется с Smooth=Minimal. Режим Hug Only. 

 

Рис.  6.8 Зеленая линия трассируется с Smooth=Off. Режим Hug Only. 

 

 



 

 

Рис.  6.9 Опция Replace Etch отключена. 

 

Рис.  6.10 Опция Replace Etch включена. 

Если в процессе прокладки линии нажать на правую клавишу мышки, то появится 

выпадающее меню, изображённое на Рис.  6.11.Рис.  6.11 Контекстное меню при трассировке. 

Стоит обратить внимание, что такой вид меню будет иметь только тогда, когда трассировка 

одиночной линии уже начата. В противном случае меню примет несколько иной вид, описание 

которого будет дано ниже. 



 

 

Рис.  6.11 Контекстное меню при трассировке. 

Опишем все пункты меню: 

Done – Завершить команду трассировки. Команда прокладки линий будет завершена, а на 

экране останется только зафиксированная часть линии. Зафиксированной частью считается 

та линия, которая остаётся после клика левой клавишей по рабочему полю. Т.е. когда 

пользователь ведёт мышку в режиме прокладки трасс, то за курсором тянется хвост из 

трассы. Если нажать в любом месте рабочей области на левую клавишу, то произойдёт 

привязка хвоста к месту нажатия и линия как бы сломается в этом месте. Похоже на то, если 

бы мы прикрепили ленту на платье булавкой. 

Oops – Не отменяет текущей команды, но откатывает состояние команды на один шаг 

назад. 

Cancel – Отменяет текущую команду без внесения изменений в проект. 

Next – Завершает текущее действие, но не завершает команду. 

Reject – Очень полезная функция для случая, когда несколько объектов одного типа 

накладываются друг на друга, а пользователю необходимо выбрать определённый  

объект. Это могут быть RefDes элементов (см. Рис.  6.12), полигоны и т.п. Для того, чтобы 

правильно выбрать необходимый пользователю объект из всех накладывающихся друг на 

друга, стоит выбрать любой из объектов, а затем нажать правую клавишу мышки и 

активировать пункт Reject (Рис.  6.13). 



 

 

Рис.  6.12 Три RefDes, накладывающихся друг на друга 

 

Рис.  6.13 Выбор нужного объекта при помощи функции Reject. 

После того, как пользователь задействовал Reject, программа предоставит выбор из всех 

имеющихся поблизости объектов, над которыми возможно провести действие.  

Стоит отметить, что необходимо внимательно следить за типами объектов, над которыми 

вы собираетесь производить действие. Например, пользователь хочет подвинуть текст в 

новое место. Но под текстом находится довольно много других объектов: трассировка, 

полигоны и т.п. Это значит, что после выбора команды Move пользователю необходимо снять 

галочки со всех типов объектов, кроме Text, во вкладке Find. Своевременное 

отфильтровывание ненужных типов объектов через Find вызывает наибольшие сложности у 

начинающих пользователей, но зато дает большие удобства в работе тем, кто освоил эту 

функцию. 

Add via – Добавляет в указанном месте переходное отверстие и меняет слой трассировки 

на указанный в строке Alt. 

Change active layer – Изменяет слой, на котором в данный момент происходит 

трассировка. 

Change alternative layer – Изменяет слой, на который будет осуществлён переход при 

генерации переходного отверстия. 



 

Swap layers – Меняет местами два слоя: текущий и альтернативный. Т.е. трассировка 

переходит на альтернативный слой, и он становится текущим. 

Neck mode – Изменяет ширину линии трассировки на ту, которая указана в Constraint 

manager проекта для столбца “Neck” (узкое горлышко). Если в констрейнах указана 

максимальная допустимая длина заужения, то начинается отсчёт длины узкого сегмента для 

генерации ошибки DRC в случае превышения заданного параметра. 

Toggle – Переключает стремление текущей создаваемой трассы к горизонтали/вертикали 

или к наклону под 45 градусов. В общих чертах отражает трассировку текущего и следующего 

сегмента относительно воображаемой линии связи (Рис.  6.14). 

  

Рис.  6.14 Расположение текущего сегмента до и после нажатия Toggle. 

Enhanced pad Entry – Улучшенный режим входа проводника в контактную площадку. 

Программа не даст пользователю проложить проводник так, чтобы угол входа проводника в 

контактную площадку был менее указанного в Constraint manager. По умолчанию угол равен 

90 градусов. Это делается для предотвращения создания ловушек травления (Рис.  6.15) при 

процессе производства печатных плат. Улучшает технологичность проекта и повышает 

процент выхода годных плат в сложных проектах 5-го класса точности и выше. 



 

 

Рис.  6.15 Кислотная ловушка, угол входа проводника в КП менее 90 градусов. 

Target – Работает вместе с функцией Finish. Выбирает объект, на котором должна 

закончиться трассировка. Например, если пользователь прокладывает трассу земли от одного 

пина до другого. Пинов, подсоединённых к земле, может быть очень много. Если необходимо 

воспользоваться функцией Finish, нужно указать пин, являющийся концом трассируемой 

линии. 

Finish – После указания Target позволяет автоматически проложить линию от точки до 

точки. Начальная точка будет находиться в месте выбора объекта трассировщиком. Конечная 

точка будет находиться на объекте, который назначен Target. 

Scribble mode – Трассировка штрихами (Рис.  6.16). Нет необходимости прокладывать 

линии в узких местах или же под разъёмами, вымеряя расстояние и пытаясь проложить 

проводники в узких каналах. Достаточно просто нарисовать примерный путь прохождения 

проводника, и, если это возможно, программа сама проложит трассировку по наброску 

маршрута. Таким способом очень удобно трассировать диф. пары под разъёмами. 



 

 

Рис.  6.16 Примерный путь прохождения проводника. 

 

Рис.  6.17 Трассировка штрихами - результат. 

Snake mode – Иногда бывает необходимо проложить два независимых проводника между 

пинами микросхемы или пинами разъёма. Однако места для трассировки имеется мало, и 

любая ошибка в прокладке первого проводника ведёт к невозможности проложить второй, т.к. 

места уже не хватает. Т.е. канал трассировки настолько мал, что допускает трассировку двух 

проводников, но при максимальном приближении их как друг к другу, так и к пинам. Для таких 

задач применяется инструмент «змейка» (Рис.  6.18). Программа максимально близко 

прижимает проводник в верхнему или нижнему ряду пинов при прокладке. За счёт этого 

остаётся место для прокладки второго проводника. Проводник словно змея проползает в узких 

местах. 



 

 

Рис.  6.18 Иллюстрация “проползания” проводника в узком месте. 

Contour – Дает возможность прокладки проводника вдоль «шаблона» - контура печатной 

платы, либо уже проложенного другого проводника (Рис.  6.19). Пользователю остаётся только 

дотянуть мышку из начала в конец трассы, после начала трассировки и выбора шаблона 

трассировки. Прокладку проводника программа выполнит сама. 

Design parameters – Возможность настроить параметры инструментов для дизайна. Из 

данного места можно попасть в диалоговое окно, позволяющее управлять настройкой команд 

редактора: 

- Add connect 

- Delay Tune 

- Edit vertex  

- Slide 

- Gloss  

- Create fanout 



 

 

Рис.  6.19 Пример трассировки вдоль контура. 

 

Теперь поговорим о выпадающем меню, которое появляется по щелчку правой кнопкой 

мышки, если трассировка ещё не начата (Рис.  6.20). Опишем только пункты, которые не были 

описаны ранее. 

 

Рис.  6.20 Вид выпадающего меню, когда трассировка еще не идёт. 



 

Persistent select – Позволяет выбирать режимы группового выделения. Используется для 

выбора режима по умолчанию, если никакие другие режимы не были выбраны пользователем. 

- select by polygon – Выбор полигоном. 

- select by lasso – Выбор лассо. 

- select on path – Выбор по пути следования. 

Select by polygon – Выбор при помощи полигона. Пользователю предлагается нарисовать 

область, все объекты внутри которой должны попасть в выделение. 

Select by lasso – Пользователь рисует не полигональную область, а зажимает левую 

кнопку мышки и обводит необходимые объекты замкнутым произвольным контуром. 

Select on path – Пользователь рисует прямую линию. Всё, что оказалось на её пути, 

попадает в выделение. 

Temp group – Создаёт временную группу объектов. В эту группу могут входить любые 

объекты, которые указаны в данный момент как доступные для выбора во вкладке Find, и 

которые пользователь выберет, последовательно кликая поверх них мышью, или выбирая 

областями. 

Multi line route – Активирует режим проведения нескольких линий одновременно. Линии не 

привязаны к какой-либо цепи. Их параметры отступа друг от друга и ширина настраиваются 

перед трассировкой. Полезная команда, когда необходимо провести шину сигналов, а потом 

последовательно подсоединить полученную трассировку к нужным пинам с одной и с другой 

стороны. 

 

Подгонка длин линий. Delay tune. 

Очень часто при трассировке параллельных интерфейсов передачи данных бывает 

необходимо, чтобы все сигналы приходили к приёмнику одновременно. Этого добиваются при 

помощи: 

- Трассировки всех сигналов на одном слое печатной платы и выравниванием физической 

длины каждого сигнала. Это не всегда возможно при большом количестве сигналов в шине. 

- Выравниванием электрической длины линий с помощью подгонки физической длины. 

- Моделирование проекта, например, в Sigrity для определения задержек в линиях и 

выравнивания их в соответствии с результатами моделирования. 

Как видно: в каждом варианте применяется выравнивание линий по физической или 

электрической длине. Эта операция реализуется в редакторе печатных плат при помощи 

инструмента Delay tune. Рассмотрим его подробнее. 

Вызывается инструмент Delay tune из меню Route. После его активации вкладка Options 

изменит свой вид, см. Рис.  6.21 



 

 

Рис.  6.21 Вид вкладки Options при активированной команде Delay tune. 

Active class and subclass – Слой, на котором будет происходить выравнивание. 

Net – Имя цепи. Условное обозначение одиночной цепи или диф. пары различается. 

Gap in use – Зазор между элементами выравнивания. Он рассчитывается исходя из 

настроек ниже по меню. 

Style: Accordion/Trombone/Sawtooth – Виды выравнивания линии. 

Centered – Выравнивание будет происходить относительно исходной линии в обе стороны 

от линии. 

Gap – Зазор между элементами выравнивания. Можно задавать как относительный, в 

ширинах проводника, так и в единицах измерения проекта. 

Corners – Угол, под которым будут срезаться места поворота проводника при подгонке 

длины. 

Miter size – Величина скосов углов. 

Allow DRC – При подгонке длины будет выполняться проверка на DRC. Лучше выполнять 

это действие отдельно, уже после выравнивания, и галочку не ставить. 

 

После внесения всех необходимых настроек во вкладке Options достаточно кликнуть 

мышкой на любое место выравниваемого проводника, и после единичного клика потянуть 

мышку, создавая прямоугольную область, в которой будут рисоваться элементы 

выравнивания. Если ничего не рисуется, значит не хватает места. 



 

 

Рис.  6.22 Пример подгонки длины при помощи Delay tune. 

Обычно при необходимости подгонять длины линий в Constraint manager задаются 

пределы, в которых происходит подгонка. Рассмотрим задание отношений длин линий внутри 

группы сигналов. 

После запуска Constraint manager необходимо раскрыть раздел Electrical, подраздел 

Routing->Relative propagation Delay. 

После этого необходимо выделить интересующие пользователя цепи и нажать правую 

клавишу мышки. После этого выбрать пункт Create->Match Group. См. Рис.  6.23 

 

Рис.  6.23 Создание группы сигналов для выравнивания длин. 

После ввода имени новая группа сигналов появится в верхней части списка цепей. 

 

Рис.  6.24 Пример match group из реального проекта печатной платы. 



 

На Рис.  6.24 приведён пример нескольких групп сигналов с уже заданными параметрами. В 

правой части экрана под ячейкой Relative Delay можно видеть столбец Actual. Данный столбец 

может быть трёх цветов. Если пользователь не изменял цветовую гамму состояний в проекте, 

то эти цвета: 

Зелёный – Все проводники в группе удовлетворяют условиям по разности длин. 

Жёлтый – Проверка не может быть проведена по какой-либо причине. Как правило – это 

отсутствие трассировки данной группы сигналов. 

Красный – Одна или несколько цепей в группе не удовлетворяют условию по разности 

длин. 

После названия группы сигналов, находящегося в столбце Name, идёт столбец Pin Pairs. 

Этот столбец может принимать следующие значения: 

 

Рис.  6.25 Пример структуры линии передачи. 

 

Longest pin pair – Будет подсчитываться длина пары пинов, которая будет наибольшей в 

добавленной цепи. В примере линии на Ошибка! Источник ссылки не найден. будет 

подсчитываться длина пары пинов R156.1-D39.E20. 

Longest Driver/Receiver – Будет подсчитываться наибольшая длина пары пинов приёмник-

передатчик. Однако это будет выполняться только в том случае, если поле свойства Pin Use 

было заполнено корректно при создании схемного символа элемента. У одного пина 

(приемника в линии) оно должно быть In, у другого (источника сигнала) Out. Либо значение 

обоих пинов может быть BI. 

All drivers/All receivers – Будет подсчитана длина всех возможных комбинаций пар пинов, 

входящих в исследуемую цепь. Опять же эта проверка выполняется между приёмниками и 

передатчиками, если свойства пинов заданы корректно. Если свойства пинов не были заданы 

вовсе, то произойдёт подсчёт для всех пар пинов, входящих в цепь, что в некоторых случаях 

неправильно, поэтому рекомендуем корректно задавать свойство Pin Use в ваших 

компонентах изначально. 

За описанным столбцом идёт столбец под названием Scope. Он может принимать 

теоретически три значения. Однако значение Bus мы описывать не будем. 



 

Global – Происходит подсчёт длин пар пинов, созданных внутри каждой линии, и сравнение 

этих длин друг с другом. Таким образом гарантируется, что все пары пинов из указанных 

линий будут равны между собой в конечном итоге. Другими словами, фокус направлен на 

выравнивание длин линий между собой. 

Local – Рассматриваются пары пинов только внутри одной линии. Простой или составной 

цепи. И гарантируется, что длина всех пар пинов в пределах одной линии будет равна между 

собой в конечном итоге. 

Обычно значение Local не выставляется. 

Следующий столбец Delta:Tolerance. Для понимания значений этих названий см. Рис.  6.26 

 

Рис.  6.26 Иллюстрация значений Delta и Tolerance. 

Delta подразумевает, насколько данная линия должна быть длиннее той линии, с которой 

она сравнивается (обычно с линией, имеющей отметку Target). Если Delta отрицательная, то 

данная линия должна быть короче. А Tolerance – это допуск, то есть в каких пределах может 

варьироваться длина линии, в плюс или минус, относительно целевой длины. Как правило, 

Delta указывают равной нулю, а Tolerance – исходя из требований к данному интерфейсу. 

Значения Delta и Tolerance записываются в единицах измерения проекта через двоеточие.  

Пример записи : “0 mm:2 mm”, где Delta = 0, а Tolerance +/-2 мм. 

Пробел между цифрой и единицей измерения в записи обязателен. 

Столбцы Actual и Margin показывают подсчитанное значение длины и оставшийся запас 

соответственно. 

Вернёмся к выравниванию длины линии, входящей в определённую группу Match Group. В 

процессе выравнивания в правом нижнем углу рабочей области проекта появляется окошко 

обратной связи, показывающее: попадает ли цепь в указанный диапазон значений, и сколько 

ещё осталось запаса по длине (Рис.  6.27). 

  

Рис.  6.27 Три состояния окна обратной связи при подгонке длины линии. 

Пройдём по вариантам состояния окна обратной связи слева направо и поясним все три 

ситуации. 

Первая ситуация – Линии не хватает длины. Необходимо набрать ещё 1.3237 мм 

дополнительной длины. 



 

Вторая ситуация – Линия укладывается в заданный интервал. Она немного короче Target 

линии, и её ещё можно уменьшить на 0.1584 мм, прежде чем она станет слишком короткой. 

Третья ситуация – Линия слишком длинная. Её необходимо уменьшить как минимум на 

8.0474 мм. 

При описании различных состояний окна обратной связи было использовано понятие 

Target. Поясним данный термин. 

Target – Это длина линии внутри рассматриваемой группы сигналов, которая принимается 

за эталонную. Т.е. диапазон длин всех остальных линий должен попадать в пределы 

(Target+Delta +/-Tolerance). Задаётся Target командой Set as target по щелчку правой кнопкой 

мышки на ячейке, указанной на Рис.  6.28 

 

Рис.  6.28 Назначение Target. 

Target можно назначить только тогда, когда и Delta и Tolerance заданы, пусть даже одно из 

значений равно нулю. 

Однако существуют ситуации, в которых нет необходимости привязываться к какому-либо 

конкретному сигналу. Результирующая длина линий не важна. Важно только то, что длины 

линий не будут отличаться друг от друга более чем на удвоенный Tolerance. Тогда в поле 

Delta:Tolerance необходимо написать “:1 mm”. Цифра 1 здесь – это требуемое значение 

Tolerance в единицах измерения проекта. Delta в данном случае не указывается вообще. 

Если говорить в общем о том, нужно ли указывать Delta или нет, то тенденция такова: 

- Если группы сигналов должны быть выровнены по длине между собой, то Delta и Target 

необходимы. Поскольку наряду с обычными группами сигналов будет присутствовать 

так называемая “главная” группа сигналов, включающая в себя Target для каждой 

обычной группы. И сначала выравниваются Target-сигналы каждой группы между собой, 

а затем уже сигналы внутри каждой группы относительно своего Target. Target-

сигналом, как правило, назначается наиболее длинный сигнал, который уже 

невозможно сократить.  

- Если группы сигналов трассируются на плате как независимые объекты, то Delta не 

нужна. 

Теперь рассмотрим ситуацию, когда назначения пинов не определены правильно или 

вообще не определены. И в линии присутствует один источник сигнала, а также несколько 

приёмников. Также имеются согласующие пассивные компоненты в начале или конце линии. В 

такой ситуации любое значение поля Pin Pairs не приведёт к желаемому результату. В группе 

будут присутствовать все возможные пары пинов. А при значении поля Longest pin pair будет 



 

указываться пара пинов, включающая в себя согласующий компонент, хотя он совсем не 

нужен. Для решения данной ситуации применяется назначение пар пинов вручную. 

Ручное создание пар выводов 

Для ручного создания пары пинов необходимо: 

- Открыть раздел Electrical->Net->Electrical propagation delay. 

- Выбрать интересующую пользователя цепь, найдя её в правой части экрана 

самостоятельно, либо введя искомое название в ячейке сортировки. См. Рис.  6.29 

 

Рис.  6.29 Иллюстрация сортировки объектов по части их названия.  

- Нажать правую клавишу мышки и выбрать пункт Create->Pin Pair (Рис.  6.30).

 

Рис.  6.30 Создание пары пинов. 



 

- Проделать данную операцию столько раз, сколько цепей будет содержаться в группе 

сигналов. 

После этих действий нельзя закрывать Constraint Manger до тех пор, пока все созданные 

пары пинов не будут помещены в группу. Иначе все результаты создания пар пинов будут 

потеряны. 

Для объединения всех пар пинов в группу необходимо: 

- Раскрыть все цепи с созданными парами пинов, нажав на знак «+» около имени цепи. 

- Зажав клавишу CTRL на клавиатуре, аккуратно покликать на необходимых парах пинов 

для получения группового выделения. См. Рис.  6.31 

 

 

Рис.  6.31 Выбор необходимых пар пинов для объединения их в группу. 

- Нажать правую клавишу мышки и выбрать Create->Match Group. 

После этого можно закрыть Constraint Manager. Все изменения сохранятся. 

Выравнивание дифференциальных пар по длине 

После того, как был описан процесс выравнивания длины одиночных линий, поговорим о 

выравнивании длины диф. пар.  

Диф. пары не могут быть добавлены в группу сигналов, как объект «диф. пара». 

Необходимо раскрыть диф. пару, затем выделить две цепи, составляющие диф. пару, и 

наконец добавить эти цепи в группу сигналов. 

Процесс рисования выравнивающих элементов аналогичен процессу рисования у 

одиночных линий. 



 

 

Рис.  6.32 Процесс набора длины у диф. пары. 

Трассировка диф. пар. 

Процесс трассировки диф. пар аналогичен процессу трассировки одиночных линий. Однако 

есть небольшие нюансы. Эти нюансы заключаются в управлении шаблоном добавления 

переходных отверстий и установкой зазоров между этими отверстиями. Также при 

трассировке диф. пары существует возможность проведения одного проводника отдельно от 

другого, если это необходимо. Опишем всё подробнее. 

Добавление переходных отверстий и управление зазорами между 
отверстиями 

В процессе проведения диф. пары необходимо нажать на правую клавишу мышки и 

выбрать из выпадающего меню пункт add via. Будут добавлены два переходных отверстия, и 

диф. пара изменит слой на тот, который указан в строке Alt. 

Переходные отверстия будут добавлены по заранее определённому образцу. Образец 

выбирается тоже по клику правой клавишей мышки, только пункт необходимо выбрать другой, 

а именно Via pattern. После этого выбирается образец добавления переходных отверстий. 

Расстояние между отверстиями регулируется строкой spacing (Рис.  6.33). 

 

Рис.  6.33 Добавление переходных отверстий, определение их положения и управление расстоянием. 

На Рис.  6.33 показано расширенное меню, включающее в себя очень полезную функцию 

автоматического добавления возвратных переходных отверстий для земляных возвратных 

токов. Однако данная функция доступна только в лицензии Allegro PCB Designer High Speed.  

Трассировка проводников диф. пары по отдельности.  



 

Если необходимо трассировать один проводник диф. пары отдельно от другого, нужно 

нажать правую клавишу мышки в процессе прокладки проводников и выбрать пункт Single 

Trace Mode. Далее трассировать проводники как отдельные сигналы.  

Общие действия над проводниками в режиме Etch Edit.  

Как уже говорилось ранее, существуют различные режимы работы программы, в которых те 

или иные разделы получают расширенные возможности. В режиме Etch Edit становится 

возможным не активировать команду Add connect, а просто кликать левой клавишей мышки на 

объекты трассировки и выполнять различные действия, зависящие от настроек. 

При клике левой клавишей на объекте трассировки вкладка Options приобретёт вид, 

показанный на Рис.  6.34 

 

Рис.  6.34 Вид вкладки Options при клике на объект трассировки в режиме Etch Edit. 

Поясним только некоторые параметры, поскольку описание остальных уже давалось: 

- Vertex action – Действие, выполняемое при клике на точку излома линии. Может 

выполняться передвижка точки излома, скругление угла, слайдирование отрезка линии 

и др.  

- Min corner size – Минимальное значение скоса угла, которое будет поддерживаться 

при попытке сделать из двух 45 градусных углов один 90 градусный. Другими словами, 

убрать скос угла. 

На этом описание базовых функций трассировки линий будем считать завершённым. 



 

Прокладка полигонов. 

Трассировка сигналов при помощи проводящих линий обеспечивает высокую плотность 

укладки проводников, однако таким способом нельзя передать большое количество энергии. 

Длинные узкие проводники обладают большой индуктивностью и на высоких частотах 

начинают плохо проводить ток из-за возрастающего сопротивления. 

Из этого следует, что если необходимо подвести к компоненту-потребителю большую 

мощность, то необходимо расширять проводники, уменьшая их индуктивность и 

сопротивление. Таким образом, проводники в процессе уширения постепенно превращаются в 

полигоны. 

Полигоны – Сплошные области металлизации, служащие для передачи большой 

мощности по печатной плате. 

Полигоны делятся на: 

- земляные и полигоны питания - по признаку цепи, к которой они подключены. 

- статические и динамические - по признаку того: сохраняют ли они свою форму в 

неизменном виде, или динамически подчиняются изменившимся условиям трассировки. 

Земляные полигоны выполняют несколько функций: 

- Проводят возвратные токи от сигнальных проводников и полигонов питания, тем самым 

замыкая контур токов на печатной плате. 

- Экранируют внутренние слои печатной платы от внешних воздействий. 

- Повышают технологичность печатной платы, снижая коробление и разгружая слои по 

плотности тока при гальванической металлизации отверстий.  

Прокладке полигонов питания в проекте печатной платы должно уделяться большое 

внимание в процессе трассировки. Поговорим об этом этапе подробнее. 

Прежде всего перед прокладкой полигонов стоит провести базовые подготовительные 

действия, которые облегчат дальнейшую работу как с самими полигонами, так и с другими 

частями проекта. 

Первое, что необходимо сделать – преобразовать резиновые связи земли и питания, 

сменив их вид с динамических линий на небольшие «перечёркнутые квадраты». Это уменьшит 

количество видимых резиновых связей на экране, одновременно не давая забывать, что цепи 

питания тоже требуют разводки. 

Чтобы сменить внешний вид связей RatsNest, необходимо выделить цепь как отдельный 

объект. Это очень легко сделать. Нужно выбрать любой режим, позволяющий работать с 

цепями. Пускай это будет режим General Edit. Далее, во вкладке Find необходимо оставить 

одну галочку напротив типа объектов Nets. После этого кликнуть левой клавишей мышки на 

любой объект, принадлежащий искомой цепи. Либо в поле Find by name переключить 

состояние фильтра в Nets и ввести имя цепи. После ввода имени цепи необходимо нажать на 

Enter, либо немного подвинуть мышку по экрану, т.е. совершить какое-либо действие. 

Необходимая цепь подсветится и будет считаться выбранной. Далее необходимо кликнуть 

правой клавишей мышки на любом объекте трассировки, принадлежащем цепи, и вызвать 

пункт меню Property Edit (Рис.  6.35). Если никакой трассировки ещё нет, то необходимо 

кликать на резиновой связи. 



 

 

Рис.  6.35 Контекстное меню по правому клику мышкой, при выделенной цепи. 

После этих действий перед пользователем появится список из всех свойств, которые 

вообще можно назначить электрической цепи (Рис.  6.36). 

 

Рис.  6.36 Доступные свойства для электрической цепи. 

Из всего многообразия доступных свойств необходимо выбрать одно под названием 

Voltage. И записать туда числовое значение напряжения данной цепи питания. Конечно же, 

лучше писать правильное значение. Если цепь принадлежит земле, то надо писать 0. Если 

цепь принадлежит питанию, но необходимо написать напряжение питания с разделителем 

«точка». В тех случаях, когда напряжение питания неизвестно, надо написать хоть какую-то 

цифру. Как только пользователь проделает операцию присвоения нового свойства цепи и 

закроет окно, можно будет видеть, что отображение отредактированных цепей изменилось. 

См. Рис.  6.37 



 

 

Рис.  6.37 Альтернативное отображение резиновых связей. 

Такого эффекта можно добиться, не только задав напряжение в поле Voltage. На самом 

деле за отображение резинок отвечает поле Net_Schedule, но им нельзя напрямую управлять 

под лицензией OrCAD Standard, требуется хотя бы OrCAD Professional или Allegro. 

Теперь необходимо настроить параметры полигонов в целом для проекта. Конечно же, 

свойства полигонов можно будет потом задать при желании у каждого полигона в 

отдельности. Но каждый вновь создаваемый полигон будет обладать именно теми 

свойствами, которые указаны в общих настройках. Эти настройки доступны из меню Shape-

>Global Dynamic Params. Диалоговое окно, появляющееся перед пользователем, показано на 

Рис.  6.38. 



 

 

Рис.  6.38 Окно управления глобальными параметрами полигонов. 

Необходимо сразу заметить, что управлять можно параметрами динамических полигонов.  

Статические полигоны – это полигоны, которые не подчиняются правилам DRC проекта и 

не меняют своего состояния с момента их создания. Используются они редко, главным 

образом для подключения объектов, которые нельзя подключить при помощи динамических 

полигонов. 

Пояснения ко всем вкладкам уже давались ранее в разделе Ошибка! Источник ссылки не 

найден. Не будем останавливаться на них второй раз. 

Добавляются полигоны в проект командой Shape->Polygon/Rectangular/Circle. Различные 

команды добавляют полигоны различных форм.  

Рисование полигона представляет собой довольно рутинный процесс. Состоит из 

добавления на плату заготовки многоугольника, либо фигуры прямоугольной или круглой 

формы. Затем происходит редактирование полигона, корректировка его границ или углов. 

Назначить цепь, к которой принадлежит полигон, можно либо в момент добавления, либо 

после, в диалоговом окне при редактировании свойств. 

При добавлении полигона на плату его подключением к цепи можно управлять в окне 

Options, см. Рис.  6.39 



 

 

Рис.  6.39 Назначение цепи вновь добавляемому полигону. 

Если цепь не была назначена, или же требуется подсоединить полигон к другой цепи, 

можно выделить полигон командой Shape->Select Shape or Void/Cavity и, нажав правой 

клавишей мышки на выделенном полигоне, выбрать строку Assign Net. 

Опишем подробнее пункты выпадающего диалогового окна, которые возникают при 

редактировании границ полигона при правом клике мышкой (Рис.  6.40). Пункты меню, 

которые уже описывались ранее и повторяются, описывать не будем. 

 

Рис.  6.40 Действия, доступные во время редактирования полигона. 



 

Delete vertex – Удаляет выбранную вершину в контуре полигона. 

Copy – Копирует полигон в место указанное пользователем. 

Copy to layers – Копирует полигон на указанные пользователем медные слои. 

Edit boundary – Позволяет редактировать границу полигона. 

Defer Dynamic Fill – Позволяет не прорисовывать внутреннее наполнение полигона. 

Останется только контур полигона. 

Change Shape Type – Изменяет динамические полигоны на статические и обратно. 

Assign Net – Позволяет подключить полигону к заданной цепи. 

Raise Priority/Lower Рriority – Повышает или понижает приоритет, то есть очередь 

прорисовки полигона. Если необходимо, чтобы определённый полигон прорисовывался 

первым, то выбирают Raise Priority. Если необходимо, чтобы полигон прорисовывался по 

остаточному принципу и не подавлял собой другие полигоны, выбирают Lower Priority. В 

общем случае лучше всего не допускать множественного наложения границ полигонов друг на 

друга. 

Update shape – Обновление единичного полигона. 

Parameters – Управление настройками выбранного полигона. 

 

Теперь дадим описание командам, находящимся в разделе меню Shape (Рис.  6.41). 

 

Рис.  6.41 Перечень инструментов из меню Shape. 

Polygon/Rectangular/Circular – Создать полигон заданной формы. Уже описывалось выше. 

Select Shape or Void/Cavity – Позволяет выбрать границу полигона для дальнейшего 

редактирования. Причём можно выбрать как границу полигона, так и границу выреза в 

полигоне. Если пользователю необходимо выбрать вырез в полигоне, то нужно кликать 



 

именно на границу между заполняемой и незаполняемой частью полигона. Если кликнуть 

внутри выреза, то ничего не произойдёт. 

Manual Void/Cavity – Добавляет в указанный полигон незаполненную область. Форму 

области можно выбрать самостоятельно или отредактировать с нуля. 

Edit boundary – Позволяет дорисовывать к полигону дополнительные кусочки, см. Рис.  

6.42 и Рис.  6.43. 

 

Рис.  6.42 Дорисовывание части полигона командой Edit Boundary. 

 

Рис.  6.43 Результат работы команды Edit boundary. 

Delete Islands – Убирает «островки» - неподсоединённые участки полигонов, висящие в 

воздухе, при помощи добавления на их место «вырезов», повторяющих эти кусочки. При 

активации этой команды происходит анализ всего проекта в целом. В окошке Options 



 

пользователю предоставляется выбор: на каком слое удалять кусочки и какие именно (Рис.  

6.44 - Рис.  6.47). 

 

Рис.  6.44 Возможность управления процессом удаления неподключённых участков полигонов. 

Обычно удаляются все участки на выбранном слое простым нажатием на кнопку Delete all 

on layer. 

 

Рис.  6.45 Полигон перед операцией Delete Islands. 



 

 

Рис.  6.46 Полигон после операции Delete Islands. 

 

Рис.  6.47 Границы полигона не были изменены. Добавлены незаполняемые области. 

Create bounding Shape – Применяется для добавления в один из служебных слоев 

полигона, граница которого расположена вокруг выбранных объектов – пинов, переходных 

отверстий или проводников. В обычных проектах функция не используется, но может быть 

полезна для проектов с СВЧ-топологией или площадками под разварку, а также с плотной 

трассировкой – для создания зон с другими нормами трассировки. 



 

Shape Operations – Позволяет выполнять над полигонами двоичные логические операции, 

такие как: исключение, сложение и некоторые другие. 

Merge Shapes – Объединение двух накладывающихся друг на друга полигонов в один. 

Полигоны должны принадлежать одной цепи. 

Check – Проверка полигонов на существование узких мест. Заужение должно быть менее 

указанной в свойствах полигона минимальной апертуры. 

Compose Shape/Decompose Shape – Собирает из контура, выполненного отрезками 

линий, полигон на указанном классе и подклассе. Либо, наоборот, преобразует полигон в 

контур, состоящий из отрезков линий. Функция уже описывалась ранее на этапе импорта 

контура печатной платы из формата DXF в проект. 

Global Dynamic Params – Управление общими параметрами для вновь создаваемых 

полигонов. 

 

Теперь рассмотрим ситуацию, когда необходимо напрямую подключить какую-либо 

площадку компонента к полигону. Это бывает, как правило, теплосъёмная контактная 

площадка. Однако пользователь не имеет возможности управлять подключением полигона к 

площадкам индивидуально. Управление происходит относительно всех площадок, 

подключаемых к полигону. Чтобы изменить способ подключения полигона к одиночной 

контактной площадке, необходимо выбрать эту площадку и назначить ей дополнительное 

свойство. Выбрать единичную контактную площадку можно в режиме General Edit, оставив в 

окне выбора Find галочку только напротив типа объектов Pin. 

Далее пользователь правым кликом мышки на КП вызывает диалоговое окно, как он делал 

это ранее с цепями. 

 

Рис.  6.48 Подключение выбранной контактной площадки к полигону без термобарьера. 

Пользователю необходимо добавить к площадке свойство Dyn_Thermal_con_type и задать 

ему правильное значение для требуемых слоев меди (Рис.  6.48). В результате описанных 

действий можно будет наблюдать картину, похожую на Рис.  6.49 – металлический теплоотвод 

под компонентом подключен к полигону сплошным образом, без термобарьеров. 



 

 

Рис.  6.49 Результат Подключения КП без термобарьера. 

Для быстрого и более удобного редактирования полигонов существует отдельный режим 

работы - Shape Edit. Он позволяет редактировать полигоны без их выделения, просто кликая 

мышкой на те или иные участки полигона. В зависимости от того, на какой участок полигона 

пользователь кликнул, будет можно выполнить то или иное действие по изменению его 

границ. В этом режиме вкладка Options приобретает вид, показанный на Рис.  6.50. 



 

 

Рис.  6.50 Вкладка Options при активном режиме Shape Edit. 

 

В верхней части вкладки Options на Рис.  6.50 указываются класс и подкласс, на которых 

расположены редактируемые полигоны.  

Enable zone boundary editing – Позволяет редактировать границы зон с отличными от 

остального проекта правилами трассировки (эти зоны тоже являются полигонами). 

Segment commands – Раздел, отвечающий за выбор действий по умолчанию при кликах 

пользователя на границе полигона и попытках потянуть эту границу с зажатой левой 

клавишей мышки. 

Действия из раздела Segment commands 



 

- Add Notch - Если просто кликнуть на границе полигона, то появится точка излома, так 

называемый Vertex. Теперь необходимо потянуть мышку по границе в нужную пользователю 

сторону и кликнуть снова. Необходимо делать простые одиночные клики, клавиши на мышке 

зажимать не нужно. В результате из полигона начнёт выдвигаться так называемая выноска 

между двумя отмеченными точками на его границе. Либо, наоборот, можно будет вдвинуть эту 

часть полигона внутрь (Рис.  6.51). 

 

Рис.  6.51 Выдвижение части полигона вовне и вдвижка внутрь. 

- Move – При клике мышкой на границе полигона, эта граница прицепится к мышке и 

начнёт передвигаться за курсором (Рис.  6.52). 

 

Рис.  6.52 Движение границы полигона при значении поля Click->Move. 

- Slide – При клике мышкой на сегменте границы полигона выделенный сегмент начнёт 

смещаться вдоль оси Х или Y, если это возможно (Рис.  6.53). 



 

 

Рис.  6.53 Движение границы полигона при значении поля Segment commands->Click->Slide. 

При команде Move сдвижка возможна по двум осям. При команде Slide сдвижка возможна 

только по одной из осей. 

- Remove/Extend – Удаляет выбранный сегмент и продолжает оставшийся после 

удаления до ближайшей точки пересечения со следующей линией (Рис.  6.54). 

 

Рис.  6.54 Состояние полигона до и после выполнения операции Remove/Extend. 

В поле Drag возможно только два состояния: Move и Slide. Оба этих действия уже 

описывались на примерах сегментов при одиночном клике мышкой. Чтобы выполнялось 

действие, указанное в поле Drag, кнопку мышки после нажатия отпускать не нужно. 

Действия из раздела Vertex Commands. 

Действия, совершаемые по одиночному клику мышкой (Click) 

- Move – Движение вершины полигона по двум осям. 



 

 

Рис.  6.55 Движение вершины полигона после одиночного нажатия на ней левой клавишей мышки. 

- Chamfer/Round – Добавление фаски или скругление вершины полигона по клику мышкой. 

Величина фаски или скругления указывается ниже в области окна Corners (Рис.  6.56 и Рис.  

6.57). 

 

Рис.  6.56 Задание размеров фаски и скругления. 

   

Рис.  6.57 Вид полигона до и после выполнения операции Chamfer/Round. 

Trim – отвечает за срез острых углов. Как бы отрезает носик у угла на заданную величину. 

Chamfer – Снятие фаски под 45 градусов у прямых углов. 

Round – Скругляет угол с заданным радиусом. 

Если поставить галочку напротив опции Set trim size by cursor, то можно будет управлять 

величиной скругления или среза при помощи движения мышки (Рис.  6.58). 



 

 

Рис.  6.58 Изменяемый радиус скругления. 

Slide Extend Selection (Hold Shift to toggle) – Позволяет сдвигать несколько сегментов 

одновременно. Необходимо нажать и удерживать кнопку Shift. Левой клавишей мышки 

покликать все необходимые сегменты. Далее, навести курсор мышки на один из сегментов и 

нажать правую клавишу. Из выпадающего меню выбрать команду Slide Segment. И начать 

двигать мышкой (Рис.  6.59). Отпускание клавиши Shift изменяет поведение этой функции. 

 

Рис.  6.59 Сдвижка выбранных сегментов по одной из осей. 

Auto join (hold CTRL to toggle) – Позволяет как бы вдвигать сегменты один в один. 

Процесс похож на вдвигание ящиков в тумбочку. Необходимо кликнуть на одном сегменте и 

повести его по направлению к другим. Сдвигаемый сегмент будет вбирать в себя все 

сегменты, которые встретит на своём пути. При удерживании нажатой клавиши CRTL данный 

режим отключается и двигается весь полигон целиком (Рис.  6.60). 



 

 

Рис.  6.60 Начальное и конечное состояние вдвижки сегментов полигона в одну линию. 

Создание шаблонов выхода из-под компонента (Fanout). Выравнивание 
плотности проводящего рисунка на внутренних слоях. 

В современных печатных платах повсеместно используются многорядные корпуса с 

большим количеством выводов, например, BGA. Соответственно, вывести все сигналы из-под 

компонента на одном слое не представляется возможным, т.к. внутренние ряды пинов 

окажутся закрыты внешними рядами. Для того, чтобы решать данную задачу, под 

компонентом генерируется матрица переходных отверстий, которые позволяют вывести 

сигналы на внутренних слоях печатной платы. Чаще всего отверстия сквозные. Реже 

лазерные или глухие. Чтобы каждый раз вручную не генерировать массив этих отверстий, в 

редакторе печатных плат присутствует инструмент автоматической генерации этого массива и 

присоединения его к посадочному месту компонента.  

Массив переходных отверстий и соединяющие отверстия с площадками проводники 

называется английским словом Fanout.  

Инструмент, генерирующий различные варианты Fanout, вызывается из меню Route-

>Create Fanout. Как только данная команда активируется, состояние вкладки Options 

изменяется. См. Рис.  6.61 



 

 

Рис.  6.61 Вкладка Options при активированной команде генерации Fanout. 

Поля вкладки Options при выполнении операции Fanout 

- Include Unassigned Pins – трассировка будет подключена ко всем пинам, 

принадлежащим выбранному элементу, независимо от того: подключен пин к цепи в данный 

момент или нет. Это удобно, если в дальнейшем планируется перемещать цепи на новые 

пины. 

- Include all same net pins – необходимо генерировать трассировку для всех земляных 

пинов, а также тех, которые подключены к цепям питания. Так что галочка должна стоять 

практически всегда. 

- Via structure – в сложных проектах наряду со сквозными переходными отверстиями часто 

используются глухие и погребенные переходные отверстия. Обычно переход со слоя на слой 

осуществляется при применении одного и того же участка трассировки. Т.е. однотипные 

действия по созданию 2-х и более переходных отверстий, связанных между собой короткими 

проводниками. Эти повторяющиеся структуры можно запомнить, как библиотечные элементы, 

и пользоваться ими. Запомненная структура может включать в себя любую трассировку, и 

воспринимается программой как единое переходное отверстие. При установки данной галочки 

становится возможным пользоваться этими структурами. 

- Via – одиночные переходные отверстия, которые определены для трассируемого класса 

цепей в Constraint manager. 

- Via direction – выбор преднастроенного шаблона расположения генерируемых 

переходных отверстий. 

- Override line width – ширина линий, соединяющих контактную площадку и переходное 

отверстие, будет браться не из Constraint manager, а задаваться в явном виде. 

- Pin-via space – расстояние от контактной площадки до генерируемого переходного 

отверстия. В случае генерации фэнаута для BGA-компонента очень удобно выставлять не 

конкретное значение в единицах проекта, а переключать поле в состояние Centered. Тогда 

переходное отверстие будет равноудалено от всех близлежащих пинов. 



 

- Curve Cw/CCw – Для объяснения данной опции достаточно посмотреть на Рис.  6.62. 

 

Рис.  6.62 Иллюстрация опции Curve. 

Такой вид соединительной линии удобен для последующего выравнивания длин при 

трассировке параллельных интерфейсов передачи данных. 

В процессе работы над проектом пользователь может модифицировать фэнаут. 

Это может быть: 

- Простая сдвижка автоматически созданных переходных отверстий на новое место. 

- Пользовательское добавление новых отверстий к пинам, которые ранее не были 

подключены к фэнауту. 

При добавлении новых отверстий полезно будет присоединять их к уже существующему 

фэнауту для того, чтобы вся трассировка переносилась вслед за компонентом при его 

движении. Это легко сделать при помощи функции Route->Convert Fanout->Mark/Unmark. 

При выполнении команды Mark необходимо кликнуть левой клавишей мышки на тот пин, к 

которому подходит вновь созданная трассировка. Участок трассировки на слое TOP/Bottom 

будет прикреплён к компоненту. Если выполнить команду Unmark, то участок трассировки 

будет исключён из фэнаута и останется на месте при движении. 

Если пользователь в процессе работы над проектом создал свой уникальный шаблон 

фэнаута для какого-то компонента, то его можно автоматически скопировать на все 

компоненты, имеющие одинаковый с начальным компонентом тип корпуса. Выполняется это 

при помощи команды Route->Copy fanout. 

 

7. Проверка проекта на DRC. Вывод 

производственных файлов. 
После того, как работа над проектом будет завершена, и все пины компонентов будут 

подключены к цепям, пользователю необходимо произвести ряд проверок и рутинных 

действий для передачи проекта в производство.  Рассмотрим данные действия. 

a. Проверка проекта на наличие ошибок DRC. 



 

b. Подготовка преднастроенных видов для вывода Gerber файлов. 

c. Генерация таблицы сверловки и вывод файла сверловки. 

d. Генерация Thieving на внутренних слоях печатной платы. 

Различные проверки проекта. 

Прежде всего стоит поговорить о проверках, которые позволяют устранить различные 

ошибки, допущенные пользователем при работе над проектом. 

Проверки проводятся как в режиме реального времени, так и по требованию пользователя. 

Проверки по требованию – это так называемый Batch режим. Не все проверки могут быть 

проведены в режиме реального времени. 

Запускаются проверки по команде Tools->Update DRC. В результате проведения проверки 

будет сформирован список ошибок, и по проекту будут расставлены маркеры DRC. В окне 

Command можно будет увидеть краткую информацию о количестве ошибок (Рис.  7.1). 

 

Рис.  7.1 Отчёт о количестве найденных ошибок DRC. 

После этого можно ознакомиться с найденными ошибками, раскрыв раздел DRC окна 

Constraint Manager (Рис.  7.2). 

 

Рис.  7.2 Отчёт по ошибкам DRC, отсортированный по разделам. 

Все ошибки сортируются в зависимости от их вида. По созданным записям можно кликать 

мышкой, и фокус рабочего поля редактора печатных плат будет перемещаться в ту 

координату, где был сформирован выбранный маркер. 

Далее пользователь либо производит устранение ошибки, либо скрывает её из 

рассмотрения, как несущественную. Скрытие ошибки из рассмотрения происходит при 

помощи команды Display->Waive DRC`s. 

Так же найденные ошибки очень удобно просматривать из DRC браузера. Он активируется 

командой Tools->DRC Browser (Рис.  7.3). 



 

 

Рис.  7.3 Окно браузера ошибок. 

В конце работы можно сформировать отчёт об ошибках в формате HTML с работающими 

на проекте ссылками, и тоже использовать его при просмотре ошибок. Такой отчёт 

генерируется по команде Tools->Quick Reports->Design Rules Check Report. Кликая мышкой по 

синим координатам в отчёте, пользователь будет перемещаться по проекту (Рис.  7.4). 

 



 

 

Рис.  7.4 Отчёт об ошибках в формате HTML. 

Отчеты 

В ходе рассказа о способах просмотра ошибок был затронут раздел генерации различных 

отчётов. Указанный раздел можно увидеть, выбрав в меню Tools->Quick Reports. 

Отчётов довольно много. Некоторые из них более используемые, некоторые редко 

используются в работе. Расскажем о наиболее полезных и используемых отчётах. 

- Bill of material report (Condensed)  

Отчёт выводит информацию об используемых в проекте компонентах. Компоненты 

сгруппированы по одинаковым свойствам. См. Рис.  7.5 

 

Рис.  7.5 Пример отчёта Bill Of Materials (Condensed). 

- Component report 

Отчёт выводит информацию о местоположении компонентов в проекте, их ориентации и 

расположении на слоях TOP или Bottom. Данный отчёт необходимо передавать на участок 

поверхностного монтажа (Рис.  7.6). 



 

 

Рис.  7.6 Пример отчёта Component Report. 

- Cross-Section Report 

Предоставляет информацию о количестве и порядке следования слоёв в печатной плате. А 

также даётся информация о толщине и марке применяемых диэлектриков. Этот отчет можно 

передавать производителю печатных плат, как информацию о структуре слоев платы и 

используемых материалах (Рис.  7.7). 

 

Рис.  7.7 Пример отчёта Cross-Section. 

- Dangling lines via and antenna report 

Отчёт предоставляет информацию о висящих в воздухе проводниках и отверстиях. Т.е. о 

тех элементах, которые трассировщик забыл довести до конца и бросил на каком-то этапе. 



 

- Summary Drawing Report  

Отчёт предоставляет общую информацию о проекте. Сообщает, сколько пинов, цепей и 

компонентов присутствует в проекте. Можно узнать о стадии завершённости проекта в 

процентах. Очень полезно при полном завершении проекта удостовериться, что процент 

завершенности равен 100% (Рис.  7.8). 

 

Рис.  7.8 Пример Summary Drawing Report. 

- Unconnected Pins Report  

Если процент завершенности проекта не равен 100%, то можно узнать с помощью этого 

отчета, какие именно пины и по каким координатам остались не разведёнными (Рис.  7.9). 



 

 

Рис.  7.9 Пример Unconnected Pins Report. 

- Net single pin and no pin 

Предоставляет информацию о цепях, содержащих только одну точку контакта, либо не 

содержащих их вовсе. Такие ошибки можно отловить уже на этапе проверки схемы, но иногда 

проверки схемы не проводятся, либо список соединений поступает из сторонних САПР (Рис.  

7.10). 

 

Рис.  7.10 Пример отчёта об однопиновых цепях. 

- Shape Dynamic status  

В ходе проектирования плат иногда возникает ситуация, когда один проводящий полигон 

полностью накрывается другим проводящим полигоном с более высоким приоритетом 



 

отрисовки. В результате этого один из полигонов не отрисовывается вовсе, и его статус не 

может быть приведен к состоянию Smooth, то есть он не считается завершенным. Без 

выполнения данного условия нельзя сгенерировать Gerber-файлы фотошаблонов. С такой 

ошибкой очень трудно бороться, поскольку нельзя найти неотрисованный полигон в проекте 

визуально. Для решения данной проблемы и существует отчёт Shape Dynamic status. В нем 

содержится информация о состоянии всех проводящих полигонов в проекте и их координатах. 

Становится очень легко обнаружить проблемный полигон и поправить его (Рис.  7.11). 

 

Рис.  7.11 Отчет о состоянии проводящих полигонов в проекте. 

- Unplaced component report 

Отчёт позволяет убедиться, что все компоненты, перечисленные в Netlist, присутствуют на 

печатной плате и установлены. 

Вывод слоёв печатной платы в формате Gerber для изготовления платы. 

Перед тем, как описывать процесс вывода слоёв печатной платы в формате Gerber, стоит 

отдельно упомянуть, что для передачи информации из различных САПР печатных плат в 

производство существует замечательный формат данных ODB++. Этот формат данных 

содержит в себе не только необходимую послойную графику всего проекта, но и Netlist, 

информацию о центрах посадочных мест компонентов, сверловку и многое другое. Самым 

правильным будет передача на производство проекта именно в формате ODB++. Грамотный 

производитель печатных плат сам извлечёт всю необходимую информацию. 

Если же производитель по каким-либо причинам отказывается принимать данные в 

формате ODB++, то придётся производить послойный вывод проекта в формате Gerber и 

генерацию файла сверловки. 

О настройке видов, используемых для генерации Gerber-файлов, уже упоминалось ранее. 

Не будем останавливаться на этом подробно.  



 

Генерация файлов сверловки происходит следующим образом. Необходимо активировать 

команду Manufacture->NC-NC Drill. После этого появится диалоговое окно, Рис.  7.12. 

 

Рис.  7.12 Диалоговое окно генерации файла сверловки. 

В самом верху окна необходимо ввести имя файла сверловки. Далее следует строка для 

масштабного коэффициента, если его необходимо применять. Порядок перечисления 

инструментов в заголовке файла сверления неважен. Можно не изменять следующую строку.  

- Auto tool select – Галочка в данной строке обязательна. Она необходимо для генерации 

описательной части файла сверления. 

- Separated files for plated/non-plated holes – Разделять или не разделять сверловку для 

металлизированных и неметаллизированных отверстий. Производители печатных плат 

рекомендуют выводить эти файлы раздельно, чтобы четко понимать, какие отверстия требуют 

металлизации, а какие - нет. 

- Repeat codes – Определяет, поддерживает ли файл сверловки коды повтора координат. 

Обычно галочка ставится. Это несколько сокращает размер конечного файла сверловки. 

- Optimize drill head travel – Оптимизировать путь шпинделя по полю печатной платы. 

Смысла в данной галочке нет, поскольку на участке сверления оптимизация все равно 

произойдет по алгоритмам того оборудования, которое установлено на участке. 

- Drilling Layer pair/by layer – В случае Layer Pair произойдет генерация файлов сверления 

по парам слоёв, определенных в проекте. По умолчанию хотя бы одна пара слоёв всегда 

существует. Это внешние слои печатной платы. В случае by layer произойдёт разбиение 

каждого из отверстий на несколько, связывающих только соседние слои. Пользователю легко 

понять механизм генерации файлов при таком выборе самостоятельно в ходе эксперимента. 

- Include backdrill / Include counterdrill – Включать или нет информацию об обратном или 

прямом частичном высверливании отверстий в печатной плате. Обычно галочки не 

устанавливаются. 

После установки всех необходимых отметок пользователю необходимо перейти на 

следующее диалоговое окно, нажав на кнопку Parameters в правом верхнем углу Рис.  7.12. 

После этого откроется окно настройки формата, изображенное на Рис.  7.13 



 

 

Рис.  7.13 Окно настройки формата вывода данных сверления. 

В этом окне необходимо указать: 

- Code: ASCII – Формат записи данных – указать ASCII. 

- Automatically generate drill ncroutebits_auto – Автоматически генерировать отверстия 

нужного диаметра в точках захода фрезы. Необходимо, если плата фрезеруется по контуру. 

Обычно не указывается. 

Exellon format: (все данные сверловки генерируются в формате Exellon) 

- Format: 3.3 – Определяет количество знаков в целой и дробной частях координаты точки 

сверления. Для метрической системы всегда должно быть 3.3  

- Coordinates: Absolute – Абсолютные координаты в файле сверления. Координаты 

относитеьлно определенной точки в проекте, принятой за начало координат. 

- Output Units: Metric – Единицы измерения проекта. Дюймы или метрика. Рекомендуем 

всегда указывать метрику. 

- Leading/Trailing zero suppression – Подавление повторяющихся нулей вначале и в конце 

координат сверления. Нет необходимости подавлять нули, поскольку оборудование у всех 

производителей печатных плат довольно современное, и проблем с оперативной памятью для 

запоминания программы не возникает. 

- Equal coordinate suppression  - Подавление повторяющихся координат. Нет 

необходимости в подавлении по указанным выше причинам. 

- Enhanced Exellon format – Генерация информации о размере используемых 

инструментов. Галочка обязательно должна быть. 



 

Генерация заполнения (Thieving) на внутренних слоях ПП. 

Перед тем, как сгенерировать окончательные файлы Gerber для производства печатной 

платы, уже после всех проверок, рекомендуется заполнить свободное пространство на 

внутренних слоях медными пятачками, для получения более высокого качества печатных плат 

и повышения выхода годных. Механизм генерации Thieving, причины генерации и 

необходимые настройки были описаны в разделе «Кнопка Thieving. Добавление медного 

заполнения.». Рекомендуется делать это для сложных многослойных проектов, чтобы 

уменьшить коробление платы. 

  



 

8. Служебные слои (классы и подклассы 
объектов) в проекте ПП. 

Примечание: Все подклассы, имеющие серый цвет на картинках, не могут быть 

удалены. Если подкласс может быть удален, то это пользовательский объект и его 

назначение определяется только пользователем. 

 

Рис.  8.1 Подклассы, включенные в класс Board Geometry. 

Класс объектов Board Geometry состоит из объектов, относящихся к печатной плате в 

понимании физического объекта. Т.е. вся информация, которая принадлежит и описывает 

саму печатную плату, должна находиться в этом классе. 

Assembly_Detail – Содержит информацию о сборочном чертеже печатной платы. Может 

содержать текст, линии или иную графическую информацию. Обычно на данном подклассе 

располагают увеличения кусков печатной платы, варианты установки компонентов на 

поверхность и т.п.  

Assembly_Notes – Очень похож по назначению на предыдущий, но предназначен больше 

для расположения текста типа конструкторских требований, примечаний и т.п. 

Both_Rooms - Класс объектов “комната”. Содержит на себе области, в которых должны 

располагаться определенные объекты. Слой расположения деталей может быть Top/Bottom. 



 

Top/Bottom_Room – Класс объектов “комната” располагаемый на Top/Bottom слое. 

Содержит на себе области, в которых должны располагаться определенные объекты. 

Cutout – Содержит в себе контуры областей вырезов в печатной плате. Это может быть 

полилиния либо полигон. 

Design outline – Относительно новый класс, который должен содержать в себе контур 

печатной платы.  

Place Grid Bottom - ? 

Place Grid Top - ? 

Plating Bar – Область вскрытия от защищающей поверхность маски при гальваническом 

нанесении защитных покрытий на контакты ножевого разъема. В переводе с английского 

данный термин обозначает прямоугольную область вскрытия в маске. 

Silkscreen_Top/Bottom – Содержит в себе графическую информацию о маркировке, 

располагаемой на слое Top/Bottom. Текст на данном подклассе не содержится. 

Soldermask_Top/Bottom – Содержит в себе графическую информацию о вскрытиях 

паяльной маски, располагаемой на слое Top/Bottom. 

Switch_Area_Top/Bottom - ? 

Tooling corners - ? 

Wb_Guide_line - ? 

Dimension – Содержит информацию о размерах печатной платы. 



 

 

Рис.  8.2 Перечень подклассов класса Component Value. 

Класс содержит информацию о номиналах компонентов, которая может располагаться на 

различных подклассах. Названия подклассов, на которых может располагаться номинал 

компонента, видны на рисунке и не будут поясняться. 



 

 

Рис.  8.3 Перечень подклассов класса Device Type. 

Назначение класса Device Type полностью аналогично предыдущему классу за 

исключением того, что класс содержит информацию из поля Device_Type. Данное поле 

должно присутствовать в схеме электрической принципиальной. 



 

 

Рис.  8.4 Список подклассов класса Drawing Format. 

Класс объектов Drawing Format содержит всю информацию, относящуюся к штампу 

чертежа. На этом классе может располагаться как текстовая, так и графическая информация. 

Drawing_Origin – На подклассе располагается графика начала координат. Т.е. крестик с 

кружочком. 

Outline – Подкласс должен содержать границы форматки. 

Revision_Block - ? 

Revision_Data – Содержит дату последнего исправления в штампе. 

Title_Block – Содержит графическую информацию штампа и рамки форматки. 

Title_Data – Аналогичен предыдущему подклассу, но содержит текстовую информацию. 



 

 

Рис.  8.5 Список подклассов класса Etch. 

Класс Etch содержит информацию о всем проводящем рисунке печатной платы. Сюда 

входят проводящие полигоны и линии. Класс объектов является строго неизменяемым 

пользователем и динамическим. Т.е. подклассы добавляются по мере добавления слоев в 

печатную плату. 

Top/Bottom – Содержит информацию о трассировке на слое TOP/Bottom. Сюда не входят 

пины компонентов и переходные отверстия. 

Bond_Top/Bottom – Содержит информацию о проводящем рисунке, к которому 

осуществляется разварка проволочек при способе безкорпусного монтажа кристаллов на 

поверхность ПП. 

Wire – ? 



 

 

Рис.  8.6 Список подклассов класса Manufacturing. 

Данный подкласс содержит всю вспомогательную информацию, которая необходима при 

производстве печатной платы. 

Autosilk_Top/Bottom – Содержит графическую и текстовую информацию о маркировке. Эта 

информация получается только при помощи автоматических инструментов коррекции 

маркировки. Т.е. все результаты работы автоматических инструментов по коррекции 

маркировки заносятся на эти подклассы, а исходные подклассы остаются неизменными. 

Ncdrill_Figure – Содержит графическое отображение точек сверления отверстий на 

печатной плате. Точки сверления разделяются по диаметру сверла и имеют каждый свой 

графический символ. 

Ncdrill_Legend – Содержит перечень используемых графических символов для обозначения 

отверстий. 

No_Gloss_All – Данный подкласс содержит в себе незаполненные полигоны, которые 

олицетворяют собой области недоступные для изменения трассировки автоматическими 

инструментами Gloss. 

No_Gloss_Top/Bottom – Аналогично предыдущему классу, но на слоях Top/Bottom. 

No_Gloss_Internal - Аналогично предыдущему классу, но только на внутренних слоях. 

No_Probe_Top/Bottom – Содержит в себе области, в которых запрещена установка щупов на 

стороне Top/Bottom. 

Probe_Top/Bottom – Разрешает установку щупов в областях, расположенных на данном 

подклассе. 

Photoplot_Outline – Содержит границы фотошаблона, который будет выходить из 

фотоплоттера. 



 

Xsection_Chart – Содержит информацию о стекапе печатной платы. Данная информация 

может быть сформирована при помощи автоматических инструментов. Данные берутся из 

раздела Stackup проекта ПП. 

 

Рис.  8.7 Перечень подклассов класса Analysis. 

Класс Analysis содержит вспомогательную информацию, которая получается при тепловом 

моделировании печатной платы. Поскольку тепловое моделирование в настоящее время 

проводится при помощи Sigrity, которая имеет свой формат данных, то данный класс не 

используется. 

  



 

 

 

Рис.  8.8 Перечень подклассов класса Package Geometry. 

Класс Package Geometry содержит всю информацию, относящуюся к посадочному месту 

компонента. Однако, информация о КП компонентов находится на другом классе. 

Assembly_Top/Bottom – Содержит графическую информацию о корпусах компонентов на 

слоях Top/Bottom. 

Body_Center – Содержит графическую информацию о центре графического примитива, 

олицетворяющего компонент. 

Dfa_Bound_Top/Bottom – Содержит на себе заполненные области, которые олицетворяют 

место необходимое компоненту на слое Top/Bottom, чтобы сборка и ремонт печатной платы не 

вызывали трудностей. Обычно эти области рисуются в размер корпуса и в программе есть 

инструмент, который замеряет расстояние до соседних областей. 

Display Top/Bottom – Подкласс общего назначения. Может содержать справочную 

информацию, либо размеры компонентов. 

Modules – Содержит информацию о модуле, к которому принадлежит компонент. Модуль – 

это группа, состоящая из компонентов и привязанной к ним схеме/трассировке. Т.е. часто 

повторяющиеся куски схемы можно выполнять модулями с привязанной к ним трассировкой. 

Pad_Stack_Name – Содержит на себе имя падстека пина компонента. 



 

Pastemask_Top/Bottom – Содержит в себе информацию о вскрытиях в трафарете, через 

которые на плату наносится паяльная паста. Вскрытия под паяльную пасту для пинов не 

попадают в данный класс и подкласс. 

Pin_number – Содержит в себе номера пинов. Это могут быть цифры, буквы, либо цифро-

буквы. 

Place_Bound_Top/Bottom – На данном классе располагаются заполненные области 

обозначающие место, занимаемое компонентом на ПП. Не применяются для проведения 

проверки DFA. Применяются для того, чтобы показать необходимую область вокруг 

компонента, которую нельзя занимать элементами. 

Silkscreen_Top/Bottom – Маркировка на слоях Top/Bottom, принадлежащая компоненту. Не 

содержит RefDes компонентов. 

Soldermask_Top/Bottom – Содержит вскрытия от паяльной маски. Это может быть любая 

графика, привязанная к компоненту и необходимая для генерации вскрытия нужной формы. 

Стандартные формы вскрытий от маски для пинов содержатся на других классах и 

подклассах. 

 

Рис.  8.9 Список подклассов класса RefDes. 

Данный класс содержит всю информацию, которая относится к RefDes компонента.  

Подклассы этого класса – просто различные слои на ПП, на которых могут быть 

расположены RefDes компонента. 

 



 

 

Рис.  8.10 Список подклассов класса Tolerance. 

Данный подкласс содержит в себе информацию о различных допусках. По задумке 

создателей программы допуска могут проставляться на различных слоях. На самом деле 

практически все инженеры-проектировщики не соблюдают правил по расположению допусков 

на определенных слоях, поскольку это не несет за собой никаких последствий. Можно считать 

данный класс объектов мертвым. 

 

Рис.  8.11 Список подклассов класса User Part Number 

Еще один мертвый класс, на котором пользователь может располагать свои PartNumber. 

Причем, это будут не PartNumber производителя. 



 

 

Рис.  8.12 Список подклассов класса Rigid Flex. 

Данный класс предназначен для хранения вспомогательной информации, необходимой для 

производства гибко-жестких ПП и установки на поверхность ПП экранирующих конструкций. 

(экранов) 

Bend_Area – Обозначает зону изгиба гибкой части (шлейфа) 

Bend_Line – Содержит саму линию изгиба. Необходим для генерации фида изогнутого 

шлейфа в новом 3Д вьюере. 

Coverlay_Top/Bottom – Отображает защитное покрытие гибкой части на слое Top/Bottom. 

Emi_Shield_Top/Bottom – Отображает зону установки защитного экрана на стороне 

Top/Bottom. На самом деле данным подклассом никто не пользуется. Защитный экран 

рисуется в виде отдельного посадочного места, задается его высота и проводится проверка 

на перекрытие высот элементов расположенных под экраном, самого экрана и корпуса 

прибора. 

Stiffener_Metal_Top/Bottom – Обозначает зону металлизации на Top/Bottom для установки 

конструкции, повышающей жесткость конца гибкого шлейфа. 

Stiffener_Top – Показывает область наклейки непроводящего увеличителя жесткости конца 

шлейфа. 

Zone_outline – Граница определенной зоны. Зоны служат для подключения нескольких 

стекапов в один проект гибко-жесткой ПП. Т.е. в гибкой части один стекап, в жесткой другой. 

Для назначения стекапов различным частям платы нужны зоны. Зона должна быть создана из 

замкнутого контура, который находится на Board_Geometry->Design_outline. 



 

 

Рис.  8.13 Перечень подклассов класса Surface Finishes. 

Данный класс может содержать различную геометрию, показывающую зоны нанесения 

всевозможных финишных покрытий на ПП. Данная информация может быть полезна, когда 

инженер хочет показать определенные зоны, на которых финишное покрытие отличается от 

общего. Однако, необходимо давать пояснения производителю и прикладывать отдельный 

Gerber файл для нового слоя финишного покрытия. На самом деле новый слой для 

финишного покрытия можно создать в каком угодно классе, назвать его соответственно и 

пользоваться именно им. Так что полезность данного класса объектов является 

сомнительной. 

 

Примечание: До сих пор были рассмотрены классы объектов, в которые пользователь 

может вносить свои подклассы. Т.е. по желанию инженера приведенные классы могут 

быть расширены. Существуют классы объектов, которые расширяются только 

программой и не могут дополняться пользователем. Рассмотрим их. 

 

 



 

 

Рис.  8.14 Список подклассов класса AntiEtch. 

Данный класс содержит объекты, которые запрещают расположение проводящего рисунка. 

Можно сказать, что это отрицательная трассировка на различных слоях ПП. При помощи этой 

отрицательной трассировки можно разделять один полигон на несколько кусков. 

 

Рис.  8.15 Список подклассов класса Boundary 

Данный класс содержит всевозможные границы и области. Эти границы и области могут 

создаваться программно, либо пользователем.  

 

Рис.  8.16 Список подклассов класса Cavity 



 

Данный класс содержит в себе зоны вырезов в теле печатной платы для установки 

встраиваемых компонентов. Данные зоны формируются автоматически при определении 

компонента, как встраиваемый или монтируемый на внутренние слои. 

 

Рис.  8.17 Список классов подкласса Constraint Region. 

Данный класс содержит зоны, в которых действуют другие наборы констант для различных 

слоев печатной платы. Зона должна иметь имя. Набор констант, который будет назначен 

данной зоне, должен иметь имя. Подклассы – это просто различные слои или группы слоев 

ПП для которых действует набор отдельных констант в указанной зоне. 

 

Рис.  8.18 Список подклассов класса DRC Error Class 



 

Данный класс содержит в себе маркеры ошибок, расположенные на различных слоях ПП. 

Маркеры ошибок генерируются при приведении DRC проверок. 

 

Рис.  8.19 Список подклассов класса Embedded Geometry. 

Класс Embedded Geometry содержит области для описания встроенных компонентов. 

Класс Package Keepin содержит только один подкласс All. На данном подклассе 

располагается зона, которая определяет область содержащую компоненты проекта. Т.е. все 

установленные на плате компоненты должны попадать в область Package Keepin->All. 

 

Рис.  8.20 Список подклассов класса Package Keepout. 

Класс содержит области, в которых компоненты не должны находиться. При попадании 

компонента в область будет сгенерирована DRC ошибка. Области рисуются закрашенными 

полигонами. 

 

Рис.  8.21 Список подклассов класса Pin. 



 

Данный класс содержит информацию о проводящем рисунке и вскрытия в непроводящем 

рисунке для пинов компонентов.  

Filmmasktop/bottom – Содержит информацию о вскрытии над пином в слое защитного 

покрытия ПП. Паяльная маска НЕ ЯВЛЯЕТСЯ защитным покрытием. 

Остальные подклассы – это так же слои проекта ПП, которые должны быть хорошо 

известны всем проектировщикам ПП. 

 

Рис.  8.22 Список подклассов класса Plan. 

Plan – служебные классы Allegro для планирования трассировки при использовании опции 

Desigh Planning. 

 

Рис.  8.23 Классы Route Keepin и Route Keepout. 

Классы Route_Keepin и Route_Keepout – Это классы антагонисты. Оба содержат 

незаполненные области, обозначающие границы. В Route_Keepin обозначается область, в 

которой должна содержаться трассировка проекта ПП. В Route_Keepout обозначаются 

области на различных слоях, которые не должны содержать в себе трассировку. 



 

 

Рис.  8.24 Классы Via Class и Via Keepout. 

Класс Via class содержит в себе Flash обьекты для переходных отверстий в печатной плате 

на различных слоях. В общем случае – это заполненные медью окружности с отверстием 

посередине. На подклассах, отвечающих за непроводящие слои ПП, располагаются 

всевозможные вскрытия для создания шаблонов для паяльной маски, трафаретов и т.п. 

VIA KEEPOUT содержит в себе границы областей на различных слоях ПП, в которых не 

может быть переходных отверстий. ROUTE KEEPOUT выполняет такие же задачи, но для все 

трассировки. Переходные отверстия входят в ROUTE KEEPOUT, как частная сущность 

трассировки. VIA KEEPOUT проверяет отсутствие только переходных отверстий. 

Ниже приведена таблица основных классов из справочной системы Cadence Allegro 

Table D-1  Table for Class/Subclass Definitions 

CLASS SUBCLASS USED FOR 

BOARD GEOMETRY Assembly_Detail Creating Assembly Drawing of PCB. For 

example, milling details, special hardware 

requirements, and so on. 

  Assembly_Notes Creating Assembly Drawing of PCB, includes 

general notes for assembly manufacturer. 

  Both_Rooms Adding room boundaries as closed polygon, to 

define a region for a group of components on both 

top and bottom layers. Works in conjunction with 

component room properties. 

"Package to Room" check can be used to verify 

components place in intended areas. 

  Bottom_Room Adding room boundaries as closed polygon, to 

define a region for a group of components on the 



 

bottom layer. Works in conjunction with 

component room properties. 

"Package to Room" check can be used to verify 

components place in intended areas. 

  Dimension Adding dimensioning parameters to board. 

  Off_Grid_Area Defining off grid region. 

  Outline Creating the physical shape and dimension of 

physical board. By default, this is a rectangle of 

the size of working area. 

  Place_Grid_Bottom Defining user-defined grids on the bottom layer 

which are used for Rename Refdes setup UI, and 

with auto-placements routines. 

  Place_Grid_Top Defining user-defined grids on the top layer which 

are used for Rename Refdes setup UI, and with 

auto-placements routines. 

  Plating_Bar Creating plating features. For example, edge 

plating, edge fingers, and so on. 

  Silkscreen_Bottom Creating text and line to the board on the bottom 

layer. 

  Silkscreen_Top Creating text and line to the board on the top layer. 

  Soldermask_Bottom Creating geometries on the Bottom layer to 

eliminate solder mask in designated areas. 

Example application is the need to remove 

soldermask from internal slots and cutouts. 

  Soldermask_Top Creating geometries on the Bottom layer to 

eliminate solder mask in designated areas. 

Example application is the need to remove 

soldermask from internal slots and cutouts. 

  Switch_Area_Bottom Defining an area on the bottom side in which all 

etch is routed in the direction perpendicular to the 

preferred direction of most of the etch on that 

etch/conductor subclass. 

Note: This subclass is no longer in use. 

  Switch_Area_Top Defining an area on the top side in which all etch 

is routed in the direction perpendicular to the 

preferred direction of most of the traces on that 

etch/conductor subclass. 

Note: This subclass is no longer in use. 

  Tooling_Corners Creating Board Layer film orientation for 

fabrication processing. 

  Top_Room Adding room boundaries as closed polygon, to 

define a region for a group of components on the 



 

top layer. Works in conjunction with component 

room properties. 

"Package to Room" check can be used to verify 

components place in intended areas. 

  Wb_Guide_Line Defining the wire bound boundary for bond pads 

in the APD or SIP Layout. 

COMPONENT VALUE Assembly_Bottom Layer of text which defines the component value. 

The actual text string is typically driven from 

schematic input data and not added manually in 

the PCB editor. This layer is used to produce 

drawings to assist manual assembly and rework. 

  Assembly_Embedded Layer of text which defines the component value. 

The actual text string is typically driven from 

schematic input data and not added manually in 

the PCB editor. This layer is used to produce 

drawings to assist manual assembly and rework. 

  Assembly_Top Layer of text which defines the component value. 

The actual text string is typically driven from 

schematic input data and not added manually in 

the PCB editor. This layer is used to produce 

drawings to assist manual assembly and rework. 

  Display_Bottom Layer of text which defines the component value. 

The actual text string is typically driven from 

schematic input data and not added manually in 

the PCB editor. This layer is used to produce 

drawings to assist in custom or non-standard 

processing. 

  Display_Embedded Layer of text which defines the component value. 

The actual text string is typically driven from 

schematic input data and not added manually in 

the PCB editor. This layer is used to produce 

drawings to assist in custom or non-standard 

processing. 

  Display_Top Layer of text which defines the component value. 

The actual text string is typically driven from 

schematic input data and not added manually in 

the PCB editor. This layer is used to produce 

drawings to assist in custom or non-standard 

processing. 

  Silkscreen_Bottom Layer of text which defines the component value. 

The actual text string is typically driven from 

schematic input data and not added manually in 

the PCB editor. This layer is used to produce PCB 

silkscreen labels indicating component values. 

  Silkscreen_Top Layer of text which defines the component value. 

The actual text string is typically driven from 

schematic input data and not added manually in 



 

the PCB editor. This layer is used to produce PCB 

silkscreen labels indicating component values. 

DEVICE TYPE Assembly_Bottom Displaying device type on bottom layer of 

assembly drawing. 

  Assembly_Embedded Displaying device type of embedded component in 

assembly drawing. 

  Assembly_Top Displaying device type on bottom layer of 

assembly drawing. 

  Display_Bottom Additional subclass. Used for displaying device 

type on bottom layer. 

  Display_Embedded Additional subclass. Used for displaying device 

type of embedded components. 

  Display_Top Additional subclass. Used for displaying device 

type on top layer. 

  Silkscreen_Bottom Creating a text for device type on the bottom 

layer. 

  Silkscreen_Top Creating a text for device type on the top layer. 

DRAWING FORMAT Drawing_Origin Creating co-ordinates (00,00) of drawing origin. 

  Outline Creating documentation of design sheet. 

  Revision_Block Adding details about differences between versions 

of a design. 

  Revision_Data Adding revision history of design. 

  Title_Block Lines and text defining a fixed standard format 

typically unchanged by the user from one design 

to the next, such as: Company name, address, 

sheet size. 

  Title_Data Adding design information, such as: Title , 

Author, Drawing Number, etc. 

MANUFACTURING Autosilk_Bottom Destination layer for Automatic Bottom silkscreen 

results. Manual edits to this layer are not 

recommended. 

  Autosilk_Top Destination layer for Automatic Top silkscreen 

results. Manual edits to this layer are not 

recommended. 

  Ncdrill_Figure Previous releases utilized this layer for drill 

figures. 

Note: This subclass is no longer used and is 

purged when nc_drill legends are recreated. 

  Ncdrill_Legend Quantifying the number, type, and tolerance of 

plated and non-plated holes. 

  No_Gloss_All Creating a polygon shape to prevent automatic 

glossing on all etch layers. 



 

  No_Gloss_Bottom Creating a polygon shape to prevent automatic 

glossing on bottom layer. 

  No_Gloss_Internal Creating a polygon shape to prevent automatic 

glossing on internal etch layers. 

  No_Gloss_Top Creating a polygon shape to prevent automatic 

glossing on top layer. 

  No_Probe_Bottom Creating a probe keepout area on the bottom layer 

into the library package definitions in symbol 

mode to control the proximity of test vias to 

surrounding tall parts. 

  No_Probe_Top Creating a probe keepout area on the top layer into 

the library package definitions in symbol mode to 

control the proximity of test vias to surrounding 

tall parts. 

  Photoplot_Outline Creating a rectangle to define the area in the 

design for photoplotting (Artwork generation). 

  Probe_Bottom Creating an automatic test point on bottom layer. 

  Probe_Top Creating an automatic test point on top layer. 

  Xsection_Chart Creating layer stack-up chart for fabrication. 

ANALYSIS High_Isocontour Note: This subclass is no longer in use. 

  Low_Isocontour Note: This subclass is no longer in use. 

  Medium1_Isocontour Note: This subclass is no longer in use. 

  Medium2_Isocontour Note: This subclass is no longer in use. 

  Medium3_Isocontour Note: This subclass is no longer in use. 

  Pcb_Temperature Note: This subclass is no longer in use. 

PACKAGE 

GEOMETRY 

Assembly_Bottom Depicting boundary of package on assembly 

drawing. 

  Assembly_Top Depicting boundary of package on assembly 

drawing. 

  Body_Center Creating a text point that defines the component 

center. 

  Dfa_Bound_Bottom Creating boundary on the bottom layer for Real 

Time Design for Assembly (DFA) to check 

clearances between components driven by a 

Spreadsheet based matrix of components. This 

boundary can be different from 

Place_bound_Bottom boundary. 

You can define this boundary only at the symbol 

level (.dra). If not defined, then the DFA checks 

use the Place_Bound_Bottom boundary. 

  Dfa_Bound_Top Creating boundary on Top layer for Real Time 

Design for Assembly (DFA) to check clearances 

between components driven by a Spreadsheet 



 

based matrix of components. This boundary can 

be different from Place_bound_Top boundary. 

You can define this boundary only at the symbol 

level (.dra). If not defined, then the DFA checks 

use the Place_Bound_Top boundary. 

  Display_Bottom Additional subclass. Used for displaying package 

assembly of bottom layer. 

  Display_Top Additional subclass. Used for displaying package 

assembly of top layer. 

  Modules Creating auto-generated regions around the 

perimeter of a placed Design Reuse module. 

  Pad_Stack_Name Additional layer. Used for displaying Pad stack 

name. 

  Pastemask_Bottom Creating stencil for assembly. Only needed for 

surface mounted devices. 

  Pastemask_Top Creating stencil for assembly. Only needed for 

surface mounted devices. 

  Pin_Number Displaying component pin numbers. 

  Place_Bound_Bottom Creating filled rectangle on the bottom layer that 

define package-part boundary and govern 

placement restrictions. These rectangles are used 

as keepin and keepout areas while placement. 

They are also used by DRCs to check for 

violations of package-to-package overlapping. 

  Place_Bound_Top Creating filled rectangle on the top layer that 

define component areas which may or may not 

include pins of surface mount devices. Used by 

DRCs to check for violations of package-to-

package overlapping. 

You can define this boundary only at the symbol 

level. If not defined it, then it will be automatically 

created based on assembly_top outline. 

  Silkscreen_Bottom Creating arcs, shapes, text and lines to the bottom 

layer of the package geometry of the footprint. 

  Silkscreen_Top Creating arcs, shapes, text and lines to the top 

layer of the package geometry of the footprint. 

  Soldermask_Bottom Special solder mask opening requirements of 

bottom components. 

  Soldermask_Top Special solder mask opening requirements of top 

components. 

REFDES Assembly_Bottom Adding component identifier name in Assembly 

Bottom. 

  Assembly_Embedded Adding component identifier name in Embedded 

Layer. 



 

  Assembly_Top Adding component identifier name in Assembly 

Bottom. 

  Display_Bottom Additional subclass. Used for displaying refdes 

values on bottom layer. 

  Display_Embedded Additional subclass. Used for displaying refdes 

values of embedded components. 

  Display_Top Additional subclass. Used for displaying refdes 

values on top layer. 

  Silkscreen_Bottom Creating text for reference designator on the 

bottom layer. 

  Silkscreen_Top Creating text for reference designator on the top 

layer. 

TOLERANCE Assembly_Bottom Displaying tolerance values of bottom 

components. 

  Assembly_Embedded Displaying tolerance values of embedded 

components. 

  Assembly_Top Displaying tolerance values of top components. 

  Display_Bottom Additional subclass. Used for displaying tolerance 

values of bottom components. 

  Display_Embedded Additional subclass. Used for displaying tolerance 

values of embedded components. 

  Display_Top Additional subclass. Used for displaying tolerance 

values of top components. 

  Silkscreen_Bottom Creating text for the tolerance value on the bottom 

layer. 

  Silkscreen_Top Creating text for the tolerance value on the top 

layer. 

USER PART 

NUMBER 

Assembly_Bottom Displaying user part number values of bottom 

components. 

  Assembly_Embedded Displaying user part number values of embedded 

components. 

  Assembly_Top Displaying user part number values of top 

components. 

  Display_Bottom Additional subclass. Used for displaying user part 

number values of bottom components. 

  Display_Embedded Additional subclass. Used for displaying user part 

number values of embedded components. 

  Display_Top Additional subclass. Used for displaying user part 

number values of top components. 

  Silkscreen_Bottom Creating text for the part number on the bottom 

layer. 

  Silkscreen_Top Creating text for the part number on the top layer. 



 

PACKAGE_KEEPOUT Top Creating boundary at the board level on the top 

etch layer. You can define this boundary at the 

symbol level only for Mechanical part. Used to 

ensure that there is no violation of placement 

keepout areas or high restricted areas in a design. 

  Bottom Creating boundary at the board level on the 

bottom etch layer. You can define this boundary at 

the symbol level only for Mechanical part. Used to 

ensure that there is no violation of placement 

keepout areas or high restricted areas in a design. 

  All Creating boundary at the board level on all the 

etch layers. You can define this boundary at the 

symbol level only for Mechanical part. Used to 

ensure that there is no violation of placement 

keepout areas or high restricted areas in a design. 

  

 

 

КОНЕЦ 

Замечания и пожелания принимаются по адресу info@pcbsoft.ru 

 

 

 

 

 

 

 

 

 

  

mailto:info@pcbsoft.ru

